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Product comparison

M521dn M521dw
A8P79A A8P80OA

Paper handling Tray 1 (100-sheet capacity) v v

Tray 2 (500-sheet capacity) v v

Optional Tray 3 (500-sheet v v

capacity)

Standard output bin (250-sheet v v

capacity)

Rear output bin (50-sheet v v

capacity)

Automatic duplex printing v v
Supported operating Windows XP, 32-bit, Service v v
systems Pack 2 and greater

Windows Vista, 32-bit and 64- v v

bit

Windows 7, 32-bit and 64-bit v v

Windows 2003 Server (32-bit, v '

Service Pack 1 or greater), print

and scan drivers only

Windows 2008 Server (32-bit, v v

64-bit, and R2), print and scan

drivers only

Mac OS X v10.6.8 and later v v
Connectivity Hi-Speed USB 2.0 ' v

10/100/1000 Ethernet LAN v~ v

connection

Wireless network connection v
Memory 256 MB RAM v v
Control-panel display Color graphical touch screen v v
Print Prints 40 pages per minute (ppm) v v

on A4-size paper and 42 ppm

on Lettersize paper

Walk-up USB printing (no v v

computer required
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M521dn M521dw
A8P79A A8P8OA

Copy Copies at up to 20 ppm v v

Copy resolution is 300 dots per v v

inch (dpi)

This document feeder holds up to v v

50 pages and supports page

sizes from 127 to 356 mm (5 to

14 in) in length and from 127 to

216 mm (5 to 8.5 in) in width

Flatbed scanner supports page v v

sizes up to 297 mm (11.7 in) in

length and up to 215 mm (8.5

in) in width

Automatic duplex copying v v
Scan Scans in black and white with v v

resolution up to 1200 dpi from

the flatbed glass

Scans in color with resolution up

to 300 dpi from the document

feeder and up to 600 dpi from

the flatbed glass

Automatic duplex scanning v v

Scan to Email (no software v v

required)

Scan to Network Folder (no v v

software required)

Walk-up USB scanning (no v v

computer required)
Fax V.34 with two RJ-11 fax ports v v
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Product views

e  Product front view

e  Product back view

e Interface ports

e Serial number and model number location

Product front view

1 Automatic document feeder

2 Document-feeder output bin

3 Walk-up USB port (for printing and scanning without a computer)
4 Control panel with color touchscreen graphical display
5 On/off button

6 Optional Tray 3

7 Tray 2

8 Tray 1

9 Front-door-release button (access to the toner cartridge)
10 Output-bin extension for long paper

11 Standard output bin

12 Handle to raise the scanner lid
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Product back view

1 Rear door and face-up output bin (access for clearing jams)
2 Dust cover for Tray 2 (for printing on legal-size paper)

3 Power connection

4 I/O ports and security lock

ENWW Product views



Interface ports

1 Slot for a cabletype security lock

2 Local area network (LAN) Ethernet (RJ-45) network port

3 Hi-Speed USB 2.0 printing port

4 Telephone “line out” port for attaching an extension phone, answering machine, or other device
5 Fax “line in” port for attaching the fax phone line to the product
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Serial number and model number location

The model number and serial number are listed on an identification label located on the back of the
product. They are also listed on the inside of the front door. The serial number contains information
about the country/region of origin, the product version, production code, and the production number of

the product.

Model name Model number
M521dn A8P79A
M521dw A8P8OA

ENWW Product views
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Control panel

e Control-panel layout

e Control-panel Home screen

e Control panel help system

Control-panel layout

1 Touchscreen display Provides access to the product features and indicates the current status of the product
2 Help button and light Provides access to the control-panel help system
3 Right arrow button and light Moves the cursor to the right or moves the display image to the next screen
NOTE: This button illuminates only when the current screen can use this feature.
4 Cancel button and light Clears settings, cancels the current job, or exits the current screen
NOTE: This button illuminates only when the current screen can use this feature.
5 Wireless light (wireless models Indicates the wireless network is enabled. The light blinks while the product is establishing a
only) connection to the wireless network.
6 Attention light Indicates a problem with the product
7 Ready light Indicates the product is ready
8 Back button and light Returns fo the previous screen
NOTE: This button illuminates only when the current screen can use this feature.

Chapter 1 Product introduction
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9 Left arrow button and light Moves the cursor to the left

NOTE: This button illuminates only when the current screen can use this feature.

10 Home button and light Provides access to the Home screen

NOTE: This button illuminates only when the current screen can use this feature.

Control-panel Home screen

The Home screen provides access to the product features, and it indicates the product status.

2 NOTE:  Depending on the product configuration, the features on the Home screen can vary. The
layout might also be reversed for some languages.

1 Web Services @ button Provides quick access to HP Web Services features, including HP ePrint

HP ePrint is a fool that prints documents by using any email enabled device to send
them to the product’s email address.

2 Setup button Provides access fo the main menus
3 Wireless () button (wireless Provides access to the Wireless menu and wireless status information
models only)

NOTE: When you are connected to a wireless network, this icon changes to a set of
signal strength bars.

4 Provides access fo network seftings and information. From the network settings screen,
Network button (for i
you can print the Network Summary page.
products connected to a
network only)

5 Information @) button Provides product status information. From the status summary screen, you can print the
Configuration Report page.

6 Supplies [& button Provides information about supplies status. From the supplies summary screen, you can
print the Supplies Status page.

7 Fax button Provides access to the Fax feature

ENWW Control panel 9



8 Apps button Provides access to the Apps menu to print directly from Web applications that you have
downloaded from the HP ePrintCenter Web site at www.hpeprintcenter.com

9 Product status Indicates whether the product is ready or is processing a job

10 Scan button Provides access to the scan feature

11 Copy button Provides access to the copy feature

12 USB button Provides access to the walkup-USB feature (for printing and scanning without a

computer)

Control panel help system
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The product has a built-in Help system that explains how to use each screen. To open the Help system,
touch the Help ? button in the upper-right corner of the screen.

For some screens, the Help opens to a global menu where you can search for specific topics. You can
browse through the menu structure by touching the buttons in the menu.

Some Help screens include animations that guide you through procedures, such as clearing jams.

For screens that contain settings for individual jobs, the Help opens to a topic that explains the options

for that screen.

If the product alerts you of an error or warning, touch the Help ? button to open a message that
describes the problem. The message also contains instructions to help solve the problem.

Chapter 1 Product introduction
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Print product reports

ENWW

From the Reports menu, you can print several informative pages about the product.

1. From the Home screen on the product control panel, touch the Setup 8\, button.

2. Touch the Reports button.

3. Touch the name of the report that you want to print.

Menu item

Description

Demo Page

Prints a page that demonstrates print quality

Menu Structure

Prints a map of the control panel-menu layout. The active settings for each menu are
listed.

Configuration Report

Prints a list of all the product settings. Includes network information when the
product is connected to a network.

Supplies Status

Prints the status for each toner cartridge, including the following information:
o  Estimated percentage of cartridge life remaining

o  Approximate pages remaining

e  Part numbers for HP foner cartridges

e Number of pages printed

Network Summary

Prints a list of all product network settings

Usage Page

Prints a page that lists PCL pages, PCL 6 pages, PS pages, pages that were jammed
or mispicked in the product, number of pages printed; and reports the page count

PCL Font List

Prints a list of all the PCL fonts that are installed

PS Font List

Prints a list of all the PostScript (PS) fonts that are installed

PCL6 Font List

Prints a list of all the PCL6 fonts that are installed

Service Page

Prints the service report

Print Quality Page

Prints a page that helps solve problems with print quality

Print product reports
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Paper trays

e Supported paper sizes

e  Supported paper types

e Tray |l

e Tray 2 and optional Tray 3

e Use paper output options
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Supported paper sizes

@NOTE: To obtain the best results, select the correct paper size and type in the print driver before
printing.

Table 2-1 Supported paper sizes

Size and dimensions Tray 1 Tray 2 and the Avutomatic duplex
optional 500- printing
sheet trays

Letter v v v

216 x 279 mm (8.5 x 11 in)

Legal v v v

216 x 356 mm (8.5 x 14 in)

Executive v v

184 x 267 mm (7.25 x 10.5 in)

8.5x 13 in \'d \ \

216 x 330 mm (8.5 x 13 in)

A4 ' v v

210x 297 mm (8.3 x 11.7 in)

A5 v \

148 x 210 mm (5.8 x 8.3 in)

Ab \ \'

104 x 148 mm (4.1 x 5.8 in)

B5 (IS) v v

182 x 257 mm (7.2 x 10.1 in)

16K v v

184 x 260 mm (7.2 x 10.25 in)

16K ' v

197 x 273 mm (7.75 x 10.75 in)

Postcard (JIS) v

100 x 148 mm (3.9 x 5.8 in)

Double Postcard (JIS) v \'d

200 x 148 mm (7.9 x 5.8 in)

Custom v

76 x 127 mmto 216 x 356 mm (3.0 x 5.0 in to
8.5 x 14 in)
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Table 2-1 Supported paper sizes (continued)

Size and dimensions

Tray 1

Tray 2 and the Automatic duplex
optional 500- printing
sheet trays

Custom

105 x 148 mmto 216 x 356 mm (4.1 x 5.8 in to
8.5 x 14 in)

v

Custom

210 x 280 mm to 216 x 356 mm (8.3 x 11 in fo
8.5 x 14 in)

Envelope #10

105 x 241 mm (4.1 x 9.5 in)

Envelope DL

110 x 220 mm (4.3 x 8.7 in)

Envelope C5

162 x 229 mm (6.4 x 9.8 in)

Envelope B5

176 x 250 mm (6.9 x 9.8 in)

Envelope Monarch

98 x 191 mm (3.9 x 7.5 in)

ENWW

Supported paper sizes

15



Supported paper types

Table 2-2 Supported paper types

For a complete list of specific HP-brand paper that this product supports, go to www.hp.com/support

limfoM52 1series.

printing.

2% NOTE: To obtain the best results, select the correct paper size and type in the print driver before

Paper type Tray 1 Tray 2 and optional  Automatic duplex
500-sheet trays printing
Plain v v v
HP EcoSMART v v v
Light 60-74g v v v
Midweight 96-110g v v v
Heavy 111-130g v \
Extra Heavy 131-175¢g \'d
Transparency v v v
Labels v
Letterhead v v v
Envelope v
Preprinted v v v
Prepunched v v v
Colored v v v
Bond ' v v
Recycled v v v
Rough v v
16 Chapter 2 Paper trays ENWW
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Tray 1

e Tray capacity and paper orientation

e load Tray 1

Tray capacity and paper orientation

To prevent jams, do not overfill trays. Be sure the top of the stack is below the tray-full indicator. For
short/narrow and heavy/glossy paper, load paper to less than half of the tray full indicators.

Table 2-3 Tray 1 capacity

Paper type Specifications

Quantity

Paper Range:

60 g/m? (16 Ib) o 220 g/m? (58 Ib)

Maximum stack height: 12 mm (0.5 in)

Equivalent to 100 sheets of 75 g/m? (20 Ib)

Envelopes 75 g/m? (20 Ib) to 90 g/m? (24 Ib) Up to 10 envelopes
Labels 0.10to 0.14 mm (0.004 to 0.006 in) thick ~ Maximum stack height: 12 mm (0.5 in)
Transparencies 0.10t0 0.14 mm (0.004 to 0.006 in) thick ~ Maximum stack height: 12 mm (0.5 in)

Table 2-4 Tray 1 paper orientation

Single-sided printing Avutomatic duplex printing and Envelopes
Alternative Letterhead Mode
Face-up Face-down Face-up
Top edge leading into the product Bottom edge leading into the product Short, postage end leading info the product

SN

0

ENWW

Tray 1
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Load Tray 1

1. Open Tray 1.

2. Pull out the paper support and fold out the
extension.
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3. Load the paper into the tray. Make sure that
the paper fits under the tabs and below the
maximum-height indicators.

4. Adjust the side guides so that they lightly touch
the paper stack but do not bend the paper.

ENWW Tray 1 19



Tray 2 and optional Tray 3

e Tray capacity and paper orientation

e Load Tray 2 and optional Tray 3

Tray capacity and paper orientation

To prevent jams, do not overfill trays. Be sure the top of the stack is below the tray-full indicator. For
short/narrow and heavy/glossy paper, load paper to less than half of the tray-full indicators.

Table 2-5 Tray 2 and optional Tray 3 capacity

Paper type Specifications Quantity

Paper Range: Equivalent to 500 sheets of 75 g/m? (20 Ib)

60 g/m? (16 Ib) to 130 g/m? (35 Ib)

Table 2-6 Tray 2 and optional Tray 3 paper orientation

Single-sided printing Avutomatic duplex printing and Envelopes
Alternative Letterhead Mode

Face-down Face-up Print envelopes only from Tray 1.

Top edge at the front of the tray Bottom edge at the front of the tray
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Load Tray 2 and optional Tray 3

E%?NOTE: The procedure to load paper for Tray 3 is the same as for Tray 2. Only Tray 2 is shown here.

1. Pull the tray out and lift up slightly to remove it
completely from the product.

2. Pinch the release that is located on the left
guide and slide the side guides to the correct
paper size.

3. Pinch the release that is located on the rear
paper guide and slide it to the correct paper
size.

ENWW Tray 2 and optional Tray 3
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5.

22

Load the paper into the tray. Make sure that
the stack is ﬁat at all four corners and that the
top of the stack is below the maximum-height
indicators.

Slide the tray completely into the product.

Chapter 2 Paper trays
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Use paper output options

Print to the standard output bin

The standard output bin collects paper face-down, in the correct order. Use this bin for most print jobs,
including transparencies. To use the standard output bin, be sure that the rear output bin is closed. To
avoid jams, do not open or close the rear output bin while the product is printing.

The standard output bin holds up to 250 sheets of 75 g/m? (20 Ib) paper.

Print to the rear output bin

The product always prints to the rear output bin if it is open. Paper that is printed to this bin will exit
face-up, with the last page on top (reverse order).

The rear output bin holds up to 50 sheets of 75 g/m? (20 |b) paper.

Printing from Tray 1 to the rear output bin provides the straightest path. Opening the rear output bin
might improve performance with the following items:

Envelopes

Labels

Small custom-size paper
Postcards

Paper heavier than 120 g/m? (32 Ib)

To open the rear output bin, grasp the handle at the top of the bin. Pull the bin down to a 45° angle,
and slide out the extension.

E’%NOTE: Opening the rear output bin makes the duplexer and the top output bin unavailable. To avoid
jams, do not open or close the rear output bin while the product is printing.

ENWW
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Parts, supplies, and accessories

[ Order parts, accessories, and supp|ies

e HP policy on non-HP supplies

e HP anticounterfeit Web site

e  Print when a toner cartridge is at estimated end of life

e  Customer self-repair parts

e  Accessories

e  Toner cartridge
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Order parts, accessories, and supplies

HP original toner cartridges and paper www.hp.com/go/suresupply
Order genuine HP parts or accessories www.hp.com/buy/parts
Order through service or support providers Contact an HP-authorized service or support provider.
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HP policy on non-HP supplies

Hewlett-Packard Company cannot recommend the use of non-HP toner cartridges, either new or
remanufactured.

E”/{’NOTE: For HP printer products, the use of a non-HP toner cartridge or a refilled toner cartridge does

ENWW

not affect either the warranty to the customer or any HP support contract with the customer. However, if
product failure or damage is attributable to the use of a non-HP toner cartridge or refilled toner
cartridge, HP will charge its standard time and materials charges to service the product for the
particular failure or damage.

HP policy on non-HP supplies
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HP anticounterfeit Web site

Go to www.hp.com/go/anticounterfeit when you install an HP toner cartridge and the control-panel
message says the cartridge is non-HP. HP will help determine if the cartridge is genuine and take steps
to resolve the problem.

Your toner cartridge might not be a genuine HP toner cartridge if you notice the following:
o  The supplies status page indicates that a non-HP supply is installed.
e You are experiencing a high number of problems with the toner cartridge.

e  The cartridge does not look like it usually does (for example, the packaging differs from
HP packaging).
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Print when a toner cartridge is at estimated end of
life

Black cartridge is low: The product indicates when a toner cartridge level is low. Actual toner
cartridge life remaining may vary. Consider having a replacement available to install when print
quality is no longer acceptable. The toner cartridge does not need to be replaced now.

Black cartridge is very low: The product indicates when the toner cartridge level is very low.
Actual toner cartridge life remaining may vary. Consider having a replacement available to install
when print quality is no longer acceptable. The toner cartridge does not need to be replaced now
unless the print quality is no longer acceptable.

Once an HP toner cartridge has reached “very low”, HP’s Premium Protection Warranty on that toner
cartridge has ended.

You can change the way the product reacts when supplies reach the Very Low state. You do not have
to re-establish these settings when you install a new toner cartridge.

Enable or disable the Very Low Setting

You can enable or disable the default settings at any time, and you do not have to re-enable them
when you install a new toner cartridge.

1. From the Home screen on the product control panel, touch the Setup &\, button.
2. Open the following menus:

e  System Setup

e Supply Settings

e Black Cartridge

e Very Low Setting
3. Select one of the following options:

e  Select the Continue option to set the product to alert you that the toner cartridge is very low,
but to continue printing.

e  Select the Stop option to set the product to stop printing (including printing faxes) until you
replace the toner cartridge.

e  Select the Prompt option to set the product to stop printing (including printing faxes) and
prompt you to replace the toner cartridge. You can acknowledge the prompt and continue
printing. A customer configurable option on this product is "Prompt to Remind Me in 100
pages, 200 pages, 300 pages, 400 pages, or never." This option is provided as a customer
convenience and is not an indication these pages will have acceptable print quality.

When the product is set to the Stop option, there is some risk that faxes will not print after the new
cartridge is installed if your product has received more faxes than the memory can hold while stopped.

ENWW Print when a toner cartridge is at estimated end of life 29



When the product is set to the option, there is some risk that faxes will not print after the new
cartridge is installed if your product has received more faxes than the memory can hold while the
product is waiting for the prompt to be acknowledged.

Once an HP toner cartridge has reached Very Low, HP’s Premium Protection Warranty on that toner
cartridge has ended. All print defects or cartridge failures incurred when an HP toner cartridge is used
in at very low mode will not be considered to be defects in materials or workmanship in the
toner cartridge under the HP Toner Cartridge Warranty Statement.
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Customer self-repair parts

The following customer self-repair parts are available for the product.

o  Paris listed as Mandatory self-replacement are to be installed by customers, unless you are

willing to pay HP service personnel to perform the repair. For these parts, on-site or return-to-depot

support is not provided under the HP product warranty.

o  Parts listed as Optional self-replacement can be installed by HP service personnel at your request
for no additional charge during the product warranty period.

E‘/{’NOTE: For more information, go to www.hp.com/go/learnaboutsupplies.

Table 3-1 Customer self-repair parts

Item Description Self-replacement options Part number

Toner cartridge, standard Replacement toner cartridge Mandatory CE255-67901

capacity

Toner cartridge, high capacity Replacement toner cartridge Mandatory CE255-67902

Tray 2 cassette assembly Replacement Tray 2 Mandatory RM1-8512-000CN

Complete 500 Sheet Feeder Optional 500-sheet feeder and ~ Mandatory CE530-69001

(Optional Tray 3) installation instructions

Document feeder roller Replacement roller for the Optional A8P79-65001

mainfenance kit document feeder

Document feeder separation pad  Replacement separation pad for ~ Optional A8P79-65010

mainfenance kit the document feeder

Power cable 220V-10A Replacement cable — China Mandatory 8121-0943

Power cable 110V-13A Replacement cable - Taiwan Mandatory 8121-0964

Power cable 220V-10A Replacement cable — Korea, EU Mandatory 8121-0731
Generic

Power cable 220V-6A Replacement cable — India Mandatory 8121-0564

Power cable 220V - 10A Replacement cable — UK/Asia Mandatory 8121-0739
Pacific

Power cable 220V - 10A Replacement cable — Australia/  Mandatory 8121-0837
New Zealand

Power cable 220V - 10A Replacement cable — Israel Mandatory 8121-1004

Power cable 220V - 10A Replacement cable — Denmark Mandatory 81210733

Power cable 220V - 10A Replacement cable — South Mandatory 81210737
Africa

Power cable 220V - 10A Replacement cable — Switzerland  Mandatory 8121-0738

Power cable 110V - 10A Replacement cable — Brazil Mandatory 8121-1071

Power cable 220V - 10A Replacement cable — Argentina Mandatory 81210729

ENWW

Customer self-repair parts
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Table 3-1 Customer self-repair parts (continued)

Item Description Self-replacement options Part number

Power cable 220V - 10A Replacement cable - South Mandatory 8121-0735
America/Chile/Peru

Power cable 220 / 110V Replacement cable — Thailand/  Mandatory 81210734
Philippines

Power cable 110V - 10A Replacement cable — Saudi Mandatory 8121-0740

Arabia/Others

32
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Accessories

ENWW

Item Description Part number

Optional 500-sheet tray and feeder unit  Optional tray to increase paper CE530A
capacity.

MFP Stand A storage cabinet that is installed CF338A
beneath the product.

USB cable 2-meter standard USB-compatible device C6518A

connector

Accessories
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Toner cartridge

e Toner-cartridge view

e Toner-cartridge information

e Replace the toner cartridge

Toner-cartridge view

1 Imaging drum

CAUTION: Do not touch the shutter or the surface of the roller. Doing so can damage the cartridge.

2 Memory chip

3 | Pull tab for the sealing tape
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Toner-cartridge information

Capacity Cariridge number Part number
Standard-capacity replacement black 55A CE255A

toner cartridge

High-capacity replacement black toner 55X CE255X
cartridge

For more information about supplies, go to www.hp.com/go/learnaboutsupplies.

The information contained herein is subject to change without notice. For the latest supplies information
go to www.hp.com/support/limfpM52 1 series.

Recycle the toner cartridge

To recycle a genuine HP toner cartridge, place the used cartridge in the box in which the new cartridge
arrived. Use the enclosed return label to send the used supply to HP for recycling. For complete
information, see the recycling guide that is included with each new HP supply item.

Toner-cartridge storage

Do not remove the toner cartridge from its package until you are ready to use it.

/\ CAUTION: To prevent damage to the toner cartridge, do not expose it to light for more than a few
minutes.

HP policy on non-HP toner cartridges

Hewlett-Packard Company cannot recommend the use of non-HP toner cartridges, either new or
remanufactured.

E’/?‘NOTE: Any damage caused by a non-HP toner cartridge is not covered under the HP warranty and
service agreements.
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Replace the toner cartridge

/\ CAUTION: If toner gets on clothing, wipe it off by using a dry cloth and wash the clothes in cold
water. Hot water sets toner into fabric.

I%NOTE: Information about recycling used toner cartridges is on the toner-cartridge box.

1. Press the front-door-release button.

2. Open the front door.
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3. Remove the used toner cartridge from the
product.

4. Remove the new toner cartridge from the bag.
Place the used toner cartridge in the bag for
recycling.

5. Grasp the front and back of the toner
cartridge, and distribute the toner by gently
rocking the toner cartridge five or six times.

CAUTION: Do not touch the shutter or the
surface of the roller.

6. Remove the sealing tape from the new toner
cartridge. Recycle the tape with the used toner
cartridge.

ENWW

Toner cartridge
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7. Align the toner cartridge with the tracks inside
the product, and insert the toner cartridge until
it is firmly seated.

8. Close the front door.
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Print

e  Supported print drivers (Windows)

e  Change print-job settings (Windows)

e  Change print-job settings (Mac OS X)

e  Print tasks (Windows)

e  Print tasks (Mac OS X)

e  Create archival-quality prints

e Use HP ePrint
e Use AirPrint

o Use walk-up USB printing
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Supported print drivers (Windows)

Print drivers provide access fo the product printing system. The following print drivers are available at
www.hp.com/go/limfpM52 1series_software.

HP PCL 6 driver o  Provided as the default driver on the in-box CD. This driver is automatically
installed unless you select a different one.

o  Recommended for all Windows environments

o  Provides the overall best speed, print quality, and productfeature support for
most users

o  Developed to align with the Windows Graphic Device Interface (GDI) for the
best speed in Windows environments

e Might not be fully compatible with third-party and custom software programs
that are based on PCL 5

HP UPD PS driver e Recommended for printing with Adobe® software programs or with other
highly graphics-intensive software programs

o Provides support for printing from postscript emulation needs, or for postscript
flash font support

HP UPD PCL 5 o  Recommended for general office printing in Windows environments
o  Compatible with previous PCL versions and older HP LaserJet products
o The best choice for printing from third-party or custom software programs

e  The best choice when operating with mixed environments, which require the
product to be set to PCL 5 (UNIX, Linux, mainframe)

o  Designed for use in corporate Windows environments to provide a single
driver for use with multiple product models

o  Preferred when printing to multiple product models from a mobile Windows
computer

HP UPD PCL 6 e Recommended for printing in all Windows environments

o  Provides the overall best speed, print quality, and printer feature support for
most users

o  Developed to align with Windows Graphic Device Interface (GDI) for best
speed in Windows environments

e  Might not be fully compatible with third-party and custom software programs
that are based on PCL 5

HP Universal Print Driver (UPD)

The HP Universal Print Driver (UPD) for Windows is a single print driver that gives you instant access to
virtually any HP LaserJet product, from any location, without downloading separate drivers. It is built on
proven HP print driver technology and has been tested thoroughly and used with many software
programs. It is a powerful solution that performs consistently over time.
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The HP UPD communicates directly with each HP product, gathers configuration information, and then
customizes the user interface to show the product’s unique, available features. It automatically enables
features that are available for the product, such as two-sided printing and stapling, so you do not need

to enable them manually.

For more information, go to www.hp.com/go/upd.

UPD installation modes

ENWW

Traditional mode

To use this mode, download UPD from the Internet. Go to www.hp.com/go/
upd.

Use this mode if you are installing the driver for a single computer.
It operates with a specific product.

If you use this mode, you must install UPD separately for each computer and
for each product.

Dynamic mode

To use this mode, download UPD from the Internet. Go to www.hp.com/go/
upd.

Dynamic mode allows you to use a single driver installation, so you can
discover and print to multiple networked HP producis in any location.

Use this mode if you are installing UPD for a workgroup.

Do not use this mode for USB-connected products.

Supported print drivers (Windows)
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Change print-job settings (Windows)

e  Priority for changing print-job settings

e Change the settings for all print jobs until the software program is closed

e Change the default settings for all print jobs

e Change the product configuration settings

Priority for changing print-job settings

Changes to print setftings are prioritized depending on where the changes are made:

I%NOTE: The names of commands and dialog boxes might vary depending on your software program.

o Page Setup dialog box: Click Page Setup or a similar command on the File menu of the
program you are working in fo open this dialog box. Settings changed here override settings
changed anywhere else.

o Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed in the Print dialog box
have a lower priority and usually do not override changes made in the Page Setup dialog box.

o Printer Properties dialog box (print driver): Click Properties in the Print dialog box to
open the print driver. Settings changed in the Printer Properties dialog box usually do not
override settings anywhere else in the printing software. You can change most of the print settings
here.

o Default print driver settings: The default print driver settings determine the settings used in all
print jobs, unfess seftings are changed in the Page Setup, Print, or Printer Properties dialog
boxes.

e  Product control-panel settings: Settings changed at the product control panel have a lower

priority than changes made anywhere else.

Change the settings for all print jobs until the software program is
closed

The steps can vary; this procedure is most common.
1. From the software program, select the Print option.

2. Select the product, and then click Properties or Preferences.
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Windows XP, Windows Server 2003, and Windows Server 2008 (using the
default Start menu view): Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the
Classic Start menu view): Click Start, click Settings, and then click Printers.

Windows Vista: Click the Windows icon in the lower-left corner of the screen, click Control
Panel, and then click Printers.

Windows 7: Click the Windows icon in the lower-left corner of the screen, and then click
Devices and Printers.

Right-click the print-driver icon for this product, and then select Printing Preferences.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the
default Start menu view): Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the
Classic Start menu view): Click Start, click Settings, and then click Printers.

Windows Vista: Click the Windows icon in the lower-left corner of the screen, click Control
Panel, and then click Printers.

Windows 7: Click the Windows icon in the lower-left corner of the screen, and then click
Devices and Printers.

Right-click the print-driver icon for this product, and then select Properties or Printer
properties.

Click the Device Settings tab.

Change print-job settings (Windows)
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Change print-job settings (Mac OS X)

e  Priority for changing print-job settings

e Change the settings for all print jobs until the software program is closed

e Change the default settings for all print jobs

e Change the product configuration settings

Priority for changing print-job settings

Changes to print setftings are prioritized depending on where the changes are made:

I%NOTE: The names of commands and dialog boxes might vary depending on your software program.

o Page Setup dialog box: Click Page Setup or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed here might override
settings changed anywhere else.

o Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed in the Print dialog box
have a lower priority and do nofoverride changes made in the Page Setup dialog box.

o Default printer driver settings: The default printer driver settings determine the settings used
in all print jobs, unfess settings are changed in the Page Setup, Print, or Printer Properties
dialog boxes.

o Product control-panel settings: Settings changed at the procuct control panel have a lower

priority than changes made anywhere else.

Change the settings for all print jobs until the software program is
closed

1. Click the File menu, and then click the Print option.
2. In the Printer meny, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list,
and then open a menu for which you want to change the print settings.

4. For each menu, select the print settings that you want to change.

5. Change the settings that you want on the various menus.

Change the default settings for all print jobs

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.
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By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list,
and then open a menu for which you want to change the print settings.

For each menu, select the print setftings that you want to save for reuse.
In the Presets menu, click the Save As... option, and enter a name for the preset.

Click the OK button.

These settings are saved in the Presets menu. To use the new settings, you must select the saved preset
option every time you open a program and print.

At the computer, open the Apple g menu, click the System Preferences item, and then click
the Print & Fax icon or the Print & Scan icon.

Select the product in the left side of the window.
Click the Options & Supplies button.
Click the Driver tab.

Configure the installed options.
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Print tasks (Windows)

e Use a printing shortcut (Windows)

e  Create printing shortcuts (Windows)

e  Automatically print on both sides (Windows)
e  Manually print on both sides (Windows)

e  Print multiple pages per sheet (Windows)

e  Select the page orientation (Windows)

e  Select the paper type (Windows)

e  Print the first or last page on different paper (Windows)
e Scale a document to fit page size (Windows)
e Create a booklet (Windows)

e Select the paper size (Windows)

e  Select a custom paper size (Windows)

e  Print watermarks (Windows)

e Cancel a print job (Windows)

Use a printing shortcut (Windows)

1. From the software program, select the Print
option.

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Printing Shortcuts tab.

4. Select one of the shortcuts. Click the OK
button to close the Document Properties
dialog box.

NOTE: When you select a shortcut, the
corresponding settings change on the other
tabs in the print driver.

5. In the Print dialog box, click the OK button to
print the job.
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Create printing shortcuts (Windows)

1. From the software program, select the Print
option.

2. Select the product, and then click the
Properties or Preferences button.

3. Click the Printing Shortcuts tab.

4. Select an existing shortcut as a base.

NOTE: Always select a shortcut before
adjusting any of the settings on the right side
of the screen. If you adjust the settings and
Ihen select a shortcut, all your adjustments are
ost.
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5. Select the print options for the new shorfcut.

6. Click the Save As button.
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7. Enter a name for the shortcut, and then click
the OK button.

8. Click the OK button to close the Document
Properties dialog box. In the Print dialog
box, click the OK button to print the job.

Chapter 4 Print

Printing Shortcuts

h arne
Flease type a name far the new printing shortzut,

rumber of cooles:
7) Current page Selection

from the start of the document or the
s=cton, For example, type 1, 3, 5-12
or plgl, plzd, ple3-phe3

Printwhat: |Document Znom

ER| £

Print: All pag=s inrange

Options...

L] =
P o Blesas
Type page numbers and/or page .
ranges separated by commas counting

Pagesper saeet: 1page E|
[

Scale to paper size: | Mo Sealing

Legal Size
[ Ok, J I Cancel |

& — =
(Print Em|

Printer

e | el

s de rird Printer... |

Type: - - -

Wikere: - - & [ Print to il

Comment: [Tl Manua dupiex

Page rarge Copies

@ al

0K ] Cancel .

ENWW



Avutomatically print on both sides (Windows)

The product supports the following paper sizes for automatic duplex printing:

o letter

o legal

o A4

e 85x13

The product supports the following paper types for automatic duplex printing:

o  Unspecified

e  Plain

e  HP EcoSMART Lite

o Light 60-74 g

e  Midweight 96-110 g
o letterhead

e  Preprinted

e  Prepunched

o  Colored

e Bond

e  Recycled

For other paper types or sizes, use manual duplex printing.

1. From the software program, select the Print
option.

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Finishing tab.

4. Select the Print on both sides check box.
Click the OK button to close the Document
Properties dialog box.

5. In the Print dialog box, click the OK button to
print the job.
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Manually print on both sides (Windows)

5.

For paper sizes and types that the automatic duplexer does not support, use manual duplex printing. To
use this option, the product must be configured to enable manual duplexing. The first five steps of the
following task need to be performed only one time. After that, you can manually print on both sides by

starting with step 6.

Windows XP, Windows Server 2003,
and Windows Server 2008 (using the
default Start menu view): Click Start,
and then click Printers and Faxes.

Windows XP, Windows Server 2003,
and Windows Server 2008 (using the
Classic Start menu view): Click Start,
click Settings, and then click Printers.

Windows Vista: Click the Windows icon in
the lower-left corner of the screen, click
Control Panel, and then click Printers.

Windows 7: Click the Windows icon in the
lower-left corner of the screen, and then click
Devices and Printers.

Right-click the print-driver icon, and then select
Printer properties.

Click the Device Settings tab.

Expand the list of Installable options, and
in the drop-down list next to Allow Manual
Duplexing: select Enabled.

Click the OK button.
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6. load Tray 1 with the paper for your document.

7. From the software program, select the Print

option.
8. Select the product, and then click the P T2
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10. Select the appropriate paper size for your e ) ===
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13. Retrieve the printed stack from the output bin,
and place it with the printed-side facing down
in Tray 1.

NOTE: Do not rotate or turn over the pages.

14. If prompted, touch the appropriate control
panel button to continue.
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Print multiple pages per sheet (Windows)

1. From the software program, select the Print
option.

2. Select the product, and then click the
Properties or Preferences button.

3. Click the Finishing tab.

4. Select the number of pages per sheet from the
Pages per sheet drop-down list.
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5. Select the correct Print page borders,
Page order, and Orientation options.
Click the OK button to close the Document
Properties dialog box.

6. In the Print dialog box, click the OK button to
print the job.
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Select the page orientation (Windows)

1. From the software program, select the Print
option.

2. Select the product, and then click the
Properties or Preferences button.

3. Click the Finishing tab.
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4.

5.

In the Orientation areq, select the Portrait
or Landscape option.

To print the page image upside down, select
the Rotate by 180 degrees option.

Click the OK button to close the Document
Properties dialog box.

In the Print dialog box, click the OK button to
print the job.
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Select the paper type (Windows)

1. From the software program, select the Print

option.
2. Select the product, and then click the P &
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5. Expand the list of Type is: options. Type is: X

ooy 960

F- Presentation 96-130q
B Brochure 131-175g
B Other

6. Expand the category of paper types that best Type is: [t i L
describes your paper. -

- Rracknre 131-1754g -
—roruchrome Laser Transparency
- Labels
- Letterhead
- Envelope
- Preprinted
- Prepunched
-~ Colored
- Bond
- Recvcled
- Riough
- Mellum =%

m

1
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7. Select the option for the type of paper you are Type is: [
using, and click the OK button. '

[ Brochure 131-175g ;
= Other
L Mannchreme Laser Transparency
“Lefernead
-Envelope
-Preprinted
-Prepunched .
Colored
?-Band
-Recycled
?-Ruugh
“ovellum ':
8]4 I | Cancel |
8. Click the OK button to close the Document (Dint. B
Properties dialog box. In the Print dialog prner
box, click the OK button to print the job. Nome: [ @ - . Tl Lo ]
-
Where: - —— [ Print to fle
Comment: [ Manua dupex
Page range Copies
] number of coples: 1

P B
7 current page Selection : 1 E
@ Pages: | ' 5 2] olate
Type page numbers and/or page

ranges separated by cormas counting
from the start of the document or the
s=cton, For example, type 1, 3, 512
orplel, plsl, ple3-p8c3

Zoom

Pages per sheet: 1page E|
=]

Printwhat: |Document

ER| £

Print: Al pag=s in range
Scale to paper size: | Mo Sealing

.mems.‘. | ' Cancel ;

ENWW Print tasks (Windows) 63



64

Print the first or last page on different paper (Windows)

1. From the software program, select the Print
option.

2. Select the product, and then click the
Properties or Preferences button.

3. Click the Paper/Quality tab.

4. In the Special pages areq, click the Print
pages on difterent paper option, and
then click the Settings button.
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5. In the Pages in document areq, select
either the First or Last option.

6. Select the correct options from the Paper

source and Paper type drop-down lists.
Click the Add button.

7. If you are printing both the first and last pages
on different paper, refeof steps 5 and 6,
selecting the options for the other page.
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[t |
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|
|
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8. Click the OK button.

9. Click the OK button to close the Document
Properties dialog box. In the Print dialog
box, click the OK button to print the job.
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Specisl Fager Sy st
Special Pages
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Print: All pag=s inrange

Print what: Docu'n:nt -3

Pagesper saeet: 1page

Seale fo paper size: | Na Sceling

Deee |
oK i Cancel
Drint

Printer
fame: @; - - - - 3 Fropertize.
= -
Type: " - = =
Where: o — - —— [T Print to e
Comment: [T Manua dupex
Page range Copies.
@ Al number of coples:
7 CuTentpage selection - 1
) Pages: | B B N 1 3 2] Colate

Type page numbers and/or page

ranges separated by commas counting

from the start of the document or the

s=cton, For example, type 1, 3, 5-12

or plgl, plzd, ple3-pBs3

Zoom
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Scale a document to fit page size (Windows)

1. From the software program, select the Print
option.

2. Select the product, and then click the
Properties or Preferences button.

3. Click the Effects tab.
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4.

Select the Print document on option, and
then select a size from the drop-down list.

Click the OK button to close the Document
Properties dialog box.

In the Print dialog box, click the OK button to (int
print the job. Printer
fame: l'*l
Status: Idle
Type:
Where: -
Comment:
Page rarge
@ Al
(7] current page Selection
) Pages:
Type page numbers and/for page

or plgl, plzd, ple3-phe3
Printwhat: |Documnent

Print: All pag=s inrange

Options...

ranges separated by commas counting
from the start of the document or the
section, For example, type 1, 3, 5-12

Copies
rumber of cooles:

3

Zoom
Pagesper saeet:

Scale to paper size:

[

o=

Z|| Fropertize |
rird Printer... |

[ Print to #le
[ Manuat dupex

] colate

1page
Mo Sealing

ok ||| coe |

EX|ET}
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Create a booklet (Windows)

1. From the software program, select the Print
option.

2. Select the product, and then click the
Properties or Preferences button.

3. Click the Finishing tab.

4. Select the Print on both sides check box.
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5. In the Booklet layout drop-down list, click
the Left binding or Right binding option.
The Pages per sheet option automatically
changes to 2 pages per sheet.

Click the OK button to close the Document
Properties dialog box.

6. In the Print dialog box, click the OK button to
print the job.

Select the paper size (Windows)

P

Sihvanced | Priniing Shoilcuts | PaositDusliy | Efzcls

Decurmert Optios.

[ Prrk on bolh ades (marusl]

|2 pinges pevshest =
Pt piage berde:

=

Decument Propertics
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Disralon
@ Forrat
Landwcape

] Rickaba by 180 dagiess

Bri

| Brint

inter

fame: @I

Status: Idle
Type: - - -
Where: - -

Commert:

Page range

®

) Current page

2l

Selection

Printwhat: |Documnent

Prin

Type page numbers and/or page
ranges separated by commas counting
from the start of the document or the
s=cton, For example, type 1, 3, 5-12
or plgl, plzd, ple3-phe3

£ All pag=s inrange e

[E1[E]

Options...

=]

Bl—n

Copies
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Zoom
Pages per sheet: 1page

Scale fo paper sige: | Mo Scaling

0K ]

rird Printer... |
[ Print to file
[T Manual duplex

EX|ET}

Cancel |

1. From the software program, select the Print option.

Click the Paper/Quality tab.

Click the OK button.

o v s wPp

Select a custom paper size (Windows)

Select a size from the Paper size drop-down list.

In the Print dialog box, click the OK button to print the job.

1. From the software program, select the Print option.

Select the product, and then click the Properties or Preferences button.

2. Select the product, and then click the Properties or Preferences button.
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Click the Paper/Quality tab.

Click the Custom button.

Type a name for the custom size and specify the dimensions.
e  The width is the short edge of the paper.

e The length is the long edge of the paper.

Click the Save button, and then click the Close button.

Click the OK button to close the Document Properties dialog box. In the Print dialog box,
click the OK button to print the job.

From the software program, select the Print option.

Select the product, and then click the Properties or Preferences button.
Click the Effects tab.

Select a watermark from the Watermarks drop-down list.

Or, to add a new watermark to the list, click the Edit button. Specify the settings for the
watermark, and then click the OK button.

To print the watermark on the first page only, select the First page only check box. Otherwise,

the watermark is printed on each page.

Click the OK button to close the Document Properties dialog box. In the Print dialog box,
click the OK button to print the job.

Print tasks (Windows)
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If the print job is currently printing, cancel it by pressing the Cancel 3¢ button on the product
control panel.

E‘/?’ If the print job is too far into the printing process, you might not have the option to
cancel it.

129),

2 Pressing the Cancel X button clears the job that the product is currently processing. If
more than one process is running, pressing the Cancel X button clears the process that currently
displays on the product control panel.

You can also cancel a print job from a software program or a print queue.

e Software program: Typically, a dialog box displays briefly on the computer screen,
allowing you to cancel the print job.

e Windows print queue: If a print job is waiting in a print queue (computer memory) or
print spooler, delete the job there.

Windows XP, Server 2003, or Server 2008: Click Start, click Settings, and
then click Printers and Faxes. Double-click the product icon to open the window,
right-click the print job that you want to cancel, and then click Cancel.

Windows Vista: Click the Windows icon in the lower left corner of the screen, click
Settings, and then click Printers. Double-click the product icon to open the window,
right-click the print job that you want to cancel, and then click Cancel.

Windows 7: Click the Windows icon in the lower left corner of the screen, and then
click Devices and Printers. Double-click the product icon to open the window, right-
click the print job that you want to cancel, and then click Cancel.
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Print tasks (Mac OS X)

Use a

Use a printing preset (Mac OS X)

Create a printing preset (Mac OS X)

Automatically print on both sides (Mac OS X)

Manually print on both sides (Mac OS X)

Print multiple pages per sheet (Mac OS X)

Select the page orientation (Mac OS X)

Select the paper type (Mac OS X)

Print a cover page (Mac OS X)

Scale a document to fit page size (Mac OS X)

Create a booklet (Mac OS X)

Select the paper size (Mac OS X)

Select a custom paper size (Mac OS X)

Print watermarks (Mac OS X)

Cancel a print job (Mac OS X)

printing preset (Mac OS X)

1.
2.
3.
4.

Click the File menu, and then click the Print option.
In the Printer menu, select the product.
In the Presets menu, select the printing preset.

Click the Print button.

E’%NOTE: To use printdriver default settings, select the standard option.

Create a printing preset (Mac OS X)

ENWW

Use printing presets to save the current print settings for reuse.

1.
2,
3.

Click the File menu, and then click the Print option.
In the Printer menu, select the product.

By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list,
and then open a menu for which you want to change the print settings.

For each menu, select the print setftings that you want to save for reuse.

Print tasks (Mac OS X)
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5. Inthe Presets menu, click the Save As... option, and enter a name for the preset.

6. Click the OK button.

Automatically print on both sides (Mac OS X)

The product supports the following paper sizes for automatic duplex printing:

o letter

o legal

o A4

e 85x13

The product supports the following paper types for automatic duplex printing:
e  Unspecitied

e  Plain

e  HP EcoSMART Lite

o Light 60-74 g

e  Midweight 96-110 g
o letterhead

e  Preprinted

e  Prepunched

o Colored

e Bond

e  Recycled

For other paper types or sizes, use manual duplex printing.

—h
.

Click the File menu, and then click the Print option.
2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list,
and then click the Layout menu.

4. Select a binding option from the Two-Sided drop-down list.
5. Click the Print button.
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Manually print on both sides (Mac OS X)

1.
2,

@

N o s

Click the File menu, and then click the Print option.
In the Printer menu, select this product.

By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list,
and then click the Manual Duplex menu.

Click the Manual Duplex box, and select a binding option.
Click the Print button.
Go to the product, and remove any blank paper that is in Tray 1.

Retrieve the printed stack from the output bin and place it with the printed-side facing down in the
input tray.

@NOTE: Do not rotate or turn over the pages.

8.

If prompted, touch the appropriate control panel button to continue.

Print multiple pages per sheet (Mac OS X)

1.
2,

Click the File menu, and then click the Print option.
In the Printer menu, select the product.

By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list,
and then click the Layout menu.

From the Pages per Sheet drop-down list, select the number of pages that you want to print on
each sheet.

In the Layout Direction areq, select the order and placement of the pages on the sheet.
From the Borders menu, select the type of border to print around each page on the sheet.

Click the Print button.

Select the page orientation (Mac OS X)

ENWW

1.

2
3.
4

Click the File menu, and then click the Print option.
In the Printer menu, select the product.
In the Copies & Pages menvy, click the Page Setup button.

Click the icon that represents the page orientation that you want to use, and then click the OK
button.

Click the Print button.

Print tasks (Mac OS X)
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Select the paper type (Mac OS X)

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list,
and then click the Finishing menu.

4. Select a type from the Media-type drop-down list.
5. Click the Print button.

Print a cover page (Mac OS X)
1. Click the File menu, and then click the Print option.
2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list,
and then click the Cover Page menu.

4. Select where to print the cover page. Click either the Before Document button or the After
Document button.

5. Inthe Cover Page Type menu, select the message that you want to print on the cover page.

E/?NOTE: To print a blank cover page, select the standard option from the Cover Page Type
menu.

6. Click the Print button.

Scale a document to fit page size (Mac OS X)
1. Click the File menu, and then click the Print option.
2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list,
and then click the Paper Handling menu.

4. Inthe Destination Paper Size areq, click the Scale to fit paper size box, and then select
the size from the drop-down list.

5. Click the Print button.

Create a booklet (Mac OS X)

1. Click the File menu, and then click the Print option.

2. In the Printer menu, select the product.

3. By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list,
and then click the Layout menu.
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Select a binding option from the Two-Sided drop-down list.

Open the menus drop-down list, and then click the Booklet Printing menu.
Click the Format Output as Booklet box, and select a binding option.
Select the paper size.

Click the Print button.

Click the File menu, and then click the Print option.

In the Printer menu, select the product.

In the Copies & Pages meny, click the Page Setup button.

Select a size from the Paper Size drop-down list, and then click the OK button.

Click the Print button.

Click the File menu, and then click the Print option.

In the Printer menu, select the product.

In the Copies & Pages menvy, click the Page Setup button.

From the Paper Size drop-down list, select the Manage Custom Sizes option.
Specify the dimensions for the page size, and then click the OK button.

Click the OK button to close the Page Setup dialog.

Click the Print button.

Click the File menu, and then click the Print option.
In the Printer menu, select the product.

By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list,
and then click the Watermarks menu.

From the Mode menu, select the Watermark option.

From the Pages drop-down list, select whether to print the watermark on all pages or on the first
page only.

From the Text drop-down list, select one of the standard messages, or select the Custom option
and type a new message in the box.

Print tasks (Mac OS X)
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7. Select options for the remaining settings.

8. Click the Print button.

Cancel a print job (Mac OS X)

1. |If the print job is currently printing, cancel it by pressing the Cancel X< button on the product
control panel.

E%?NOTE: If the print job is too far into the printing process, you might not have the option to
cancel it.

E’%NOTE: Pressing the Cancel X< button clears the job that the product is currently processing. If
more than one print job is waiting, pressing the Cancel X button clears the print job that currently
displays on the product control panel.

2. You can also cancel a print job from a software program or a print queue.

e Software program: Typically, a dialog box displays briefly on the computer screen,
allowing you to cancel the print job.

e  Mac print queue: Open the print queue by double-licking the product icon in the dock.
Highlight the print job, and then click Delete.
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Create archival-quality prints

Archive print produces output that is less susceptible to toner smearing and dusting. Use archive print to
create documents that you want to preserve or archive.

E”/{’NOTE: Archival-quality printing is accomplished by increasing the temperature of the fuser. Because
of the increased temperatures, the product prints at half-speed to avoid damage.

1. From the Home screen on the product control panel, touch the Setup 8\, button.
2. Touch the Service menu.

3. Touch the Archive Print button, and then touch the On button.
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Use HP ePrint to print documents by sending them as an email attachment to the product's email
address from any email enabled device.

Rkk))

2 The product must be connected to a wired or wireless network and have Internet access to use
HP ePrint.

To use HP ePrint, you must first enable HP Web Services.
a. From the Home screen on the product control panel, touch the Web Services @& button.
b. Touch the button.

From the menu, fouch the button to display the product's
email address on the control panel.

Use the HP ePrintCenter Web site to define security settings and to configure default print settings
for all HP ePrint jobs sent to this product.

a. Goto
b. Click Sign In, and enter your HP ePrintCenter credentials or sign up for a new account.

c. Select your product from the list, or click + Add printer to add it. To add the product, you
need the printer code, which is the segment of the product email address that is before the @
symbol. You can get this code by printing the Web Services page from the product control
panel.

After you have added your product, you will have the option to customize the product email
address.

E/%" This code is valid for only 24 hours from the time you enable HP Web Services. If it
expires, follow the instructions to enable HP Web Services again, and obtain a new code.

d. To prevent your product from printing unexpected documents, click ePrint Settings, and
then click the Allowed Senders tab. Click Allowed Senders Only, and add the email
addresses from which you want to allow ePrint jobs.

e. To set up default settings for all ePrint jobs sent to this product, click ePrint Settings, click
Print Options, and select the settings that you want to use.

To print a document, attach it to an email message sent to the product's email address. Both the
email message and the attachment will print.
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Use AirPrint

Direct printing using Apple’s AirPrint is supported for iOS 4.2 or later. Use AirPrint to print directly to
the product from an iPad (iOS 4.2), iPhone (3GS or later), or iPod touch (third generation or later) in
the following applications:

° Mail
e Photos
e Safari

o  Select third-party applications

To use AirPrint, the product must be connected to a network. For more information about using AirPrint
and about which HP products are compatible with AirPrint, go to www.hp.com/go/airprint.

2 NOTE:  You might need to upgrade the product firmware to use AirPrint. Go to www.hp.com/go
limfpM52 1series_firmware.

ENWW

Use AirPrint
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Use walk-up USB printing

1. Insert the USB flash drive into the USB port on
the front of the product.

2. The USB Flash Drive menu opens. Touch the
arrow buttons to scroll through the options.

e Print Documents
e View and Print Photos
e Scan to USB Drive

3. To print a document, touch the Print Documents
screen, and then touch the name of the folder
on the USB drive where the document is
stored. When the summary screen opens, you
can touch it to adjust the settings. Touch the
Print button to print the document.

4. To print photos, touch the View and Print
Photos screen, and then touch the preview
image fo select each photo that you want to
print. Touch the Done button. When the
summary screen opens, you can touch it to
adjust the settings. Touch the Print button to
print the photos.

5. Retrieve the printed job from the output bin,
and remove the USB flash drive.
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Set new default copy settings

Restore copy default settings

Make a single copy

Make multiple copies

Copy a multiple-page original

Copy identification cards

Collate a copy job

Copy on both sides (duplex)

Reduce or enlarge a copy

Optimize copy quality

Adjust the lightness or darkness for copies

Copy in draft mode

Set the paper size and type for copying on special paper
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Set new default copy settings

You can save any combination of copy settings as the default settings to use for every job.
1. From the Home screen, touch the Copy button.
2. Touch the Settings button.

3. Configure the copy settings to meet your preferences, and then scroll to and touch the Set as New
Defaults button.

4. Touch the Yes button.
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Restore copy default settings

ENWW

Use this procedure to restore the factory default copy settings.

1.

2
3.
4

From the Home screen, touch the Copy button.
Touch the Settings button.
Scroll to and touch the Restore Defaulis button.

Touch the OK button to restore the defaults.

Restore copy default settings
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Make a single copy

1. Lload the document onto the scanner glass or
info the document feeder.

NOTE: If documents are in the document
feeder and on the scanner glass at the same
time, the product processes the document in
the document feeder and not the one on the
scanner glass.

2. If you loaded the document into the document
feeder, adjust the guides until they are snug
against the paper.

3. From the Home screen on the product control
panel, touch the Copy button.

4. Touch the Start Copy button to start copying.
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Make multiple copies

1. Lload the document onto the scanner glass or
into the document feeder.

NOTE: If documents are in the document
feeder and on the scanner glass at the same
time, the product processes the document in
the document feeder and not the one on the
scanner glass.

2. If you loaded the document into the document
feeder, adjust the guides until they are snug
against the paper.

3. From the Home screen on the product control
panel, touch the Copy button.

4. Touch the arrows to change the number of
copies, or fouch the existing number and enter
the number of copies.

5. Touch the Start Copy button to start copying.
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Copy a multiple-page original

1. Insert the originals into the document feeder
face-up.

2. Adjust the guides until they are snug against
the paper.

3. From the Home screen, touch the Copy button.

4. Touch the Start Copy button to start copying.
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Copy identification cards

Use the ID Copy feature to copy both sides of identification cards, or other smallsize documents, onto
the same side of one sheet of paper. The product prompts you to copy the first side and then to place
the second side on a different area of the scanner glass and copy again. The product prints both
images at the same time.

1. Lload the document onto the scanner glass.

From the Home screen, touch the Copy button.
Touch the 1D Copy button.
Touch the Start Copy button to start copying.

L O

The product prompts you to place the next
page on a different section of the scanner
glass.

6. Touch the OK button if you have more pages
to copy, or touch the Done button if this is the
last page.

7. The product copies all pages onto one side of
a sheet of paper.
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Collate a copy job

90

Load the document onto the scanner glass or
info the document feeder.

NOTE: If documents are in the document
feeder and on the scanner glass at the same
time, the product processes the document in
the document feeder and not the one on the
scanner glass.

From the Home screen on the product control
panel, touch the Copy button.

Touch the Settings button, and then scroll to
and touch the Collation button. Touch the
arrow buttons to scroll through the options,
and then touch an option to select it.

Touch the Start Copy button to start copying.

Chapter 5 Copy
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Copy on both sides (duplex)

Copy on both sides automatically

1. Lload the original documents into the document
feeder with the first Foge facing up, and with
the top of the page leading.

2. Adjust the paper guides to fit the size of the
document.

3. From the Home screen on the product control
panel, touch the Copy button.

Touch the Settings button.
Scroll to and touch the Two-Sided button.

Touch the arrow buttons to scroll through the
options, and then touch an option to select it.

7. Touch the Start Copy button to start copying.
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Copy on both sides manually

1. Place the document face-down on the scanner
lass with the upper-left corner of the page in
the upper-left corner of the glass. Close the
scanner.

2. From the Home screen on the product control
panel, touch the Copy button.

3. Touch the Settings button.
Scroll to and touch the Two-Sided button.

Touch the arrow buttons to scroll through the
options, and then touch an option to select it.

Touch the Start Copy button to start copying.

The product prompts you to load the next
original document. Place it on the glass, and
then touch the OK button.

8. Repeat this process until you have scanned the
last page. Touch the Done button to finish
printing the copies.
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Reduce or enlarge a copy

1. Lload the document onto the scanner glass or
into the document feeder.

NOTE: If documents are in the document
feeder and on the scanner glass at the same
time, the product processes the document in
the document feeder and not the one on the
scanner glass.

2. From the Home screen on the product control
panel, touch the Copy button.

3. Touch the Seftings button, and then touch the
Reduce/Enlarge button. Touch the arrow
buttons to scroll through the options, and then
touch an option to select it.

4. Touch the Start Copy button to start copying.

ENWW Reduce or enlarge a copy 93



Optimize copy quality
The following copy-quality settings are available:

e Auto Select: Use this sefting when you are not concerned about the quality of the copy. This is the
default setting.

e  Mixed: Use this setting for documents that contain a mixture of text and graphics.
e  Text: Use this setting for documents that contain mostly text.

e  Picture: Use this setting for documents that contain mostly graphics.

1. Load the document onto the scanner glass or
into the document feeder.

From the Home screen, touch the Copy button.

3. Touch the Settings button, and then scroll to
and touch the Optimize button. Touch the
arrow buttons to scroll through the options,
and then touch an option to select it.

4. Touch the Start Copy button to start copying.
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Adjust the lightness or darkness for copies

1. Lload the document onto the scanner glass or
into the document feeder.

From the Home screen, touch the Copy button.
Touch the Settings button.
Touch the Lighter/Darker button.

L S B

Touch the “+” or “-" button to adjust the
setting, and then touch the OK button.

6. Touch the Start Copy button to start copying.
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Copy in draft mode

Using draft mode can use less toner. However, using draft mode can also reduce print quality.

HP does not recommend the fulltime use of draft mode. If draft mode is used full-time, the toner supply
might outlast the mechanical parts in the toner cartridge. If print quality begins to degrade and is no
longer acceptable, consider replacing the toner cartridge.

1. Load the document onto the scanner glass or
into the document feeder.

From the Home screen, touch the Copy button.
Touch the Settings button.

Scroll to and touch the Draft Mode button.
Touch the On button.

o u ke

Touch the Start Copy button to start copying.
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Set the paper size and type for copying on special
paper

1. From the Home screen, touch the Copy button.

2. Touch the Settings button, and then scroll to and touch the Paper button.

3.  From the list of paper sizes, touch the name of the paper size that is in Tray 1.

|"_12NOTE: The product supports these sizes for copying: Letter, Legal, and A4.

4. From the list of paper types, touch the name of the paper type that is in Tray 1.

5. Touch the Start Copy button to start copying.
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Scan

e Scan by using the HP Scan software (Windows)

e Scan by using the HP Scan software (Mac OS X)

e Scan to a USB flash drive

e Set up scan to network folder and scan to email features

e Scan to a network folder

e  Scan to email

e Scan by using other software
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Scan by using the HP Scan software (Windows)

1. Double<click the HP Sean icon on the computer desktop. If the icon is not on the computer
desktop, open the Programs folder, click HP, open the folder for this product, and then click HP
Scan.

2. Select a scanning shortcut, and adjust the settings if necessary.

3. Click Scan.

E/?NOTE: Click Advanced Settings to gain access to more options.

Click Create New Shortcut to create a customized set of settings and save it in the list of shortcuts.
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Scan by using the HP Scan software (Mac OS X)

1. Open the HP Scan software, which is located in the Hewlett-Packard folder inside the
Applications folder.

2. Follow the on-screen instructions to scan the document.

3.  When you have scanned all the pages, click the Send button to print the pages or save them to a
file.
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Scan to a USB flash drive

1. Load the document onto the scanner glass or info the document feeder.
Insert a USB flash drive into the port on the front of the product.
From the Home screen on the product control panel, touch the Scan button.

Touch the Scan to USB Drive screen.

L S

Touch the Scan button to scan and save the file. The product creates a folder named HPSCANS
on the USB drive, and it saves the file in .PDF or .JPG format using an automatically generated file
name.

E/?NOTE: When the summary screen opens, you can touch it to adjust settings.

You also can change the folder name.
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Set up scan to network folder and scan to email
features

To use these scan features, the product must be connected to a network. These scan features are not
available until you configure them. Use the Scan to Network Folder Setup Wizard (Windows) and the
Scan to Email Wizard (Windows) at the end of the product software installation process, or use the HP
Embedded Web Server to configure these features. The following instructions describe configuring the
scan features by using the HP Embedded Web Server.

Configure the scan to network folder feature

' From the Home screen on the product control panel, touch the Network Oﬁqlﬁ button to find the

product IP address.

2. To open the HP Embedded Web Server, enter the product IP address into the address line of a
Web browser.

@NOTE: You can also access the HP Embedded Web Server from the HP Device Toolbox for
Windows or the HP Utility for Mac OS X.

Click the Sean tab.
Click the Scan to Network Folder Setup link in the left pane of the screen.

3
4
5. To set up a new folder, click the New button.
6. Complete the fields on this screen.

7

Click the Save and Test button at the bottom of the screen to save the settings and test the setup.

Configure the scan to emadail feature

- From the Home screen on the product control panel, touch the Network Oﬁqlﬁ button to find the

product IP address.

2. To open the HP Embedded Web Server, enter the product IP address into the address line of a
Web browser.

2 NOTE:  You can also access the HP Embedded Web Server from the HP Device Toolbox for
Windows or the HP Utility for Mac OS X.

Click the Scan tab.

3

4. Click the Scan to E-mail Setup link in the left pane of the screen.

5. Click the Outgoing E-mail Profiles link, and then click the New button.
6

Complete the fields on this screen. Ask your network administrator or your Internet service provider
for the SMTP Server information. If the SMTP server requires authentication, you also need to know
the SMTP User ID and password.
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Click the Save and Test button at the bottom of the screen to save the seftings and test the setup.

You can add contacts to the Email Address Book or configure other default Email Settings. These
steps are optional. Click the E-mail Address Book link and the E-mail Options links in the
left pane of the screen to set up these features.
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Scan to a network folder

Use the product control panel to scan a document and save it to a folder on the network.

E/?NOTE: In order to use this feature, the product must be connected to a network and the scan feature
must be configured using the HP Embedded Web Server.

1. Lload the document onto the scanner glass or into the document feeder.

2.  From the Home screen on the product control panel, touch the Scan button.

3. Touch the Scan to Network Folder item.

4. In the list of network folders, select the folder to which you want to save the document.
5. The control panel screen displays the scan settings.

e If you want to change any of the settings, touch the Seftings button, and then change the
settings.

e If the seftings are correct, go fo the next step.

6. Touch the Scan button to start the scan job.
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Scan to email

Use the product control panel to scan a file directly o an email address. The scanned file is sent to the
address as an email message attachment.

2»NOTE:  In order to use this feature, the product must be connected to a network and the scan feature
must be configured using the HP Embedded Web Server.

1. Lload the document onto the scanner glass or info the document feeder.

From the Home screen on the product control panel, touch the Scan button.

2

3. Touch the Scan to E-mail item.
4. Touch the Send an E-mail item.
5

n

Select the From address that you want to use. This is also known as an “outgoing email profile.

2 NOTE:  If the PIN feature has been set up, enter the PIN and touch the OK button. However, a
PIN is not required to use this feature.

6. Touch the To button and pick the address or group to which you want to send the file. Touch the
Done button when finished.

7. Touch the Subject button if you would like to add a subject line
8. Touch the Next button.
9. The control panel screen displays the scan settings.

e If you want to change any of the seftings, fouch the Seftings button, and then change the
settings.

e If the seftings are correct, go to the next step.

10. Touch the Scan button to start the scan job.
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Scan by using other software

If you install the full product software, the product is TWAIN-compliant and Windows Imaging
Application (WIA)-compliant. If you install the minimum product software, the product is WIA-compliant.
The product works with Windows-based programs that support TWAIN-compliant or WIA-compliant
scanning devices.

While you are in a TWAIN-compliant or WIA-compliant program, you can gain access to the scanning
feature and scan an image directly into the open program. For more information, see the Help file or
the documentation that came with your TWAIN-compliant or WIA-compliant software program.

Scan from a TWAIN-compliant program (Windows)

Generally, a software program is TWAIN-compliant if it has a command such as Acquire, File
Acquire, Scan, Import New Obiject, Insert from, or Scanner. If you are unsure whether the
program is compliant or you do not know what the command is called, see the software program Help
or documentation.

When scanning from a TWAIN-compliant program, the HP Scan software program might start
automatically. If the HP Scan program starts, you can make changes while previewing the image. If the
program does not start automatically, the image goes to the TWAIN-compliant program immediately.

Start the scan from within the TWAIN-compliant program. See the software program Help or

documentation for information about the commands and steps to use.

Scan from a WIA-compliant program (Windows)

WIA is another way to scan an image directly into a software program. WIA uses Microsoft software
to scan, instead of the HP Scan software.

Generally, a software program is WIA-compliant if it has a command such as Picture/From
Scanner or Camera in the Insert or File menu. If you are unsure whether the program is WIA-
compliant, see the software program Help or documentation.

Start the scan from within the WIA-compliant program. See the software program Help or
documentation for information about the commands and steps to use.

-Or-

From the Windows control panel, in the Cameras and Scanner folder (located inside the
Hardware and Sound folder for Windows Vista and Windows 7), double-click the product icon.
This opens the standard Microsoft WIA Wizard, which enables you to scan to a file.
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e Set up the product for fax

e  Use the phone book

e Configure send fax settings

e  Configure receive fax settings

e  Set fax polling

e Use fax
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Set up the product for fax

Connect the fax port to a telephone line

1. Connect the telephone cable to the fax port on
the product and to the telephone jack on the
wall.

The product is an analog device. HP recommends using the product on a dedicated analog telephone
line.

I%NOTE: Some countries/regions might require an adapter to the telephone cable that came with the
product.

Connect additional devices

The product includes two fax ports:

*  The fax “line in” port {5, which connects the product to the wall telephone jack.

®  The fax “telephone line out” port {3, which connects additional devices to the product.
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Telephones used in conjunction with the product can be employed in two ways:
An extension phone is connected to the same phone line at another location.

A downstream phone is connected to the product or to another device that is connected to the
product.

Connect additional devices in the order that is described in the following steps. The output port for each
device is connected to the input port of the next, forming a "chain". If you do not want fo connect a
specific device, skip the step that explains it and continue to the next device.

l"_f‘/{’ Do not connect more than three devices to the telephone line.
E‘/?’ Voicemail is not supported with this product.

Disconnect the power cords for all of the devices that you want to connect.

Connect the product to a telephone jack.
Remove the plastic insert from the "telephone line out" port {3 .

To connect an internal or external modem on a computer, connect one end of a telephone cord
info the product “telephone line out” port {3 . Connect the other end of the telephone cord into the

fax “line in” port 5| on the modem or computer.

= Some modems have a second “line” port to connect to a dedicated voice line. If you

have two “line” ports, see your modem documentation to make sure that you connect to the correct
“line” port.

1.

To connect a callerID box, connect a telephone cord into the previous device's “telephone” port.
Connect the other end of the telephone cord into the caller-ID box “line” port.

To connect an answering machine, connect a telephone cord into the previous device's
“telephone” port. Connect the other end of the telephone cord into the answering machine “line”
port.

To connect a telephone, connect a telephone cord into the previous device’s “telephone” port.
Connect the other end of the telephone cord into the telephone “line” port.

After you have finished connecting additional devices, connect all of the devices to their power
sources.

If you connect a telephone answering machine to the product, follow these steps to configure the
product:

E‘/?’ If an answering machine is connected to the same telephone line but on a different jack (in
another room, for example), it might interfere with the product's ability o receive faxes.

From the Home screen on the product control panel, touch the Setup 2\, button.

Touch the button.
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Touch the button.
Touch the button.

Set the product rings-to-answer setting for at least one ring more than the number of rings for
which the answering machine is set. Use the keypad to enter the number of rings, and then touch

the button.

Touch the back 4 button to return to the menu.

Scroll to and touch the button.

Touch the button. With this setting, the product listens for fax tones after the answering

machine has picked up the call. The product picks up a call if fax tones are detected.

If you connect an extension phone to the product, follow these steps to configure the product:

On the control panel, touch the Setup &\, button.

Scroll to and touch the button.
Scroll to and touch the button.
Scroll to and touch the button, and confirm that the On option is selected.

With this setting turned on, you can alert the product to pick up the incoming fax call by pressing
1-2-3 sequentially on the telephone keypad. Turn this setting off only if you use pulse dialing or if
you have a service from your telephone company that also uses the 1-2-3 sequence. The telephone
company service does not work if it conflicts with the product.

Touch the back 4 button twice to return to the menu.

Touch the button.

Scroll to and touch the button.

Touch the button. With this setting, the product automatically picks up all calls and

determines if the call is a voice or fax call. If the call is a fax call, the product handles the call as
an incoming fax. If the incoming call is detected as a voice call, the product generates an audible
synthesized ring to alert you of an incoming voice call.

Touch the back 4 button twice to return to the menu.
Scroll to and touch the button.
Scroll to and touch the button.

Select the number of seconds affer which the product should stop sounding the Fax/Tel audible
ring to notify you of an incoming voice call.
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Set up for stand-alone fax

You can use the product as a stand-alone fax machine without connecting it to a computer or a
network.

1. Unpack and set up the product.

2. From the Home screen on the product control panel, touch the Setup &\, button.
3. Touch the Fax Setup button.

4. Touch the Fox Set-Up Utility button.

5. Follow the on-screen prompts and select the appropriate response for each question.

%%NOTE: The maximum number of characters for the fax number is 20.

@NOTE: The maximum number of characters for the fax header is 25.

Configure the fax time, date, and header

If you did not complete the fax setup process at the time you installed the software, you can complete it
at any time by using one of these methods.

Use the control panel to set the fax time, date, and header

—h
.

From the Home screen on the product control panel, touch the Setup S\, button.
Touch the Fax Setup button.

Touch the Basic Setup button.

Scroll to and touch the Time/Date button.

Select the 12-hour clock or 24-hour clock.

Select the date format.

2

3

4

5

6. Use the keypad to enter the current time, and then touch the OK button.
7

8. Use the keypad to enter the current date, and then touch the OK button.
9

Touch the Fax Header button.

10. Use the keypad to enter your fax number, and then touch the OK button.

@NOTE: The maximum number of characters for the fax number is 20.

11. Use the keypad to enter your company name or header, and then touch the OK button.

To enter special characters that are not on the standard keypad, touch the 123 button to open a
keypad that contains special characters.

@NOTE: The maximum number of characters for the fax header is 25.
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Use the HP Fax Setup Wizard to set the fax time, date, and header (Windows)
1. Click Start, and then click Programs.
2. Click HP, click the name of the product, and then click HP Fax Setup Wizard.

3. Follow the on-screen instructions in the HP Fax Setup Wizard to configure the fax settings.
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Use the phone book

You can store frequently dialed fax numbers (up to 120 entries) as speed-dial entries. Speed-dial entries
can be individual fax numbers or groups of fax numbers.

Create and edit speed-dial entries

Create and edit group-dial entries

Delete speed-dial entries

Delete group-dial entries

Create and edit speed-dial entries

1.

N oy 0N

From the Home screen on the product control panel, touch the Fax button.

Touch the Fax Menu button.

Touch the Phone Book Setup button.

Touch the Individual Setup button.

Touch an unassigned number from the list.

Use the keypad to enter a name for the entry, and then touch the OK button.

Use the keypad to enter the fax number for the entry, and then touch the OK button.

Create and edit group-dial entries

ENWW

1.

LG I

Create an individual entry for each fax number that you want in the group.

b.

From the Home screen on the product control panel, touch the Fax button.
Touch the Fax Menu button.

Touch the Phone Book Setup button.

Touch the Individual Setup button.

Touch an unassigned number from the list.

Use the keypad to enter a name for the entry, and then touch the OK button.

Use the keypad to enter the fax number for the entry, and then touch the OK button.

From the Phone Book Setup menu, touch the Group Setup button.

Touch an unassigned number from the list.

Use the keypad to enter a name for the group, and then touch the OK button.

Touch the name of each individual entry that you want to include in the group. When you are
finished, touch the Done Selecting button.
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Delete speed-dial entries
1. From the Home screen on the product control panel, touch the Fax button.
Touch the Fax Menu button.
Touch the Phone Book Setup button.
Touch the Delete Entry button. Or, to delete all the entries, touch the Delete All Entries button.

Touch the entry that you want to delete.

S

Touch the OK button to confirm the deletion.

Delete group-dial entries

1. From the Home screen on the product control panel, touch the Fax button.

2. Touch the Fax Menu button.

3. Touch the Phone Book Setup button.

4. Touch the Delete Entry button. Or, to delete all the entries, touch the Delete All Entries button.
5. Touch the entry that you want to delete.

6. Touch the OK button to confirm the deletion.
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Configure send fax settings

e Set special dialing symbols and options

e Set the dial tone detection

e Set autoredial options

e Setlight/dark and resolution

e Set billing codes

Set special dialing symbols and options

You can insert pauses into a fax number that you are dialing. Pauses are often needed when dialing
infernationally or connecting to an outside line.

Special symbol Button Description

Dialing pause The Redial/Pause button is available on the control panel keypad for
>)/u . .
e entering a fax number. You can also touch the comma button to insert a

dialing pause.

Pause for dial tone | This character causes the product to wait for a dial tone before dialing the

W

A remainder of the telephone number. This button is available only in
contexis where it is appropriate.

Hook flash ] This character causes the product to insert a hook flash. This button is
st available only in contexts where it is appropriate.

Set a dialing prefix

ENWW

A dial prefix is a number or group of numbers that are automatically added to the beginning of every
fax number you enter at the control panel or from the software. The maximum number of characters for
a dial prefix is 50.

The default setting is Off. You might want to turn this setting on and enter a prefix if, for example, you
have to dial a number such as 9 to get a telephone line outside of your company telephone system.
While this setting is active, you can dial a fax number without the dial prefix by using manual dial.

1. From the Home screen on the product control panel, touch the Setup &\, button.
Touch the Fax Setup menu.
Touch the Basic Setup menu.

Scroll to and touch the Dial Prefix button, and then touch the On button.

G S N

Use the keypad to enter the prefix, and then touch the OK button. You can use numbers, pauses,
and dialing symbols.
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Set the dial tone detection

Normally, the product begins dialing a fax number immediately. If you are using the product on the
same line as your telephone, turn on the detect-dialtone setting. This prevents the product from sending
a fax while someone is on the telephone.

The factory-set default for detect dial tone is On for France and Hungary, and Off for all other
countries/regions.

1.
2,
3.
4.

From the Home screen on the product control panel, touch the Setup S, button.
Touch the Fax Setup menu.
Touch the Advanced Setup menu.

Scroll to and touch the Detect Dial Tone button, and then touch the On or Off button.

Tone dial or pulse dial

Use this procedure to set the product to tone-dialing or pulse-dialing mode. The factory-set default is
Tone. Do not change this setting unless you know that the telephone line cannot use tone dialing.

@NOTE: The pulse-dialing option is not available in all countries/regions.

1.
2.
3.
4.

From the Home screen on the product control panel, touch the Setup S, button.
Touch the Fax Setup menu.
Touch the Advanced Setup menu.

Scroll to and touch the Dialing Mode button, and then touch the Tone or Pulse button.

Set autoredial options

If the product was unable to send a fax because of a communication error or the receiving fax machine
did not answer or was busy, the product attempts to redial based on the redial-on-busy, redial-on-no-
answer, and redial-on-communication-error options.

Set the redial-on-busy option

118

If this option is on, the product redials automatically if it receives a busy signal. The factory-set default
for the redial-on-busy option is On.

1.

2.

From the Home screen on the product control panel, touch the Setup &\, button.
Touch the Fax Setup menu.
Touch the Advanced Setup menu.

Scroll to and touch the Redial if Busy button, and then touch the On or Off button.
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Set the redial-on-no-answer option

If this option is on, the product redials automatically if the receiving machine does not answer. The
factory-set default for the redial-on-no-answer option is Off.

1. From the Home screen on the product control panel, touch the Setup 8\, button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.

4. Scroll to and touch the Redial if No Answer button, and then touch the On or Off button.

Set the redial-on-communication-error option

I this option is on, the product redials automatically if some sort of communication error occurs. The
factory-set default for the redial-on-communication-error option is On.

1. From the Home screen on the product control panel, touch the Setup S\ button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.

4. Scroll to and touch the Redial if Comm. Error button, and then touch the On or Off button.

Set light/dark and resolution

Set the default light/dark (contrast) setting

The contrast affects the lightness and darkness of an outgoing fax as it is being sent.

The default light/dark setting is the contrast that is normally applied to items that are being faxed. The
slider is set to the middle as the default setting.

1. From the Home screen on the product control panel, touch the Setup S\ button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.

4. Touch the Lighter/Darker button, and then touch one of the arrows to adjust the slider.

Set resolution settings

2 NOTE: Increasing the resolution increases the fax file size. Larger faxes increase the send time and

ENWW

could exceed the available memory in the product.

The following settings are available:

e Standard: This setting provides the lowest quality and the fastest transmission time.

e Fine: This setting provides a higher resolution quality than Standard that is usually appropriate for

text documents.

Configure send fax settings
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e  Superfine: This sefting is best used for documents that mix text and images. The transmission time
is slower than the Fine setting but faster than the Photo setting.

e  Photo: This setting produces the best images, but greatly increases the transmission time.

Set the fax resolution for the current fax job
1. From the Home screen on the product control panel, touch the Fax button.
2. Touch the Fax Menu button.
3. Touch the Send Options button.
4

Touch the Fax Resolution button, and then touch one of the options.

r__":"/%"NOTE: The factory-set default resolution setting is Fine.

Set the default resolution setting for all fax jobs
1. From the Home screen on the product control panel, touch the Setup &\ button.
2. Touch the Fax Sefup menu.
3. Touch the Advanced Setup menu.

4. Touch the Fax Resolution button, and then touch one of the options.

E”/{’NOTE: The factory-set default resolution setting is Fine.

Set billing codes

If the billing codes feature is on, the product prompts you to enter a billing code for each fax. The
product increases the billing code count for each sent fax page. This includes all types of faxes except
for poll-received, faxforwarded, or computer-downloaded faxes. For an undefined group or a group-
dial fax, the product increases the billing code count for each successful fax that is sent to each
destination.

The factory-set default for the billing-code setting is Off. The billing code can be any number from 1
through 250.

Set the billing-code setting
1. From the Home screen on the product control panel, touch the Setup &\, button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.

4. Scroll to and touch the Billing Codes button, and then touch the On button.
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Use billing codes
1. Load the document in the document feeder or on the scanner glass.

From the Home screen on the product control panel, touch the Fax button.

2
3. Enter the fax number, or select a speed-dial or group-dial entry.
4. Touch the Start Fax button.

5

Enter the billing code, and then touch the OK button.

Print the billing-code report

The billing-code report is a printed list of all the fax billing codes and the total number of faxes billed to
each code. This report is available only when the billing code feature is on.

E%?NOTE: After the product prints this report, it deletes all billing data.

1. From the Home screen on the product control panel, touch the Fax button.
2. Touch the Fax Menu button.

3. Touch the Fax Reporis button.
4

Scroll to and touch the Print Billing Report button.
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Configure receive fax settings

Set fax forwarding

Set the answer mode

Block or unblock fax numbers

Set the number of rings-to-answer

Set distinctive ring

Use autoreduction for incoming faxes

Set fax reprint settings

Set the fax sounds volume

Set stamp-received faxes

Set the private receive feature

Set fax forwarding

You can set your product to forward incoming faxes to another fax number. When the fax arrives at
your product, it is stored in the memory. The product then dials the fax number that you have specified
and sends the fax. If the product cannot forward a fax because of an error (for example, the number is
busy) and repeated redial attempts are unsuccessful, your product prints the fax.

If the product runs out of memory while receiving a fax, it terminates the incoming fax and only
forwards the pages and partial pages that have been stored in the memory.

When it is using the fax-forwarding feature, the product (rather than the computer) must be receiving
the faxes, and the answer mode must be set to Automatic.

1.

2
3.
4
5

From the Home screen on the product control panel, touch the Fax button.
Touch the Fax Menu button.

Touch the Receive Options button.

Touch the Forward Fax button, and touch the On button.

Use the keypad to enter the fax-forwarding number, and then touch the OK button.

Set the answer mode

122

Depending on the situation, set the product answer mode to Automatic, TAM, Fax/Tel, or Manual. The
factory-set default is Avtomatic.

Automatic: The product answers incoming calls after a specified number of rings or upon
recognition of special fax tones.

TAM: The product does not automatically answer the call. Instead, it waits until it detects the fax
tone.
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e Fax/Tel: The product answers incoming calls immediately. If it defects the fax tone, it processes the
call as a fax. If it does not detect the fax tone, it creates an audible ring to alert you to answer the
incoming voice call.

e Manual: The product never answers calls without intervention. You must start the fax-receiving
process yourself, either by touching the Start Fax button on the control panel or by picking up a
telephone that is connected to that line and dialing 1-2-3.

To set or change the answer mode, complete the following steps:

1. From the Home screen on the product control panel, touch the Setup &\ button.
2. Touch the Fax Setup menu.

3. Touch the Basic Sefup menu.

4. Scroll to and touch the Answer Mode button, and then touch the name of the option that you want
to use.

Block or unblock fax numbers

If you do not want to receive faxes from specific people or businesses, you can block as many as 30
fax numbers by using the control panel. When you block a fax number and someone from that number
sends you a fax, the control-panel display indicates that the number is blocked, the fax does not print,
and the fax is not saved in memory. Faxes from blocked fax numbers appear in the fax activity log with
a “discarded” designation. You can unblock blocked fax numbers individually or all at one time.

E’%NOTE: The sender of a blocked fax is not noftified that the fax failed.

E%?NOTE: If the sender has not configured the fax header, the number cannot be blocked.

1. From the Home screen on the product control panel, touch the Fax button.
Touch the Fax Menu button.

Touch the Receive Options button.

Touch the Block Junk Faxes button.

Touch the Add Number button.

o 0 w0 bd

Use the keypad to enter the fax number that you want to block, and then touch the OK button.

Set the number of rings-to-answer

ENWW

When the answer mode s set to Automatic, the product ringsto-answer setting determines the number
of times the telephone rings before the product answers an incoming call.

If the product is connected to a line that receives both fax and voice calls (a shared line) and that also
uses an answering machine, you might need to adjust the rings-to-answer setting. The number of rings-
to-answer for the product must be greater than the rings-to-answer on the answering machine. This
allows the answering machine to answer the incoming call and record a message if it is a voice call.
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When the answering machine answers the call, the product listens to the call and automatically

answers it if it detects fax tones.

The default setting for rings-to-answer is varies by country/region.

Use the following table to determine the number of ringsto-answer to use.

Type of telephone line

Recommended rings-to-answer setting

Dedicated fax line (receiving only fax calls)

Set to a number of rings within the range shown on the
control-panel display. (The minimum and maximum number of
rings allowed varies by country/region.)

One line with two separate numbers and a ring-pattern
service

One or two rings. (If you have an answering machine or
computer voicemail for the other telephone number, make sure
that the product is set to a greater number of rings than the
answering system. Also, use the distinctive-ring feature to
differentiate between voice and fax calls.)

Shared line (receiving both fax and voice calls) with only an

attached telephone

Five rings or more.

Shared line (receiving both fax and voice calls) with an
attached answering machine or computer voicemail

Two rings more than the answering machine or computer
voicemail.

To set or change the number of rings-to-answer, use the following steps:

1. From the Home screen on the product control panel, touch the Setup S, button.

Touch the Fax Setup menu.
Touch the Basic Setup menu.

2,
3.
4. Touch the Rings to Answer button.
5.

Use the keypad to enter the number of rings, and then touch the OK button.

Set distinctive ring

124

Ring-pattern or distinctive-ring service is available through some local telephone companies. The service
provides a way to have more than one telephone number on a single line. Each telephone number has
a unique ring pattern, so that you can answer voice calls and the product can answer fax calls.

If you subscribe to a ring-pattern service with a telephone company, you must set the product to answer
the correct ring pattern. Not all countries/regions support unique ring patterns. Contact the telephone
company fo determine if this service is available in your country/region.

2% NOTE: If you do not have ring-pattern service and you change the ring-pattern settings to something
other than the default, All Rings, the product might not be able to receive faxes.

The settings are as follows:

e Al Rings: The product answers any calls that come through the telephone line.

e  Single: The product answers any calls that produce a single-ring pattern.
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e  Double: The product answers any calls that produce a double-ring pattern.

o Triple: The product answers any calls that produce a triple-ring pattern.

e Double and Triple: The product answers any calls that produce a double-ring or triple-ring pattern.
To change ring patterns for call answering, complete the following steps:

1. From the Home screen on the product control panel, touch the Setup S\ button.

2. Touch the Fax Setup menu.

3. Touch the Basic Sefup menu.

4. Touch the Distinctive Ring button, and then touch the name of an option.

Use autoreduction for incoming faxes

If the fitto-page option is turned on, the product automatically reduces long faxes up to 75% to fit the
information on the default paper size (for example, the fax is reduced from legal to letter size).

If the fitto-page option is turned off, long faxes print at full size on multiple pages. The factory-set
default for incoming fax autoreduction is On.

If you have the Stamp Faxes option turned on, you might also want to turn on autoreduction. This
reduces the size of the incoming faxes slightly, and prevents the page-stamp from forcing a fax onto
two pages.

E’%NOTE: Make sure that the default paper size sefting matches the size of the paper in the tray.

1. From the Home screen on the product control panel, touch the Setup S\ button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.

4. Touch the Fit to Page button, and then touch the On button.

Set fax reprint settings
1. From the Home screen on the product control panel, touch the Setup &\, button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.
4. Scroll to and touch the Allow Fax Reprint button, and then touch the On button.

After this feature is turned on, a Reprint Faxes button is available in the Fax Menu > Receive
Options menu.
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Set the fax sounds volume

Use this setting fo control the volume of the fax sounds from the control panel. You can make changes
to the following sounds:

e Alarm Volume
e Ring Volume

e Phone Line Volume

Set the alarm volume, phone-line volume, and ring volume

1. From the Home screen on the product control panel, touch the Setup S\, button.
2. Touch the System Setup menu.
3. Touch the Volume Seftings menu.

4. Touch the name of the volume setting that you want to adjust, and then touch one of the options.
Repeat this step for each volume setting.

Set stamp-received faxes

The product prints the sender identification information at the top of each received fax. You can also
stamp the incoming fax with your own header information to confirm the date and time that the fax was
received. The factory-set default for stamp-received faxes is Off.

2»NOTE:  Turning on the stamp-received setting might increase the page size and cause the product to
print a second page.

[y NOTE: This option applies only to received faxes that the product prints.

1. From the Home screen on the product control panel, touch the Setup S, button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.

4. Scroll to and touch the Stamp Faxes button, and then touch the On button.

Set the private receive feature

When the private-receive feature is active, received faxes are stored in memory and not printed. A
password is required to print the stored faxes.

1. From the Home screen on the product control panel, touch the Setup S, button.
2.  Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.
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4. Scroll to and touch the Private Receive button, and then touch the On button.

5. If you have not already set a system password, the product prompts you to create one.

@NOTE: The system password is case-sensitive.

a. Touch the OK button, and then use the keypad to enter the system password.

b. Touch the OK button, confirm the password by entering it a second time, and then touch the
OK button to save the password.

After this feature is turned on, a Print Private Faxes button is available in the Fax Menu > Receive
Options menu.

Set fax polling

If someone else has set up a fax to be polled, you can request that the fax be sent to your product. (This
is known as polling another machine).

1. From the Home screen on the product control panel, touch the Fax button.
Touch the Fax Menu button.

2

3. Touch the Receive Options button.
4. Touch the Polling Receive button.
5

Use the keypad on the touchscreen to enter the number of the fax machine that you want to poll,
and then touch the OK button.

The product dials the other fax machine and requests the fax.
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Use fax

e Supported fax programs

e Cancel a fax

e Delete faxes from memory

e Use fax on a DSL, PBX, or ISDN system

e Use fax on a VolIP service

e Fax memory contents are retained when there is a loss of power

e Security issues when connecting internal networks to public phone lines

e Fax from the flatbed scanner

e Fax from the document feeder

e  Use speed dials and group-dial entries

e Send a fax from the software (Windows)

e Send a fax by dialing from a telephone connected to the fax line

e Send a fax with confirmation

e Schedule a fax to be sent later

e Send a fax combining an electronic and paper document

e  Use access codes, credit cards, or calling cards

e  Print a fax

e  Receive faxes when fax tones are audible on the phone line

Supported fax programs

The PC fax program that came with the product is the only PC fax program that works with the product.
To continue to use a PC fax program previously installed on the computer, use the modem that is
already connected to the computer; it will not function through the product modem.

Cancel a fax

Use these instructions to cancel a single fax that is currently dialing or a fax that is being transmitted or
received.

Cancel the current fax

Press the Cancel X button on the control panel. Any pages that have not been transmitted are
canceled. Pressing the Cancel > button also stops group-dial jobs.
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Cancel a pending fax job
Use this procedure to cancel a fax job in the following situations:

o  The product is waiting to redial after encountering a busy signal, an unanswered call, or a
communication error.

o  The fax is scheduled to be sent at a future time.

Use the following steps to cancel a fax job by using the Fax Job Status menu:

1. From the Home screen on the product control panel, touch the Fax button.
Touch the Fax Menu button.

2

3. Touch the Send Options button.
4. Touch the Fax Job Status button.
5

Touch the fax number for the job that you want to cancel.

Delete faxes from memory

Use this procedure only if you are concerned that someone else has access to your product and might
try to reprint faxes from the memory.

/\ CAUTION: In addition to clearing the reprint memory, this procedure clears any fax that is currently
being sent, unsent faxes that are pending redial, faxes that are scheduled to be sent at a future time,
and faxes that are not printed or forwarded.

1. From the Home screen on the product control panel, touch the Setup S\ button.
2. Touch the Service menu.
3. Touch the Fox Service menu.

4. Touch the Clear Saved Faxes button.

Use fax on a DSL, PBX, or ISDN system

HP products are designed specifically for use with traditional analog phone services. They are not
designed to work on DSL, PBX, ISDN lines, or VolP services, but they work with the proper setup and
equipment.

E‘/?"NOTE: HP recommends discussing DSL, PBX, ISDN, and VolP setup options with the service provider.

The HP Laserlet product is an analog device that is not compatible with all digital phone environments
(unless a digitalto-analog converter is used). HP does not guarantee that the product will be compatible
with digital environments or digitalto-analog converters.

DSL

A digital subscriber line (DSL) uses digital technology over standard copper telephone wires. This
product is not directly compatible with those digital signals. However, if the configuration is specified
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during DSL setup, the signal can be separated so that some of the bandwidth is used to transmit an
analog signal (for voice and fax) while the remaining bandwidth is used to transmit digital data.

Not all faxes are compatible with DSL services. HP does not guarantee that the product will
be compatible with all DSL service lines or providers.

A typical DSL modem employs a filter to separate the higher frequency DSL modem communication
from lower frequency analog phone and fax modem communication. It is often necessary to use a filter
with analog phones and analog fax products that are connected to a telephone line used by a DSL
modem. The DSL service provider usually provides this filter. Contact the DSL provider for more
information or for assistance.

The product is an analog device that is not compatible in all digital phone environments. Digital-o-
analog filters or converters may be needed for faxing functionality. If faxing issues occur in a PBX
environment, it might be necessary to contact the PBX provider for assistance. HP does not guarantee
that the product will be compatible with digital environments or digitalto-analog converters.

Contact the PBX provider for more information and for assistance.

The product is an analog device that is not compatible in all digital phone environments. Digital-o-
analog filters or converters may be needed for faxing functionality. If faxing issues occur in an ISDN
environment, it might be necessary fo contact the ISDN provider for assistance. HP does not guarantee
that the product will be compatible with ISDN digital environments or digitalto-analog converters.

Voice over internet protocol (VolP) services are often not compatible with fax machines unless the
provider explicitly states that it supports fax over IP services.

If the product experiences problems getting a fax to work on a VolIP network, verity that all cables and
settings are correct. Decreasing the fax-speed setting might allow the product to send a fax over a VolP
network.

If the VolIP provider offers a "Pass through" mode for the connection, that will offer better fax
performance on VolP. Also if the provider has "comfort noise" added to the line, fax performance can
be enhanced if this feature is not enabled.

If faxing problems continue, contact the VolP provider.

The flash memory protects against data loss when a power failure occurs. Other fax devices store fax
pages in either normal RAM or shortterm RAM. Normal RAM immediately loses data when power is
lost, while shortterm RAM loses data about 60 minutes after a power failure occurs. Flash memory can
maintain its data for years without power applied.
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Security issues when connecting internal networks to public phone
lines

The product can send and receive fax data over telephone lines that conform to public switch telephone
network (PSTN) standards. The secure fax protocols make it impossible for computer viruses to be
transferred from the telephone line to a computer or network.

The following product features prevent virus transmission:

o No direct connection exists between the fax line and any devices that are connected to the USB or
Ethernet ports.

o  The internal firmware cannot be modified through the fax connection.

e  All fax communications go through the fax subsystem, which does not use Internet data-exchange
protocols.

Fax from the flatbed scanner

1. Place the document face-down on the scanner
glass.

NOTE: If documents are in the document
feeder and on the scanner glass at the same
time, the product processes the document in
the document feeder and not the one on the
scanner glass.

2. From the Home screen on the product control
panel, touch the Fax button.

Use the keypad to enter the fax number.
Touch the Start Fax button.

The product prompts you to confirm that you
are sending from the scanner glass. Touch the
Yes button.

6. The product prompts you fo load the first page.
Touch the OK button.
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7. The product scans the first page and then
prompts you to load another page. If the
document has multiple pages, touch the Yes
button. Continue this process until you have
scanned all the pages.

8.  When you have scanned the last page, touch
the No button at the prompt. The product
sends the fax.

Fax from the document feeder

1. Insert the originals into the document feeder
face-up.

NOTE: The document feeder capacity is up
to 50 sheets of 75 g/m? (20 Ib) paper.

CAUTION: To prevent damage to the
product, do not use an original that contains
correction tape, correction fluid, paper clips,
or staples. Also, do not load photographs,
small originals, or fragile originals into the
document feeder.

NOTE: If documents are in the document
feeder and on the scanner glass at the same
time, the product processes the document in
the document feeder and not the one on the
scanner glass.

2. Adjust the paper guides until they are snug
against the paper.

3. From the Home screen on the product control
panel, touch the Fax button.

Use the keypad to enter the fax number.

Touch the Start Fax button.
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Use speed dials and group-dial entries

1. Lload the document onto the scanner glass or
into the document feeder.

2. From the Home screen on the product control
panel, touch the Fax button.

3. On the keypad, touch the fax phone book
icon.

4. Touch the name of the individual or group
entry that you want to use.

5. Touch the Start Fax button.

Send a fax from the software (Windows)

The following information provides basic instructions for sending faxes by using the software that came
with the product. All other software-related topics are covered in the software Help, which can be

opened from the software-program Help menu.

You can fax electronic documents from a computer if you meet the following requirements:

o  The product is connected directly to the computer or to a network to which the computer is

connected.
o  The product software is installed on the computer.

o  The computer operating system is one that this product supports.

Send a fax from the software

The procedure to send a fax varies according to your specifications. The most typical steps follow.

1. Click Start, click Programs (or All Programs in Windows XP), and then click HP.

2. Click the product name, and then click HP Send fax. The fax software opens.
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3. Enter the fax number of one or more recipients.
4. load the document in the document feeder.

5. Click Send Now.

Send a fax from a third-party software program, such as Microsoft Word
1. Open a document in a third-party program.
Click the File menu, and then click Print.
Select the fax print driver from the print driver drop-down list. The fax software opens.
Enter the fax number of one or more recipients.

Include any pages loaded at the product. This step is optional.

S e

Click Send Now.

Send a fax by dialing from a telephone connected to the fax line

Occasionally, you might want to dial a fax number from a telephone that is connected to the same line
as the product. For example, if you are sending a fax to a person whose device is in the manual
receive mode, you can precede the fax with a voice call to let that person know that the fax is coming.

@NOTE: The telephone must be connected to the product "telephone" port {3 .

1. Lload the document into the document feeder.
2. From the Home screen on the product control panel, touch the Fax button.

3. Pick up the handset of a telephone that is connected to the same line as the product. Dial the fax
number by using the telephone keypad.

4. When the recipient answers, instruct the person to start the fax machine.

5.  When you hear the fax tones, touch the Start Fax button on the control panel, wait until the control
panel displays the Connecting message, and then hang up the telephone.

Send a fax with confirmation

You can set the product so that it prompts you to enter the fax number a second time to confirm that you
are sending the fax to the correct number.

1. From the Home screen on the product control panel, touch the Setup S, button.
2. Touch the Fax Setup menu.

3. Touch the Advanced Setup menu.

4. Scroll to and touch the Confirm Fax Number button, and touch the On button.
5

Send the fax.
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Schedule a fax to be sent later

Use the product control panel to schedule a fax to be sent automatically at a future time to one or more
people. When this procedure is completed, the product scans the document into memory and then
returns to the Ready state.

E%?NOTE: If the product cannot transmit the fax at the scheduled time, that information is indicated on
the fax error report (if that option is turned on) or recorded in the fax activity log. The transmittal might
not be initiated because the fax-sending call is not answered, or because a busy signal stops the redial
attempts.

If a fax has been scheduled to be sent at a future time but it requires updating, send the additional
information as another job. All faxes that are scheduled to go to the same fax number at the same time
are delivered as individual faxes.

1. Load the document into the document feeder.

2. From the Home screen on the product control
panel, touch the Fax button.

Touch the Fax Menu button.
Touch the Send Options button.
Touch the Send Fax Later button.

o v ko

Use the keypad to enter the time of day to
send the fax. Touch the OK button.

7. Use the keypad to enter the date to send the
fax. Touch the OK button.

8. Use the keypad to enter the fax number. Touch
the OK button. The product scans the
document and saves it in memory until the
designated time.

Send a fax combining an electronic and paper document
Use the HP Send Fax software to set up this feature. To start the software program, from the Windows

Start menu, navigate to the program group for this product, and then click the HP Send Fax item.
Use the software to combine the documents into a single fax job.
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Use access codes, credit cards, or calling cards

To use access codes, credit cards, or calling cards, dial manually to allow for pauses and dialing
codes.

Send faxes internationally

To send a fax to an international destination, dial manually to allow for pauses and international
dialing codes.
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Print a fax

When the product receives a fax transmission, it prints the fax (unless the private-receive feature is
enabled) and also stores it automatically to flash memory.
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Reprint a fax

When the Allow Fax Reprint feature is on, the product stores received faxes in memory. The product
has about 3.2 MB of storage space, which holds about 250 pages.

These faxes are stored continuously. Reprinting them does not clear them from the memory.

The default setting for this feature is Off.

Turn on the Allow Fax Reprint feature

1. From the Home screen on the product control panel, touch the Setup &\, button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.

4. Scroll to and touch the Allow Fax Reprint button, and touch the On button.

Reprint faxes

1. From the Home screen on the product control panel, touch the Fax button.
2. Touch the Fax Menu button.

3. Touch the Receive Options button.

4. Touch the Reprint Faxes button.
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Avutomatically print on both sides of received faxes

Use the product control panel to configure the product to print two-sided copies of received faxes.

1.

2
3.
4
5

From the Home screen on the product control panel, touch the Setup S\, button.
Touch the Fax Setup button.

Touch the Advanced Setup button.

Touch the Print Duplex button.

Touch the On button.

Print a stored fax when the private receive feature is on

To use this feature, you must enable the Private Receive feature on the product. Use the following
procedure to enable this feature.

1.

2
3.
4
5

From the Home screen on the product control panel, touch the Setup 8\, button.
Touch the Fax Setup button.

Touch the Advanced Setup button

Scroll to and touch the Private Receive button.

Touch the On button.

To print stored faxes, you must provide the product security password. After the product prints the
stored faxes, the faxes are deleted from memory.

1.

2
3.
4
5

From the Home screen on the product control panel, touch the Fax button.
Touch the Fax Menu button.

Touch the Receive Options button.

Touch the Print Private Faxes button.

Use the keypad on the touchscreen to enter the product security password, and then touch the OK
button.

Receive faxes when fax tones are audible on the phone line

If you have a telephone line that receives both fax and telephone calls, and you hear fax tones when
you answer the telephone, you can start the receiving process in one of two ways:

Touch the Start Fax button on the product control panel.

Press 1-2-3 in sequence on the telephone keypad, listen for fax transmission sounds, and then
hang up.

2% NOTE: For the second method to work, the Extension Phone option must be turned on. This option is

one of the Advanced Setup options in the Fax Setup menu.
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8 Manage and maintain

e  Use the HP Reconfiguration Utility to change the product connection (Windows)

e Set up HP Wireless Direct Printing

e Use HP Web Services applications

e  Configure IP network settings

e HP Device Toolbox (Windows)

e  HP Utility for Mac OS X

e Use HP Web Jetadmin software

° Economy settings

° Product security features

e Upgrade the firmware
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Use the HP Reconfiguration Utility to change the
product connection (Windows)

If you are already using the product and you wish to change the way it is connected, use the

HP Reconfiguration Utility to set up the connection. For example, you can reconfigure the product to use
a different wireless address, to connect to a wired or wireless network, or change from a network
connection to a USB connection. You can change the configuration without inserting the product CD.
After you select the type of connection you wish to make, the program goes directly to the portion of
the product setup procedure that needs to change.

The HP Reconfiguration Utility is located in the HP programs group on your computer.
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Set up HP Wireless Direct Printing

E%?NOTE: This feature is available with wireless models only.

The HP Wireless Direct Printing feature lets you print from your wireless mobile device directly to an
HP Wireless Direct-enabled product without requiring connection to an established network or the
Internet. Use HP Wireless Direct to print wirelessly from the following devices:

o iPhone, iPad, or iTouch using Apple AirPrint
e  Mobile devices that run Android, iOS, or Symbian using the HP ePrint Home & Biz application

To set up HP Wireless Direct from the control panel, complete the following steps:

r__":"‘/f’NOTE: This feature requires you to set up a security password for the product. If you have not
previously configured a password, you are prompted to configure one affer you enable the feature.

1. From the Home screen on the product control panel, touch the Wireless () button.
2.  Open the following menus:

e  Wireless Menu

e  Wireless Direct Settings

e On/Off

2y NOTE:  If the Wireless Direct Settings item does not appear on the control panel, you need to

upgrade the product firmware. To get the current version, go to www.hp.com, enter the HP
product number in the search box, select the specific product model, and then click the Software
& Driver Downloads link.

3. Touch the On menu item. The product might prompt you to set a security password. The product
saves the setting and then returns the control panel to the Wireless Direct Settings menu.

ENWW Set up HP Wireless Direct Printing 143


http://www.hp.com

Use HP Web Services applications

1. From the Home screen on the product control panel, touch the Web Services @ button.

2. Touch the Enable Web Services button.

Atter you download an application from the HP ePrintCenter Web site, it is available in the Apps menu
on the product control panel. This process enables both HP Web Services and the Apps menu.
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Configure IP network settings

e  Printer sharing disclaimer

e View or change network settings

e Manually configure IPv4 TCP/IP parameters from the control panel

e Rename the product on a network

e Link speed and duplex settings

Printer sharing disclaimer

HP does not support peerto-peer networking, as the feature is a function of Microsoft operating systems
and not of the HP printer drivers. Go to Microsoft at www.microsoft.com.

View or change network settings

Use the HP Embedded Web Server to view or change IP configuration settings.

'+ From the Home screen on the product control panel, touch the Network O\fl;lﬁ button to find the

product IP address.
2. To open the HP Embedded Web Server, enter the IP address into the address line of a Web

browser.

@NOTE: You can also access the HP Embedded Web Server from the HP Device Toolbox for
Windows or the HP Utility for Mac OS X.

3. Click the Networking tab to obtain network information. You can change settings as needed.

Manually configure IPv4 TCP/IP parameters from the control panel

Use the control-panel menus to manually set an IPv4 address, subnet mask, and default gateway.
1. From the Home screen on the product control panel, touch the Setup 8\, button.

2. Scroll to and touch the Network Setup menu.

3. Touch the TCP/IP Config menu, and then touch the Manual button.

4. Use the keypad on the touchscreen to enter the IP address, and touch the OK button. Touch the
Yes button to confirm.

5. Use the keypad on the touchscreen to enter the subnet mask, and touch the OK button. Touch the
Yes button to confirm.

6. Use the keypad on the touchscreen to enter the default gateway, and touch the OK button. Touch
the Yes button to confirm.
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Rename the product on a network

If you want to rename the product on a network so that it can be uniquely identified, use the
HP Embedded Web Server.

'~ From the Home screen on the product control panel, touch the Network Oﬁ% button to find the
product IP address.

2. To open the HP Embedded Web Server, enter the product IP address into the address line of a
Web browser.

E’%NOTE: You can also access the HP Embedded Web Server from the HP Device Toolbox for
Windows or the HP Utility for Mac OS X.

3. Open the System tab.

4. On the Device Information page, the default product name is in the Device Status field. You
can change this name to uniquely identify this product.

E‘%NOTE: Completing the other fields on this page is optional.

5. Click the Apply button to save the changes.

146  Chapter 8 Manage and maintain ENWW



Link speed and duplex settings

E%?NOTE: This information applies only to Ethernet networks. It does not apply to wireless networks.

The link speed and communication mode of the print server must match the network hub. For most
situations, leave the product in automatic mode. Incorrect changes to the link speed and duplex settings
might prevent the product from communicating with other network devices. If you need to make
changes, use the product control panel.

E’/{’NOTE: The setting must match with the network product to which you are connecting (a network hub,
switch, gateway, router, or computer).

2 NOTE:  Making changes to these settings causes the product to turn off and then on. Make changes
only when the product is idle.

1. From the Home screen on the product control panel, touch the Setup &\ button.
2. Scroll to and touch the Network Setup menu.
3. Touch the Link Speed menu.

4. Select one of the following options.

Setting Description

Automatic The print server automatically configures itself for the highest link speed and
communication mode allowed on the network.

10T Full 10 Mbps, full-duplex operation

10T Half 10 megabytes per second (Mbps), half-duplex operation
100TX Full 100 Mbps, full-duplex operation

100TX Half 100 Mbps, half-duplex operation

1000T Full 1000 Mbps, full-duplex operation

5. Touch the OK button. The product turns off and then on.
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HP Device Toolbox (Windows)

Use the HP Device Toolbox for Windows to check product status or to view or change product settings
from your computer. This tool opens the HP Embedded Web Server for the product.
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2»NOTE:  This tool is available only if you performed a full installation when you installed the product.
Depending on how the product is connected, some features might not be available.

1. Click the Start button, and then click the Programs item.

2. Click your HP product group, and then click the HP Device Toolbox item.

Tab or section

Description

Home tab

Provides product, status, and
configuration information.

Device Status: Shows the product status and shows the approximate percent life
remaining of HP supplies.

Supplies Status: Shows the approximate percent life remaining of HP supplies.
Actual supply life remaining can vary. Consider having a replacement supply
available to install when print quality is no longer acceptable. The supply does not
need to be replaced unless the print quality is no longer acceptable.

Device Configuration: Shows the information found on the product configuration
page.

Network Summary: Shows the information found on the product network
configuration page.

Reports: Print the configuration and supplies status pages that the product
generates.

Event Log: Shows a list of all product events and errors.

System tab

Provides the ability to configure the
product from your computer.

Device Information: Provides basic product and company information.
Paper Setup: Change the default paper-handling settings for the product.
Print Quality: Change the default print-quality seftings for the product.

EcoSMART Console: Change the default times for entering Sleep mode and for
Auto Power Down mode. Configure which events cause the product to wake.

Paper Types: Configure print modes that correspond to the paper types that the
product accepts.

System Setup: Change the system defaults for the product.
Service: Perform the cleaning procedure on the product.

Save and Restore: Save the current settings for the product to a file on the
computer. Use this file to load the same settings onto another product or to restore
these settings to this product at a later time.

Administration: Set or change the product password. Enable or disable product
pictures.

NOTE: The System tab can be password-protected. If this product is on a network,
always consult with the administrator before changing settings on this tab.
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Tab or section

Description

Print tab

Provides the ability to change
default print settings from your
computer.

Printing: Change the default product print seftings, such as number of copies and
paper orientation. These are the same options that are available on the control
panel.

PCL5c: View and change the PCL5c settings.

PostScript: Turn off or on the Print PS Errors feature.

Fax tab o Receive Options: Configure how the product handles incoming faxes.
o Phone Book: Add or delete entries in the fax phone book.
o Junk Fax List: Sef fax numbers to block from sending faxes to the product.
o  Fax Activity Log: Review recent fax activity for the product.

Scan tab Configure the Scan to Network Folder and Scan to E-mail features.

Network Folder Setup: Configure folders on the network to which the product
can save a scanned file.

Scan to E-mail Setup: Begin the process to set up the Scan to E-mail feature.

Outgoing E-mail Profiles: Set an email address that will appear as the “from”
address for all emails sent from the product. Configure the SMTP Server information.

E-mail Address Book: Add or delete entries in the email address book.

E-mail Options: Configure a default subject line and body text. Configure default
scan settings for emails.

Networking tab

Provides the ability to change
network seftings from your
computer.

Network administrators can use this tab fo control network-related settings for the product
when it is connected to an IP-based network. It also allows the network administrator to
set up Wireless Direct functionality. This tab does not appear if the product is directly
connected to a computer.

HP Web Services tab

Use this tab to set up and use various Web tools with the product.

HP Smart Install tab

Use this tab to disable HP Smart Install or to download and install the product software.
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HP Utility for Mac OS X

Use the HP Utility for Mac OS X to view or change product settings from your computer.

You can use the HP Utility when the product is connected with a USB cable or is connected to a TCP/IP-
based network.

Open HP Utility

From the Finder, double-click Applications, double-click Hewlett-Packard, and then click HP
Utility.

If HP Utility is not included in the Utilities list, use the following procedure to open it:

1.

2
3.
4
5

At the computer, open the Apple g menu, click the System Preferences menu, and then click
the Print & Fax icon or the Print & Scan icon.

Select the product in the left side of the window.
Click the Options & Supplies button.

Click the Utility tab.

Click the Open Printer Utility button.

HP Utility features
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Use the HP Utility software to perform the following tasks:

Obtain information about supplies status.

Obtain information about the product, such as the firmware version and the serial number.
Print a configuration page.

Contfigure the paper type and size for the tray.

Transfer files and fonts from the computer to the product.

Upgrade the product firmware.

Change the Bonjour name for the product on the Bonjour network.
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Use HP Web Jetadmin software

HP Web Jetadmin is an award-winning, industry-leading tool for efficiently managing a wide variety of
networked HP products, including printers, multifunction products, and digital senders. This single
solution allows you to remotely install, monitor, maintain, troubleshoot, and secure your printing and
imaging environment — ultimately increasing business productivity by helping you save time, control
costs, and protect your investment.

HP Web Jetadmin upgrades are periodically made available to provide support for specific product
features. Go to www.hp.com/go/webijetadmin and click the Self Help and Documentation link to
learn more about upgrades.
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Economy settings

e  Print with EconoMode

e Set the Sleep Delay

e Set the Auto Power Down delay

Print with EconoMode

This product has an EconoMode option for printing drafts of documents. Using EconoMode can use less
toner. However, using EconoMode can also reduce print quality.

HP does not recommend the fulltime use of EconoMode. If EconoMode is used fulltime, the toner
supply might outlast the mechanical parts in the toner cartridge. If print quality begins to degrade and
is no longer acceptable, consider replacing the toner cartridge.

[ NOTE: If this option is not available in your print driver, you can set it using the HP Embedded Web
Server

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.
3. Click the Paper/Quality tab.

4. Click the EconoMode check box.

Set the Sleep Delay

1. From the Home screen on the product control panel, touch the Setup S, button.
2.  Open the following menus:

e  System Setup

e  Energy Settings

e Sleep Delay

3. Select the time for the sleep delay.

E’%NOTE: The default value is 15 Minutes.

Set the Auto Power Down delay

1. From the Home screen on the product control panel, touch the Setup &\ button.
2.  Open the following menus:
e  System Setup

e  Energy Settings
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e  Auto Power Down
e Power Down Delay

3. Select the time for the power-down delay.

E/%"NOTE: The default value is 30 Minutes.

4. The product automatically wakes from the auto power-down mode when it receives jobs or when
you touch the screen on the product control panel. You can change which events cause the
product to wake. Open the following menus:

e  System Setup

e  Energy Settings

e  Auto Power Down
e Wake Events

To turn off a wake event, select the event and then select the No option.
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Product security features

The product supports security standards and recommended protocols that help you keep the product
secure, protect critical information on your network, and simplify the way you monitor and maintain the
product.

For in-depth information about HP's secure imaging and printing solutions, visit www.hp.com/go
secureprinting. The site provides links to white papers and FAQ documents about security features.

Lock the product

1. You can attach a security cable to the slot on
the back of the product.

Set or change the product password

Use the HP Embedded Web Server to set a password or change an existing password for a product on
a network.

- From the Home screen on the product control panel, touch the Network Oﬁ% button to find the

product IP address.

2. To open the HP Embedded Web Server, enter the product IP address into the address line of a
Web browser.

r__":"/%"NOTE: You can also access the HP Embedded Web Server from the HP Device Toolbox for
Windows or the HP Utility for Mac OS X.

3. Click the System tab, and click the Administration link.

2 NOTE: It a password has previously been set, you are prompted to provide the password. Enter
the password, and then click the OK button.

4. Enter the new password in the Password box and in the Confirm password box.

5. At the bottom of the window, click the Apply button to save the password.
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Upgrade the firmware

HP offers periodic upgrades to the product firmware. You can load the firmware upgrades manually, or
you can set the product to automatically load firmware upgrades.

Manually upgrade the firmware

1. From the Home screen on the product control panel, touch the Setup S\ button.
2. Open the following menus:

e  Service

e laserJet Update

e  Check For Updates Now

3. Touch the Yes button to prompt the product to search for firmware upgrades. If the product detects
an upgrade, it will begin the upgrade process.

Set the product to automatically upgrade the firmware

1. From the Home screen on the product control panel, touch the Setup &\ button.
2. Open the following menus:

e Service

e laserlet Update

e  Manage Updates

e  Prompt Before Install

3. Touch the Install automatically option.
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Solve problems checklist

Restore the factory-set defaults

Control panel help system

Paper feeds incorrectly or becomes jammed

Clear jams

Improve print quality

Improve copy quality

Improve scan quality

Improve fax quality

The product does not print or it prints slowly

Solve walk-up USB printing problems

Solve fax problems

Solve USB connection problems

Solve wired network problems

Solve wireless network problems

Solve product software problems with Windows

Solve product software problems with Mac OS X

Remove software (Windows)

Remove software (Mac OS X)

Solve scan to email problems

Solve scan to network folder problems
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Solve problems checklist

Follow these steps when trying to solve a problem with the product.

4.

Step 1: Make sure that the product is set up correctly

Step 2: Check the cabling or wireless connection

Step 3: Check the control panel for error messages

Step 4: Check the paper

Step 5: Check the software

Step 6: Test print functionality

Step 7: Test copy functionality

Step 8: Test the fax functionality

Step 9: Check the toner cartridge

Step 10: Try sending a print job from a computer

Step 11: Verify that the product is on the network

Make sure that the product is set up correctly

Press the power button to turn on the product or to deactivate the Auto Power Down mode.
Check the power-cable connections.

Make sure that the line voltage is correct for the product power configuration. (See the label on
the back of the product for voltage requirements.) If you are using a power strip and its voltage is
not within specifications, connect the product directly to the wall outlet. If it is already connected to
a wall outlet, try a different outlet.

If none of these measures restores power, contact HP Customer Care.

Step 2: Check the cabling or wireless connection

1.

Check the cable connection between the product and the computer. Make sure that the connection
is secure.

Make sure that the cable itself is not faulty by using a different cable, if possible.
If the product is connected to a network, check the following items:

e  Check the light next to the network connection on the product. If the network is active, the
light is green.

e  Make sure that you are using a network cable and not a phone cord to connect to the
network.

e Make sure the network router, hub, or switch is turned on and that it is working correctly.
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e If your computer or the product is connected to a wireless network, low signal quality or
interference might be delaying print jobs.

e If the product is connected wirelessly, print a Wireless Network Test Report to verity that the
wireless connection is working correctly.

a. From the Home screen on the product control panel, touch the Setup &y button.
b. Touch the Self Diagnostics button.
c.  Touch the Run Wireless Test button to print the report.

4. If you are using a personal firewall system on the computer, it might be blocking communication
with the product. Try temporarily disabling the firewall to see if it is the source of the problem.

Step 3: Check the control panel for error messages

The control panel should indicate ready status. If an error message displays, resolve the error.

Step 4: Check the paper

1. Make sure that the paper that you are using meets specifications.

2. Make sure that the paper is loaded correctly in the input tray.

Step 5: Check the software

1. Make sure that the product software is installed correctly.

2. Verify that you have installed the print driver for this product. Check the program to make sure that
you are using the print driver for this product.

Step 6: Test print functionality
1. Print a configuration report.
a. From the Home screen on the product control panel, touch the Information € button.

b. Touch the Report button to print the configuration report.

»

If the page does not print, verify that the input tray contains paper.

@

If the page jams in the product, clear the jam.
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Step 7: Test copy functionality

1. Place the configuration page into the document feeder and make a copy. If paper does not feed
smoothly through the document feeder, you might need to clean the document feeder rollers and
separation pad. Make sure the paper meets specifications for this product.

2. Place the configuration page onto the scanner glass and make a copy.

3. If the print quality on the copied pages is not acceptable, clean the scanner glass and the smalll
glass strip.

/\ CAUTION: Do not use abrasives, acetone, benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these can damage the product. Do not place liquids
directly on the scanner glass. They might seep and damage the product.

Step 8: Test the fax functionality

1. From the Home screen on the product control panel, touch the Setup &\ button.
2. Open the following menus:

e  Service

e  Fax Service

3. Touch the Run Fax Test button to print the Fax Test Report, which provides information about fax
functionality.

Step 9: Check the toner cartridge

Print a supplies status page and check remaining life of the toner cartridge.
1. From the Home screen on the product control panel, touch the Supplies & button.

2. Touch the Report button to print the supplies status page.

Step 10: Try sending a print job from a computer

1. Try printing the job from another computer that has the product software installed.

2. Check the USB or network cable connection. Direct the product to the correct port, or reinstall the
software, selecting the connection type that you are using.

3. If the print quality is unacceptable, verify that the print settings are correct for the paper that you
are using.

Step 11: Verify that the product is on the network
For networked products, open a Web browser, and enter the product IP address (from the previously

printed configuration page) in the address box to open the HP Embedded Web Server (EWS). If the
HP EWS does not open, reinstall the product on the network.
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Restore the factory-set defaults

Restoring the factory-set defaults returns all of the product and network settings to the factory defaults. It
will not reset the page count, tray size, or language. To restore the product to the factory-default
settings, follow these steps.

/A CAUTION: Restoring the factory-set defaults returns all of the settings to the factory defaults, and it
also deletes any pages that are stored in the memory.

1. On the product control panel, touch the Setup &, button.
2. Scroll to and touch the Service menu.
3. Scroll to and touch the Restore Defaults button, and then touch the OK button.

The product automatically restarts.
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Control panel help system

The product has a built-in Help system that explains how to use each screen. To open the Help system,
touch the Help ? button in the upper-right corner of the screen.

For some screens, the Help opens to a global menu where you can search for specific topics. You can
browse through the menu structure by touching the buttons in the menu.

Some Help screens include animations that guide you through procedures, such as clearing jams.

For screens that contain settings for individual jobs, the Help opens to a topic that explains the options
for that screen.

If the product alerts you of an error or warning, touch the Help ? button to open a message that
describes the problem. The message also contains instructions to help solve the problem.
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Paper feeds incorrectly or becomes jammed

The product does not pick up paper

The product picks up multiple sheets of paper

The document feeder jams, skews, or picks up multiple sheets of paper

Prevent paper jams from the paper trays

The product does not pick up paper

If the product does not pick up paper from the tray, try these solutions.

1.

2
3.
4

Open the product and remove any jammed sheets of paper.
Load the tray with the correct size of paper for your job.
Make sure the paper size and type are set correctly on the product control panel.

Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides to the appropriate indentation in the tray.

Check the product control panel fo see if the product is waiting for you to acknowledge a prompt
to feed the paper manually. Load paper, and continue.

The rollers above the tray might be contaminated. Clean the rollers with a lintfree cloth dampened
with warm water.

The product picks up multiple sheets of paper

If the product picks up multiple sheets of paper from the tray, try these solutions.

1.

ENWW

Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not
fan the paper. Return the stack of paper to the tray.

Use only paper that meets HP specifications for this product.

Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package.

Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray,
straighten the stack, and then return some of the paper to the tray.

Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides to the appropriate indentation in the tray.

Make sure the printing environment is within recommended specifications.
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The document feeder jams, skews, or picks up multiple sheets of

paper

The original might have something on it, such as staples or self-adhesive notes, that must be
removed.

Make sure that the documentfeeder cover is closed.

The pages might not be placed correctly. Straighten the pages and adjust the paper guides to
center the stack.

The paper guides must be fouching the sides of the paper stack to work correctly. Make sure that
the paper stack is straight and the guides are against the paper stack.

Verify that there are no pieces of paper, staples, paper clips, or other debris in the paper path.

Clean the document-feeder rollers and the separation pad. Use compressed air or a clean, lintfree
cloth moistened with warm water.

Prevent paper jams from the paper trays

To reduce the number of paper jams, try these solutions.

1.
2,

Use only paper that meets HP specifications for this product.

Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package.

Use paper that has not previously been printed or copied on.

Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray,
straighten the stack, and then return some of the paper to the tray.

Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

Make sure that the tray is fully inserted in the product.

If you are printing on heavy, embossed, or perforated paper, use the manual feed feature and
feed sheets one at a time.

Verify that the tray is configured correctly for the paper type and size.

Make sure the printing environment is within recommended specifications.
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Clear jams

e Jam locations

e Clear jams in the document feeder

e Clear jams in the output area

e Clear jams in Tray 1

e Clear jams in Tray 2 or optional Tray 3

e Clear jams in the fuser

e Clear jams in the duplexer

Jam locations

Use this illustration to identify locations of jams. In addition, instructions display on the control panel to
direct you to the location of jammed paper and how to clear it.

E%?NOTE: Internal areas of the product that might need to be opened to clear jams have green handles
or green labels.

1 Documentfeeder area

2 Output-bin area

3 Top-cover and foner-cartridge area
4 Tray 1 area

5 Tray 2 pickup area

Duplexing area (remove Tray 2 for access)

6 Optional Tray 3

7 Rear door
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Clear jams in the document feeder

1. Open the documentfeeder cover.

2. Gently pull the jammed paper out.
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3. Close the documentfeeder cover. Make sure it
is completely closed.

4. Open the scanner lid. If paper is jammed in
the scanner lid, gently pull it out.
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Clear jams in the output area

1. |If paper is visible from the output bin, grasp
the leading edge and remove it.

2. Open the rear door, and push down so it is
fully opened to a 90° angle.

NOTE: The rear door has two positions. It
opens o a 45° angle for the rear output bin
and to a 90° angle for clearing jams.

168  Chapter 9 Solve problems ENWW



y jammed paper.

Remove an

the rear door.

4. Close

Clear jams 169
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Clear jams in Tray 1

1. If most of the sheet of paper is visible in the
tray, slowly pull the jammed paper out of the
product.

If most of the sheet of paper has been pulled
inside the product, continue with the following
steps.

2. Press the front-door-release button.

3. Open the front door.
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4. Remove the toner cartridge.

5. Lift the jom-access covers and remove any

jammed paper.
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6. Reinsert the toner cartridge.

7. Close the front door.
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Clear jams in Tray 2 or optional Tray 3

1. Remove the tray from the product.

2. Remove the paper from the tray, and discard
any damaged paper.

3. Verify that the rear paper guide is adjusted to
the indentation for the correct paper size. If
necessary, pinch the release and move the

rear rpaper guide to the correct position. It
should click into place.

ENWW

Clear joms 173



5.

6.

174

Load the paper into the tray. Make sure that
the stack is ﬁat at all four corners and that the
top of the stack is below the maximum-height
indicators.

Reinsert and close the tray.

Press the front-door-release button.
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7. Open the front door.

8. Remove the toner cartridge.

9. Lift the jam-access covers and remove any
jammed paper.
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10. Reinsert the toner cartridge.

11. Close the front door.
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Clear jams in the fuser

1. Press the front-door-release button.

2. Open the front door.

3. Remove the toner cartridge.
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4. Lift the jam-access covers and remove any
jommed paper.

5. Reinsert the toner cartridge.

6. Close the front door.
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Clear jams in the duplexer

1. Completely remove Tray 2 from the product.

2. Push the green button to release the duplex
pan.

3. Remove any jammed paper.

ENWW

Clear jams
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4. Close the duplex pan.

5. Reinsert Tray 2.
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Improve print quality

Print from a different software program

Set the papertype setting for the print job

Check the toner-cartridge status

Print a cleaning page

Visudally inspect the toner cartridge

Check the paper and printing environment

Check the EconoMode settings

Try a different print driver

Print from a different software program

Try printing from a different software program. If the page prints correctly, the problem is with the
software program from which you were printing.

Set the paper-type setting for the print job

Check the paper type-setting if you are printing from a software program and the pages have any of

these problems:

smeared print

fuzzy print

dark print

curled paper
scattered dots of toner
loose toner

small areas of missing toner

Check the paper-type setting (Windows)

ENWW

1.

o o » @ N

From the software program, select the Print option.

Select the product, and then click the Properties or Preferences button.
Click the Paper/Quality tab.

From the Paper type drop-down list, click the More... option.

Expand the list of Type is: options.

Expand the category of paper types that best describes your paper.

Improve print quality
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7.
8.

Select the option for the type of paper you are using, and click the OK button.

Click the OK button to close the Document Properties dialog box. In the Print dialog box,
click the OK button to print the job.

Check the paper-type setting (Mac OS X)

1.
2,
3.

4.
5.

Click the File menu, and then click the Print option.

In the Printer menu, select the product.

By default, the print driver displays the Copies & Pages menu. Open the menus drop-down list,
and then click the Finishing menu.

Select a type from the Media-type drop-down list.

Click the Print button.

Check the toner-cartridge status

Check the supplies status page for the following information:

Estimated percentage of cartridge life remaining
Approximate pages remaining
Part numbers for HP toner cartridges

Number of pages printed

Use the following procedure to print the supplies status page:

1.
2,

From the Home screen on the product control panel, touch the Supplies & button.

Touch the Report button to print the supplies status page.

Print a cleaning page

—-—h
.

N

From the Home screen on the product control panel, touch the Setup S, button.
Touch the Service menu.

Touch the Cleaning Page button.

Load plain letter or A4 paper when you are prompted.

Touch the OK button to begin the cleaning process.

The product prints the first side and then prompts you to remove the page from the output bin and
reload it in Tray 1, keeping the same orientation. Wait until the process is complete. Discard the
page that prints.
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Visually inspect the toner cartridge
1. Remove the toner cartridge from the product, and verify that the sealing tape has been removed.
2. Check the memory chip for damage.

3. Examine the surface of the green imaging drum on the toner cartridge.

/\ CAUTION: Do not touch the imaging drum. Fingerprints on the imaging drum can cause print-
quality problems.

4. If you see any scratches, fingerprints, or other damage on the imaging drum, replace the toner
cartridge.

5. If the imaging drum does not appear to be damaged, rock the toner cartridge gently several times
and reinstall it. Print a few pages to see if the problem has resolved.

Check the paper and printing environment

Use paper that meets HP specifications
Use different paper if you are having any of the following problems:
e  The printing is too light or seems faded in areas.
o Specks of toner are on the printed pages.
o  Toner is smearing on the printed pages.

e  Printed characters seem misformed.

Printed pages are curled.

Always use a paper type and weight that this product supports. In addition, follow these guidelines
when selecting paper:

o  Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust,
wrinkles, voids, staples, and curled or bent edges.

o  Use paper that has not been previously printed on.

o Use paper that is designed for use in laser printers. Do not use paper that is designed only for use
in inkjet printers.

o Use paper that is not too rough. Using smoother paper generally results in better print quality.

Check the product environment

Verify that the product is operating within the environmental specifications listed in the product

Warranty and Legal Guide.
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Check the EconoMode settings

HP does not recommend the fulltime use of EconoMode. If EconoMode is used fulltime, the toner
supply might outlast the mechanical parts in the toner cartridge. If print quality begins to degrade and
is no longer acceptable, consider replacing the toner cartridge.

@NOTE: This feature is available with the PCL 6 print driver for Windows. If you are not using that
driver, you can enable the feature by using the HP Embedded Web Server.

Follow these steps if the entire page is too dark or too light.
1. From the software program, select the Print option.
2. Select the product, and then click the Properties or Preferences button.
3. Click the Paper/Quuality tab, and locate the Print Quality area.
4. If the entire page is too dark, use these settings:
e  Select the 600 dpi option.
e  Select the EconoMode check box to enable it.
If the entire page is too light, use these seftings:
e Select the FastRes 1200 option.
e  Clear the EconoMode check box to disable it.
5. Click the OK button to close the Document Properties dialog box. In the Print dialog, click

the OK button to print the job.

Try a different print driver

You might need to use a different print driver if the printed page has unexpected lines in graphics,
missing text, missing graphics, incorrect formatting, or substituted fonts.

HP PCL 6 driver o  Provided as the default driver. This driver is automatically installed unless you
select a different one.

o  Recommended for all Windows environments

o  Provides the overall best speed, print quality, and productfeature support for
most users

o  Developed to align with the Windows Graphic Device Interface (GDI) for the
best speed in Windows environments

o Might not be fully compatible with third-party and custom software programs
that are based on PCL 5

HP UPD PS driver e Recommended for printing with Adobe® software programs or with other
highly graphics-intensive software programs

e  Provides support for printing from postscript emulation needs, or for postscript
flash font support
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HP UPD PCL 5

Recommended for general office printing in Windows environments
Compatible with previous PCL versions and older HP Laserlet products
The best choice for printing from third-party or custom software programs

The best choice when operating with mixed environments, which require the
product to be set to PCL 5 (UNIX, Linux, mainframe)

Designed for use in corporate Windows environments to provide a single
driver for use with multiple product models

Preferred when printing to multiple product models from a mobile Windows
computer

HP UPD PCL 6

Recommended for printing in all Windows environments

Provides the overall best speed, print quality, and product feature support for
most users

Developed to align with Windows Graphic Device Interface (GDI) for best
speed in Windows environments

Might not be fully compatible with third-party and custom solutions based on
PCL5

Download additional print drivers from this Web site: www.hp.com/go/limfpM52 1series software.

Improve print quality
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Improve copy quality

e  Check the scanner glass for dirt and smudges

e  Check the paper settings

° Optimize for text or pictures

e Edgeto-edge copying

e Clean the pickup rollers and separation pad in the document feeder

Check the scanner glass for dirt and smudges

Over time, specks of debris might collect on the scanner glass and white plastic backing, which can
affect performance. Use the following procedure to clean the scanner.

1. Press the power button to turn the product off, v
and then disconnect the power cable from the
electrical outlet.

Open the scanner lid.

Clean the scanner glass, the document feeder
strips, and the white plastic backing with a soft
cloth or sponge that has been moistened with
nonabrasive glass cleaner.

CAUTION: Do not use abrasives, acetone,
benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these
can damage the product. Do not place liquids
directly on the glass or platen. They might seep
and damage the product.
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4. Dry the glass and white plastic parts with a
chamois or a cellulose sponge to prevent
spotting.

5. Connect the power cable to an outlet, and
then press the power button to turn the product
on.

Check the paper settings

1. From the Home screen on the product control panel, touch the Copy button.
Touch the Settings button, and then scroll to and touch the Paper button.

2

3. From the list of paper sizes, touch the name of the paper size that is in Tray 1.
4.  From the list of paper types, touch the name of the paper type that is in Tray 1.
5

Touch the Start Copy button to start copying.

Optimize for text or pictures

The following copy-quality settings are available:

e  Aufo Select: Use this sefting when you are not concerned about the quality of the copy. This is the
default setting.

e Mixed: Use this setting for documents that contain a mixture of text and graphics.
o  Text: Use this setting for documents that contain mostly text.

o  Picture: Use this setting for documents that contain mostly graphics.

ENWW Improve copy quality 187



1. Lload the document onto the scanner glass or
into the document feeder.

2. From the Home screen on the product control
panel, touch the Copy button.

3. Touch the Settings button, and then scroll to
and touch the Optimize button. Touch the
arrow buttons to scroll through the options,
and then touch an option to select it.

4. Touch the Start Copy button to start copying.

Edge-to-edge copying

The product cannot print fully edgeto-edge. There is a 4 mm unprintable border around the page.

Considerations for printing or scanning documents with cropped edges:

o  When the original is smaller than the output size, move the original 4 mm (1/6 inch) away from
the corner indicated by the icon on the scanner. Recopy or scan in this position.

e  When the original is the size of the printed output that you want, use the Reduce/Enlarge feature
to reduce the image so the copy is not cropped.

Clean the pickup rollers and separation pad in the document
feeder

If the product document feeder experiences paper-handling problems, such as jams or multiple-page
feeds, clean the documentfeeder rollers and separation pad.
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1. Open the document-feeder cover.

2. Use a moist, lintfree cloth to wipe both pickup
rollers and the separation pad to remove dirt.

CAUTION: Do not use abrasives, acetone,
benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these
can damage the product. Do not place liquids
directly on the glass or platen. They might seep
and damage the product.

3. Close the documentfeeder cover.
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Improve scan quality

e  Check the scanner glass for dirt and smudges

e Clean the pickup rollers and separation pad in the document feeder

Check the scanner glass for dirt and smudges

Over time, specks of debris might collect on the scanner glass and white plastic backing, which can
affect performance. Use the following procedure to clean the scanner.

1. Press the power button to turn the product off, v
and then disconnect the power cable from the
electrical outlet.

Open the scanner lid.

Clean the scanner glass, the document feeder
strips, and the white plastic backing with a soft
cloth or sponge that has been moistened with
nonabrasive glass cleaner.

CAUTION: Do not use abrasives, acetone,
benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these
can damage the product. Do not place liquids
directly on the glass or platen. They might seep
and damage the product.
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4. Dry the glass and white plastic parts with a
chamois or a cellulose sponge to prevent
spotting.

5. Connect the power cable to an outlet, and
then press the power button to turn the product
on.

Clean the pickup rollers and separation pad in the document
feeder

If the product document feeder experiences paper-handling problems, such as jams or multiple-page
feeds, clean the document-feeder rollers and separation pad.

1. Open the document-feeder cover.
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Use a moist, lintfree cloth to wipe both pickup
rollers and the separation pad to remove dirt.

CAUTION: Do not use abrasives, acetone,
benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these
can damage the product. Do not place liquids
directly on the glass or platen. They might seep
and damage the product.

Close the document-feeder cover.
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Improve fax quality

e  Check the scanner glass for dirt and smudges

e  Check the send-fax resolution setting

e  Check the error correction setting

e Send to a different fax machine

e Clean the pickup rollers and separation pad in the document feeder

o  Check the fitto-page setting

e  Check the sender's fax machine

Check the scanner glass for dirt and smudges

Over time, specks of debris might collect on the scanner glass and white plastic backing, which can
affect performance. Use the following procedure to clean the scanner.

1. Press the power button to turn the product off, Y
and then disconnect the power cable from the
electrical outlet.

2. Open the scanner lid.
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Clean the scanner glass, the document feeder
strips, and the white plastic backing with a soft
cloth or sponge that has been moistened with
nonabrasive glass cleaner.

CAUTION: Do not use abrasives, acetone,
benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these
can damage the product. Do not place liquids
directly on the glass or platen. They might seep
and damage the product.

Dry the glass and white plastic parts with a
chamois or a cellulose sponge to prevent
spotting.

Connect the power cable to an outlet, and
then press the power button to turn the product
on.

Check the send-fax resolution setting

194

If the product was unable to send a fax because the receiving fax machine did not answer or was busy,
the product attempts to redial based on the redial-on-busy, redial-on-no-answer, and redial-on-
communication-error options.

1. From the Home screen on the product control panel, touch the Setup S, button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.

4. Open the Fax Resolution menu.
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Check the error correction setting

Usually, the product monitors the signals on the telephone line while it is sending or receiving a fax. If
the product detects an error during the transmission and the error-correction setting is On, the product
can request that the portion of the fax be resent. The factory-set default for error correction is On.

You should turn off error correction only if you are having trouble sending or receiving a fax, and you
are willing to accept the errors in the transmission. Turning off the setting might be useful when you are
trying to send a fax overseas or receive one from overseas, or if you are using a satellite telephone
connection.

1. From the Home screen on the product control panel, touch the Setup S\ button.
2. Touch the Service menu.
3. Touch the Fax Service menu.

4. Touch the Error Correction button, and then touch the On button.

Send to a different fax machine

Send the fax job to a different fax machine to see if another machine will successfully receive the fax

job.

Clean the pickup rollers and separation pad in the document
feeder

If the product document feeder experiences paper-handling problems, such as jams or multiple-page
feeds, clean the document-feeder rollers and separation pad.

1. Open the document-feeder cover.
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2. Use a moist, lintfree cloth to wipe both pickup
rollers and the separation pad to remove dirt.

CAUTION: Do not use abrasives, acetone,
benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these
can damage the product. Do not place liquids
directly on the glass or platen. They might seep
and damage the product.

3. Close the documentfeeder cover.

Check the fit-to-page setting

If the product printed a fax job off the page, turn on the fitto-page feature from the product control
panel.

@NOTE: Make sure that the default paper size sefting matches the size of the paper in the tray.

1. From the Home screen on the product control panel, touch the Setup S, button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.

4. Touch the Fit to Page button, and then touch the On button.

Check the sender's fax machine

Ask the sender to darken the contrast setting on the sending fax machine, and then resend the fax.
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The product does not print or it prints slowly

The product does not print

If the product does not print at all, try the following solutions.

1. Make sure the product is turned on and that the control panel indicates it is ready.

o If the control panel does not indicate the product is ready, turn the product off and then on
again.
o If the control panel indicates the product is ready, try sending the job again.

2. If the control panel indicates the product has an error, resolve the error and then try sending the
job again.

3.  Make sure the cables are all connected correctly. If the product is connected to a network, check
the following items:

o Check the light next to the network connection on the product. If the network is active, the
light is green.

> Make sure that you are using a network cable and not a phone cord to connect to the
network.

> Make sure the network router, hub, or switch is turned on and that it is working correctly.

4. Install the HP software from the CD that came with the product. Using generic print drivers can
cause delays clearing jobs from the print queue.

5.  From the list of printers on your computer, right-click the name of this product, click Properties,
and open the Ports tab.

> If you are using a network cable to connect to the network, make sure the printer name listed
on the Ports tab matches the product name on the product configuration page.

> If you are using a USB cable and are connecting to a wireless network, make sure the box is
checked next to Virtual printer port for USB.

6. If you are using a personal firewall system on the computer, it might be blocking communication
with the product. Try temporarily disabling the firewall to see if it is the source of the problem.

7. If your computer or the product is connected to a wireless network, low signal quality or
inferference might be delaying print jobs.
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The product prints slowly

If the product prints, but it seems slow, try the following solutions.

1. Make sure the computer meets the minimum specifications for this product. For a list of
specifications, go to this Web site: www.hp.com/support/limfpM52 1series.

2. When you configure the product to print on some paper types, such as heavy paper, the product
prints more slowly so it can correctly fuse the toner to the paper. If the paper type setting is not
correct for the type of paper you are using, change the setting to the correct paper type.

3. If your computer or the product is connected to a wireless network, low signal quality or
interference might be delaying print jobs.
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Solve walk-up USB printing problems

The USB Flash Drive menu does not open when you insert the USB flash drive

The file does not print from the USB flash drive

The file that you want to print is not listed in the USB Flash Drive menu

The USB Flash Drive menu does not open when you insert the USB
flash drive

1.

You might be using a USB flash drive or a file system that this product does not support. Save the
files on a standard USB flash drive that uses File Allocation Table (FAT) file systems. The product
supports FAT12, FAT16, and FAT32 USB storage accessories.

If another menu is already open, close that menu and then reinsert the USB flash drive.

The USB flash drive might have multiple partitions. (Some USB flash drive manufacturers install
software on the drive that creates partitions, similar to a CD.) Reformat the USB flash drive to
remove the partitions, or use a different USB flash drive.

The USB flash drive might require more power than the product can provide.

a. Remove the USB flash drive.

b. Turn the product off and then on.

c. Use a USB flash drive that has its own power supply or that requires less power.
The USB flash drive might not be functioning correctly.

a. Remove the USB flash drive.

b. Turn the product off and then on.

c. Try printing from another USB flash drive.

The file does not print from the USB flash drive

1.
2,
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Make sure paper is in the tray.

Check the control panel for messages. If paper is jammed in the product, clear the jam.

Solve walk-up USB printing problems 199



The file that you want to print is not listed in the USB Flash Drive
menu

1. You might be trying to print a file type that the USB printing feature does not support. The product
supports .PDF and .JPEG file types.

2. You might have too many files in a single folder on the USB flash drive. Reduce the number of files
in the folder by moving them to subfolders.

3. You might be using a character set for the file name that the product does not support. In this case,
the product replaces the file names with characters from a different character set. Rename the files
using ASCII characters.
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Solve fax problems

Checklist for solving fax problems

Perform a fax diagnostic test

Fax trace report

Fax error report printing

Set the fax-error-correction mode

Change the fax speed

Solve problems sending faxes

Solve problems receiving faxes

Solve general fax problems

Checklist for solving fax problems

ENWW

Several possible fixes are available. After each recommended action, retry faxing to see if the
problem is resolved.

For best results during fax problem solving, make sure the line from the product is connected
directly to the wall phone port. Disconnect all other devices that are connected to the product.

Verify that the telephone cord is connected to the correct port on the back of the product.
Check the phone line by using the fax test:

a. From the Home screen on the product control panel, touch the Setup &\, button, and then
touch the Service menu.

b. Select the Fax Service menu.
c. Select the Run Fax Test option. The product prints a fax test report.
The report contains the following possible results:
e Pass: The report contains all of the current fax settings for review.

o  Fail: The report indicates the nature of the error and contains suggestions for how to
resolve the issue.

Verify that the product firmware is current:

a. Print a configuration page from the control panel Reports menu to obtain the current firmware
date code.

b. Goto www.hp.com.
1. Click the Support & Drivers link.

2. Click the Download drivers and software (and firmware) link option.
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In the For product box, enter the product model number, and then click the Go button.
Click the link for your operating system.
Scroll to the Firmware section of the table.

o If the listed version matches the version on the configuration page, you have the
most current version.

o If the versions are different, download the firmware upgrade file and upgrade the
firmware on the product following the on-screen instructions.

g The product must be connected to a computer with internet access to
upgrade firmware.

> Resend the fax.
Verify that the fax was set up when the product software was installed.
From the computer, in the HP program folder, run the Fax Setup Utility.
Verify that the telephone service supports analog fax.

e If using ISDN or digital PBX, contact your service provider for information about configuring
to an analog fax line.

e If using a VolP service, change the sefting to from the control panel.
Ask if your service provider supports fax and for the recommended fax modem speed. Some
companies might require an adapter.

e If you are using a DSL service, make sure that a filter is included on the phone-line connection
to the product. Contact the DSL service provider, or purchase a DSL filter if you do not have
one. If a DSL filter is installed, try another filter because filters can be defective.

If the error persists, find more detailed problem-solving solutions in the sections that follow this one.

From the product control panel, you can run a diagnostic test that provides information about the
product fax settings.

From the Home screen on the product control panel, touch the Setup &\, button.
Open the following menus:

[ ]

[ ]

Touch the button to start the test. The product prints a test page that shows test results.
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Fax trace report

A fax T.30 trace report has information that can help resolve fax transmission problems. If you call HP
for help in resolving these problems, print a T.30 trace report before you call.

1.
2.
3.
4.

From the Home screen on the product control panel, touch the Setup 8\, button.
Touch the Service menu.
Touch the Fax Service menu.

Touch the Print T.30 Trace button, and then touch the Now button.

E‘/?"NOTE: This procedure prints a report for the last fax job, successful or not. To generate a report for
each unsuccessful fax job, select the If Error setting. To generate a report for each fax job, select the At
End of Call setting.

Fax error report printing

Use the following instructions to print fax logs and reports:

Print all fax reports

Use this procedure to print all of the following reports at one time:

2
3.
4

Last Call Report

Fax Activity Log

Phone Book Report

Junk Fax List

Billing Report (when Billing Codes are turned on)
Configuration Report

Usage Page

From the Home screen on the product control panel, touch the Fax button.
Touch the Fax Menu button.
Touch the Fax Reports button.

Touch the Print All fax Reports button.

Print individual fax reports

1.
2,
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From the Home screen on the product control panel, touch the Fax button.

Touch the Fax Menu button.
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3. Touch the Fax Reports button.

4. Touch the name of the report that you want to print.

Set the fax error report

A fax error report is a brief report that indicates the product experienced a fax job error. You can set it
to print after the following events:

o  Every fax error (the factory-set default)
e Send fax error
e Receive fax error

o Never

E‘%NOTE: With this option, you will have no indication that a fax failed to be transmitted unless
you print a fax activity log.

1. From the Home screen on the product control panel, touch the Fax button.
2. Touch the Fax Menu button.
3. Touch the Fax Reports button.

4. Touch the Fax Error Report button, and then touch the printing option that you want to use.

Set the fax-error-correction mode

Usually, the product monitors the signals on the telephone line while it is sending or receiving a fax. If
the product detects an error during the transmission and the error-correction setting is On, the product
can request that the portion of the fax be resent. The factory-set default for error correction is On.

You should turn off error correction only if you are having trouble sending or receiving a fax, and you
are willing to accept the errors in the transmission. Turning off the setting might be useful when you are
trying to send a fax overseas or receive one from overseas, or if you are using a satellite telephone
connection.

1.  From the Home screen on the product control panel, touch the Setup &\, button.
2. Touch the Service menu.
3. Touch the Fax Service menu.

4. Touch the Error Correction button, and then touch the On button.

Change the fax speed
The fax-speed setting is the modem protocol that the product uses to send faxes. It is the worldwide

standard for full-duplex modems that send and receive data across telephone lines at up to 33,600 bits
per second (bps). The factory-set default for the fax-speed setting is Fast(V.34).
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You should change the setting only if you are having trouble sending a fax to or receiving a fax from a
particular device. Decreasing the fax speed might be useful when you are trying to send a fax
overseas, or receive one from overseas, or if you are using a satellite telephone connection.

1. From the Home screen on the product control panel, touch the Setup S\ button.
2. Touch the Fax Setup menu.
3. Touch the Advanced Setup menu.

4. Scroll to and touch the Fax Speed button, and then touch the speed setting that you want to use.

Solve problems sending faxes

e An error message displays on the control panel

e The control panel displays a Ready message with no attempt to send the fax

e The control panel displays the message "Storing page 1" and does not progress beyond that
message

e Faxes can be received, but not sent

e  Product is password protected

e Unable to use fax functions from the control panel

e Unable to use speed dials

e Unable to use group dials

e Receive a recorded error message from the phone company when trying to send a fax

e Unable to send a fax when a phone is connected to the product

An error message displays on the control panel

The Communication error message appears
o  Allow the product to retry sending the fax. Re-sending temporarily reduces the fax speed.

o  Disconnect the product telephone cord from the wall, connect a telephone to the phone jack on the
wall, and try making a call. Connect the product phone cord to a jack for another phone line.

o  Try a different phone cord.

e  From the control panel, change the Fax Speed option to the Medium(V.17) setting or Slow(V.29)
setting.

a. From the Home screen on the product control panel, touch the Setup &, button.
b. Open the Fox Sefup menu.

c. Open the Advanced Setup menu.
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No dial tone

d. Open the Fax Speed menu.

e. Select the correct setting.

Turn off the Error Correction option.

a. From the Home screen on the product control panel, touch the Setup S\, button.
b. Open the Service menu.

c.  Open the Fax Service menu.

d. Open the Error Correction menu.

e. Select the Off sefting.

E’%NOTE: Turning off the Error Correction option can reduce image quality.

If the error persists, contact HP. See www.hp.com/support/limfpM52 1series or the support flyer
that came in the product box.

Make sure that the telephone cord is connected to the correct port on the product.

Make sure that the telephone cord from the product is connected directly to the wall telephone
jack.

Check for a dial tone on the phone line by using the Start Fax button.

Disconnect the product telephone cord from the wall, connect a telephone to the phone jack on the
wall, and try making a voice call.

Disconnect the telephone cord from both the product and the wall and reconnect the cord.

Make sure that you are using the telephone cord that came with the product.

Connect the product phone cord to a jack for another phone line.

Check the phone line by using the Run Fax Test option from the Service menu on the control panel.
a. From the Home screen on the product control panel, touch the Setup &\ button.

b. Open the Service menu.

c.  Open the Fax Service menu.

d. Select the Run Fax Test item.

The Fax is busy message appears

Try sending the fax again.
Call the recipient to ensure that the fax machine is on and ready.

Check that you are dialing the correct fax number.
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o Check for a dial tone on the phone line by using the Start Fax button.

e Make sure that the phone line is working by disconnecting the product, connecting a telephone to
the phone line, and making a voice call.

o  Connect the product phone cord to a jack for another phone line, and try sending the fax again.
o  Try a different phone cord.
o  Send the fax at a later time.

o If the error persists, contact HP. See www.hp.com/support/limfipM52 1 series or the support flyer
that came in the product box.

The No fax answer message appears
e  Try to resend the fax.
o  Call the recipient to ensure that the fax machine is on and ready.
o Check that you are dialing the correct fax number.

o  Disconnect the product telephone cord from the wall, connect a telephone to the phone jack on the
wall, and try making a voice call.

o  Connect the product phone cord to a jack for another phone line.
e  Try adifferent phone cord.
®  Make sure that the phone cord from the wall telephone jack is connected to the line {o| port.
o  Check the phone line by using the Run Fax Test option from the Service menu on the control panel.
a. From the Home screen on the product control panel, touch the Setup &\, button.
b. Open the Service menu.
c. Open the Fax Service menu.
d. Select the Run Fax Test item.

o  If the error persists, contact HP. See www.hp.com/support/limfpM52 1series or the support flyer
that came in the product box.

Document feeder paper jam

o Verity that the paper meets product size requirements. The product does not support pages longer
than 381 mm (15 in) for faxing.

o  Copy or print the original to letter, A4, or legal size paper, and then resend the fax.
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The Fax storage is full message appears

e  Turn the product off then on.

o  Print stored faxes that have not been printed.

a.
b.
c.

d.

Touch the Fax button, and then touch the Fax Menu button.
Open the Receive Options menu.
Select the Print Private Faxes item.

Provide the password when the product prompts you.

o  Delete stored faxes from memory.

b.
c.

d.

From the Home screen on the product control panel, touch the Setup S\, button.
Open the Service menu.
Open the Fax Service menu.

Select the Clear Saved Faxes item.

o  Divide the large fax job into smaller sections, and then fax them individually.

Scanner error

o  Verify that the paper meets product size requirements. The product does not support pages longer
than 381 mm (15 in) for faxing.

o  Copy or print the original onto letter, A4, or legal size paper and then resend the fax.

The control panel displays a Ready message with no attempt to send the fax

o Check the fax activity log for errors.

a.
b.
c.

d.

Touch the Fax button, and then touch the Fax Menu button.
Open the Fax Reports menu.
Open the Fax Activity Log menu.

Select the Print Log Now option.

o If a phone is connected to the product, make sure that the phone is hung up.

o Disconnect all other lines between the fax and the product.

o  Connect the product directly into the wall telephone jack and resend the fax.
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The control panel displays the message "Storing page 1" and does not
progress beyond that message

o  Delete stored faxes from memory.
a. From the Home screen on the product control panel, touch the Setup &, button.
b. Open the Service menu.
c. Open the Fax Service menu.

d. Select the Clear Saved Faxes item.

Faxes can be received, but not sent
Send fax and nothing happens.
1. Check for a dial tone on the phone line by using the Start Fax button.
2. Turn the product off then on.

3. Use the control panel or the HP Fax Setup Wizard to configure the fax time, date, and fax header
information.

a. From the Home screen on the product control panel, touch the Setup &\, button.
b. Open the Fox Sefup menu.
c. Open the Basic Setup menu.
d. Open the Fax Header menu.
e. Enter the correct settings.
4. Verify that any extension phones on the line are hung up.

5. If using a DSL service, make sure that the phone line connection to the product includes a high-
pass filter.

Product is password protected

If a network administrator has set a product password, then you must obtain the password in order to
use the product fax features.

Unable to use fax functions from the control panel

o  The product might be password protected. Use the HP Embedded Web Server, HP Toolbox
software, or the control panel to set a password.

o If you do not know the password for the product, contact your system administrator.

o Verify with the system administrator that the fax functionality has not been disabled.
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Unable to use speed dials

e  Make sure that the fax number is valid.

o If an outside line requires a prefix, turn on the Dial Prefix option or include the prefix in the speed
dial number.

a. From the Home screen on the product control panel, touch the Setup &\ button.
b. Open the Fax Setup menu.

c. Open the Basic Sefup menu.

d. Open the Dial Prefix menu.

e. Select the On setting.

Unable to use group dials
o  Make sure that the fax number is valid.

o If an outside line requires a prefix, turn on the Dial Prefix option or include the prefix in the speed
dial number.

a. From the Home screen on the product control panel, touch the Setup &\ button.
b. Open the Fax Setup menu.
c.  Open the Basic Sefup menu.
d. Open the Dial Prefix menu.
e. Select the On setting.
o  Set up all entries in the group with speed dial entries.
a. Open an unused speed dial entry.
b. Enter the fax number for the speed dial.

c. Touch the OK button to save the speed dial.

Receive a recorded error message from the phone company when trying to
send a fax

e Make sure you dial the fax number correctly, and make sure that the phone service is not blocked.
For example, some phone services might prevent long distance calling.

o If an outside line requires a prefix, turn on the Dial Prefix option or include the prefix in the speed
dial number.

a. From the Home screen on the product control panel, touch the Setup &\ button.
b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

210  Chapter 9 Solve problems ENWW



d. Open the Dial Prefix menu.

e. Select the On sefting.

2 NOTE: To send a fax without a prefix, when the Dial Prefix option is turned on, send the fax
manually.

o Send a fax to an international number
a. |If a prefix is required, manually dial the telephone number with the prefix.
b. Enter the country/region code before dialing the phone number.
¢.  Wait for pauses as you hear the tones on the phone.

d. Send the fax manually from the control panel.

Unable to send a fax when a phone is connected to the product

e Make sure that the telephone is hung up.
o Make sure that the telephone is not being used for a voice call when faxing.

o Disconnect the phone from the line, and then try sending the fax.

Solve problems receiving faxes

e The fax does not respond

e An error message displays on the control panel

e A fax s received but does not print

e Sender receives a busy signal

e No dial tone

e Cannot send or receive a fax on a PBX line

The fax does not respond

The fax has a dedicated phone line
o  Setthe Answer Mode option to the Automatic setting from the control panel.
a. From the Home screen on the product control panel, touch the Setup &\ button.
b. Open the Fox Sefup menu.
c. Open the Basic Setup menu.
d. Open the Answer Mode menu.

e. Select the Automatic sefting.
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An answering machine is connected to the product

o  Set the Answer Mode option to the TAM setting and connect the answering machine to the
“telephone” port.

a. From the Home screen on the product control panel, touch the Setup &\ button.
b. Open the Fax Setup menu.

c. Open the Basic Sefup menu.

d. Open the Answer Mode menu.

e. Select the TAM setting.

If the TAM setting is unavailable, set the Answer Mode option to the Automatic setting.

o  Setthe Rings to Answer setting fo at least one ring more than the number of rings for which the
answering machine is set.

a. From the Home screen on the product control panel, touch the Setup &\, button.
b. Open the Fax Setup menu.
c. Open the Basic Sefup menu.
d. Open the Rings to Answer menu.
e. Select the correct setting.
o  Connect the answering machine to the “telephone” port.

o If the product has a telephone handset connected, set the Answer Mode option to the Fax/Tel
setting to route calls to the correct device. When detecting a voice call, the product generates a
ring tone that alerts you to pick up the telephone handset.

a. From the Home screen on the product control panel, touch the Setup &\ button.
b. Open the Fax Setup menu.

c. Open the Basic Setup menu.

d. Open the Answer Mode menu.

e. Select the Fax/Tel setting.

The Answer Mode setting is set to the Manual setting

e Touch the Start Fax button on the product control panel.
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Voice mail is available on the fax line

e  Add a distinctive ring service to your telephone line and change the Distinctive Ring setting on the
product to match the ring pattern supplied by the telephone company. Contact your telephone
company for information.

b.
c.
d.

e.

From the Home screen on the product control panel, touch the Setup &, button.
Open the Fax Setup menu.

Open the Basic Setup menu.

Open the Distinctive Ring menu.

Select the correct setting.

o  Buy a dedicated line for faxing.

e  Setthe Answer Mode option to the Manual setting.

b.
c.
d.

e.

From the Home screen on the product control panel, touch the Setup S button.
Open the Fox Setup menu.

Open the Basic Setup menu.

Open the Answer Mode menu.

Select the Manual setting.

E/?’NOTE: You must be present to receive faxes.

The product is connected to a DSL phone service

o  Check the installation and features. A DSL modem requires a high-pass filter on the phone line
connection to the product. Contact your DSL service provider for a filter or buy a filter.

o Verity that the filter is connected.

o  Replace the existing filter to make sure that it is not defective.

The product uses a fax over IP or VolIP phone service

o  Set the Fax Speed option to the Slow(V.29) or Medium(V.17) setting.

From the Home screen on the product control panel, touch the Setup & button.

b. Open the Fax Setup menu.

C.
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Open the Advanced Setup menu.
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d. Open the Fax Speed menu.
e. Select the correct setting.

Contact your service provider o make sure that fax is supported and for a recommended fax
speed settings. Some companies might require an adapter.

An error message displays on the control panel

The No fax detected. message displays

2 NOTE: This error does not always refer to a missed fax. If a voice call is made to a fax number by
mistake and the caller hangs up, the No fax detected. message displays on the control panel.

Ask the sender to resend the fax.

Make sure that the telephone cord from the product is connected to the wall telephone jack.
Try a different phone cord.

Connect the product phone cord to a jack for another phone line.

Make sure the telephone line and phone wall jack are active by connecting a telephone and
checking for a dial tone.

Make sure that the telephone cord is connected to the “line” port on the product.
Check the phone line by running a fax test from the control panel.

If the error persists, contact HP. See www.hp.com/support/limfpM52 1series or the support flyer
that came in the product box.

The Communication error message appears
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Ask the sender to send the fax again or send at a later time when line conditions have improved.

Disconnect the product telephone cord from the wall, connect a telephone to the phone jack on the
wall, and try making a call. Plug the product phone cord into a jack for another phone line.

Try a different phone cord.

Set the Fax Speed option to the Slow(V.29) or Medium(V.17) setting.

a. From the Home screen on the product control panel, touch the Setup J\ button.
b. Open the Fax Setup menu.

¢. Open the Advanced Setup menu.

d. Open the Fax Speed menu.

e. Select the correct setting.

Turn off the Error Correction feature to prevent automatic error correction.
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E/%"NOTE: Turning off the Error Correction feature can reduce image quality.

a. From the Home screen on the product control panel, touch the Setup &\, button.
b. Open the Service menu.

c. Open the Fax Service menu.

d. Open the Error Correction menu.

e. Select the Off setting.

o  Print the Fax Activity Log report from the control panel to determine if the error occurs with a
specific fax number.

a. Touch the Fax button, and then touch the Fax Menu button.
b. Open the Fax Reports menu.

c. Open the Fax Activity Log menu.

d. Select the Print Log Now option.

o  If the error persists, contact HP. See www.hp.com/support/limfpM52 1series or the support flyer
that came in the product box.

The Fax storage is full message appears
o  Turn the product off then on.
e  Print all of the faxes, and then have the sender resend the fax.
o  Ask the sender to divide a large fax job into smaller sections, and then fax them individually.

e  Make sure that the resolution of the sending fax machine is not set to the Photo setting or the
Superfine sefting.

a. From the Home screen on the product control panel, touch the Setup &\ button.
b. Open the Fox Sefup menu.

c. Open the Advanced Setup menu.

d. Open the Fax Resolution menu.

e. Select the correct setting.

o  Cancel all fax jobs or clear the faxes from memory.

The Fax is busy message appears

o The product cannot receive a fax while attempting to send one. Cancel the fax send and try
sending at a later time.

o  Allow the product to try sending the fax again.
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A fax is received but does not print

The Private Receive feature is on

e When the Private Receive feature is activated, received faxes are stored in memory. A password is
required to print the stored faxes.

o  Enter the password to print the fax. If you do not know the password, contact the product
administrator.

2 NOTE:  Memory errors might occur if the faxes are not printed. The product will not answer if the
memory is full.

Sender receives a busy signal

A handset is connected to the product

e  Make sure the phone is hung up.

e  Change the Answer Mode option to match the product setup.
a. From the Home screen on the product control panel, touch the Setup &\, button.
b. Open the Fax Setup menu.
c. Open the Basic Setup menu.
d. Open the Answer Mode menu.
e. Select the setfting that matches the product setup.

Set the Answer Mode option fo the Fax/Tel sefting to automatically receive faxes. The Fax/
Tel setting automatically defects whether the incoming transmission is a fax or a voice call
and routes the call to the appropriate device.

A phone line splitter is being used

o If you are using a phone line splitter, remove the splitter and set up the phone as a downstream
phone.

e  Make sure the phone is hung up.

o  Make sure the phone is not being used for a voice call when faxing.

No dial tone

o If using a phone line splitter, remove the phone line splitter and set up the phone as a downstream
phone.

Cannot send or receive a fax on a PBX line

e If you are using a PBX phone line, contact your PBX administrator to configure an analog fax line
for your product.
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Solve general fax problems

e Faxes are sending slowly

e Fax qudlity is poor

e  Fax cuts off or prints on two pages

Faxes are sending slowly
The product is experiencing poor phone line quality.
o  Retry sending the fax when the line conditions have improved.
o  Check with the phone service provider that the line supports fax.
o Turn off the Error Correction setting.
a. Open the Sefup Menu menu.
b. Open the Service menu.
c. Open the Fax Service menu.
d. Open the Error Correction menu.

e. Select the Off setting.

By NOTE: This can reduce image quality.

o  Use white paper for the original. Do not use colors such as gray, yellow, or pink.

o Increase the Fax Speed setting.
a. Open the Sefup Menu menu.
b. Open the Fax Setup menu.
c. Open the Advanced Setup menu.
d. Open the Fax Speed menu.

e. Select the correct setting.

o Divide large fax jobs into smaller sections, and then fax them individually.

o Change the fax settings on the control panel to a lower resolution.
a. Open the Sefup Menu menu.
b. Open the Fox Sefup menu.
c. Open the Advanced Setup menu.
d. Open the Fax Resolution menu.

e. Select the correct setting.
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Fax quality is poor

Fax is blurry or light.

o Increase fax resolution when sending faxes. Resolution does not affect received faxes.

a.
b.
c.

d.

e.

Open the Setup Menu menu.
Open the Fax Setup menu.

Open the Advanced Setup menu.
Open the Fax Resolution menu.

Select the correct setting.

E”/f’NOTE: Increasing resolution slows transmission speed.

e Turn on the Error Correction setting from the control panel.

a.
b.
c.

d.

e.

Open the Setup Menu menu.
Open the Service menu.

Open the Fax Service menu.
Open the Error Correction menu.

Select the On setting.

o  Check the toner cartridges and replace if necessary.

o Ask the sender to darken the contrast setting on the sending fax machine, and then resend the fax.

Fax cuts off or prints on two pages
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o  Set the Default Paper Size setting. Faxes print on a single size of paper based on the Default
Paper Size settings.

a.
b.
c.

d.

e.

Open the Setup Menu menu.

Open the System Sefup menu.
Open the Paper Sefup menu.
Open the Default Paper Size menu.

Select the correct setting.

e  Set the paper type and size for the tray used for faxes.

e  Turn on the Fit to Page setting to print longer length faxes on letter or A4 size paper.

b.

Open the Setup Menu menu.

Open the Fax Setup menu.
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c. Open the Advanced Setup menu.
d. Open the Fit to Page menu.

e. Select the On sefting.

E"/f’NOTE: If the Fit to Page setting is off and the Default Paper Size setting is set to letter, a legal size
original prints on two pages.
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Solve USB connection problems

If you have connected the product directly to a computer, check the cable.
o Verify that the cable is connected to the computer and to the product.
o Verify that the cable is not longer than 5 m (16.4 f). Try using a shorter cable.

o Verify that the cable is working correctly by connecting it to another product. Replace the cable if
necessary.
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Solve wired network problems

Check the following items to verify that the product is communicating with the network. Before

beginning, print a configuration page from the product control panel and locate the product IP address
that is listed on this page.

Poor physical connection

The computer is using the incorrect IP address for the product

The computer is unable to communicate with the product

The product is using incorrect link and duplex settings for the network

New software programs might be causing compatibility problems

The computer or workstation might be set up incorrectly

The product is disabled, or other network settings are incorrect

2 NOTE:  HP does not support peerto-peer networking, as the feature is a function of Microsoft
operating systems and not of the HP print drivers. For more information, go to Microsoft at
www.microsoft.com.

Poor physical connection

1.
2,
3.

4.

Verify that the product is attached to the correct network port using a cable of the correct length.
Verify that cable connections are secure.

Look at the network port connection on the back of the product, and verify that the amber activity
light and the green link-status light are lit.

If the problem continues, try a different cable or port on the hub.

The computer is using the incorrect IP address for the product

1.
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Open the printer properties and click the Ports tab. Verify that the current IP address for the
product is selected. The product IP address is listed on the product configuration page.

If you installed the product using the HP standard TCP/IP port, select the box labeled Always
print to this printer, even if its IP address changes.

It you installed the product using a Microsoft standard TCP/IP port, use the hostname instead of
the IP address.

If the IP address is correct, delete the product and then add it again.
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The computer is unable to communicate with the product

1. Test network communication by pinging the network.

a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and
then type cmd.

b. Type ping followed by the IP address for your product.

For Mac OS X, open the Network Utility, and then supply the IP address in the correct field in
the Ping pane.

c. If the window displays round-rip times, the network is working.

2. If the ping command failed, verify that the network hubs are on, and then verify that the network
settings, the product, and the computer are all configured for the same network.

The product is using incorrect link and duplex settings for the
network

Hewlett-Packard recommends leaving this setting in automatic mode (the default setting). If you change
these settings, you must also change them for your network.

New software programs might be causing compatibility problems

Verify that any new software programs are correctly installed and that they use the correct print driver.

The computer or workstation might be set up incorrectly

1. Check the network drivers, print drivers, and the network redirection.

2. Verity that the operating system is configured correctly.

The product is disabled, or other network settings are incorrect

1. Review the configuration page to check the status of the network protocol. Enable it if necessary.

2. Reconfigure the network settings if necessary.

222 Chapter 9 Solve problems ENWW



Solve wireless network problems

Wireless connectivity checklist

The product does not print after the wireless configuration completes

The product does not print, and the computer has a third-party firewall installed

The wireless connection does not work after moving the wireless router or product

Cannot connect more computers to the wireless product

The wireless product loses communication when connected to a VPN

The network does not appear in the wireless networks list

The wireless network is not functioning

Perform a wireless network diagnostic test

Reduce interference on a wireless network

Wireless connectivity checklist
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Verify that the network cable is not connected.

Verify that the product and the wireless router are turned on and have power. Also make sure that
the wireless radio in the product is turned on.

Verify that the service set identifier (SSID) is correct. Print a configuration page to determine the
SSID. If you are not sure the SSID is correct, run the wireless setup again.

With secured networks, verify that the security information is correct. If the security information is
incorrect, run the wireless setup again.

If the wireless network is working correctly, try accessing other computers on the wireless network.
If the network has Infernet access, try connecting to the Internet over a wireless connection.

Verify that the encryption method (AES or TKIP) is the same for the product as it is for the wireless
access point (on networks using WPA/WPA2 security).

Verify that the product is within the range of the wireless network. For most networks, the product
must be within 30 m (100 ft) of the wireless access point (wireless router).

Verify that obstacles do not block the wireless signal. Remove any large metal objects between the
access point and the product. Make sure poles, walls, or support columns containing metal or
concrete do not separate the product and wireless access point.

Verify that the product is located away from electronic devices that might interfere with the
wireless signal. Many devices can interfere with the wireless signal including motors, cordless
phones, security system cameras, other wireless networks, and some Bluetooth devices.

Verify that the print driver is installed on the computer.

Verify that you have selected the correct printer port.
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Verify that the computer and product connect to the same wireless network.

For Mac OS X, verify that the wireless router supports Bonjour.

The product does not print after the wireless configuration
completes

1.

2
3
4.
5

Make sure that the product is turned on and in the ready state.

Turn off any third-party firewalls on your computer.

Make sure that the wireless network is working correctly.

Make sure that your computer is working correctly. If necessary, restart the computer.

Verify that you can open the product HP Embedded Web Server from a computer on the network.

The product does not print, and the computer has a third-party
firewall installed

1.
2,

Update the firewall with the most recent update available from the manufacturer.

If programs request firewall access when you install the product or try to print, make sure you
allow the programs to run.

Temporarily turn off the firewall, and then install the wireless product on the computer. Enable the
firewall when you have completed the wireless installation.

The wireless connection does not work after moving the wireless
router or product

1.
2,
3.

Make sure that the router or product connects to the same network that your computer connects to.
Print a configuration page.

Compare the service set identifier (SSID) on the configuration page to the SSID in the printer
configuration for the computer.

If the numbers are not the same, the devices are not connecting to the same network. Reconfigure
the wireless setup for the product.

Cannot connect more computers to the wireless product

1.

Make sure that the other computers are within the wireless range and that no obstacles block the
signal. For most networks, the wireless range is within 30 m (100 ff) of the wireless access point.

Make sure that the product is turned on and in the ready state.

Turn off any third-party firewalls on your computer.
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4. Make sure that the wireless network is working correctly.

5.

Make sure that your computer is working correctly. If necessary, restart the computer.

The wireless product loses communication when connected to a

VPN

Typically, you cannot connect to a VPN and other networks at the same time.

The network does not appear in the wireless networks list

Make sure the wireless router is turned on and has power.

The network might be hidden. However, you can still connect to a hidden network.

The wireless network is not functioning

1.
2,
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Make sure that the network cable is not connected.
To verity if the network has lost communication, try connecting other devices to the network.

Test network communication by pinging the network.

a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and

then type cmd.
b. Type ping followed by the router IP address.

For Mac OS X, open the Network Utility, and then supply the IP address in the correct field
the Ping pane.

c. If the window displays round-rip times, the network is working.
Make sure that the router or product connects to the same network that the computer connects to.

a. Print a configuration page.

in

b. Compare the service set identifier (SSID) on the configuration report to the SSID in the printer

configuration for the computer.

c. If the numbers are not the same, the devices are not connecting to the same network.
Reconfigure the wireless setup for the product.

Solve wireless network problems
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Perform a wireless network diagnostic test

From the product control panel, you can run a diagnostic test that provides information about the
wireless network settings.

1. From the Home screen on the product control panel, touch the Setup S, button.

2. Open the Self Diagnostics menu.

3. Touch the Run Wireless Test button to start the test. The product prints a test page that shows test
results.

Reduce interference on a wireless network

The following tips can reduce interference in a wireless network:

o  Keep the wireless devices away from large metal objects, such as filing cabinets, and other
electromagnetic devices, such as microwaves and cordless telephones. These objects can disrupt
radio signals.

o  Keep the wireless devices away from large masonry structures and other building structures. These
objects can absorb radio waves and lower signal strength.

o  Position the wireless router in a central location in line of sight with the wireless products on the
network.
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Solve product software problems with Windows

e A print driver for the product is not visible in the Printer folder

e An error message was displayed during the software installation

e The product is in Ready mode, but nothing prints

A print driver for the product is not visible in the Printer folder

1. Reinstall the product software.

2% NOTE:  Close any applications that are running. To close an application that has an icon in the
system tray, right-click the icon, and select Close or Disable.

2. Try connecting the USB cable to a different USB port on the computer.

An error message was displayed during the software installation

1. Reinstall the product software.

2% NOTE:  Close any applications that are running. To close an application that has an icon in the
system tray, right-click the icon, and select Close or Disable.

2. Check the amount of free space on the drive where you are installing the product software. If
necessary, free up as much space as you can, and reinstall the product software.

3.  If necessary, run the Disk Defragmenter, and reinstall the product software.

The product is in Ready mode, but nothing prints

1. Print a configuration page, and verify the product functionality.

2. Verify that all of the cables are correctly seated and within specifications. This includes the USB
and power cables. Try a new cable.

3. Verify the IP address on the configuration page matches the IP address for the software port. Use
one of the following procedures:

Windows XP, Windows Server 2003, Windows Server 2008, and Windows Vista
a. Click Start.
b. Click Settings.

c. Click Printers and Faxes (using the default Start menu view) or click Printers (using the
Classic Start menu view).

d. Rightclick the product driver icon, and then select Properties.

e. Click the Ports tab, and then click Configure Port.
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f.  Verity the IP address, and then click OK or Cancel.

g. |Ifthe IP addresses are not the same, delete the driver, and reinstall the driver using the
correct IP address.

a. Click Start.

b. Click Devices and Printers.

c. Rightclick the product driver icon, and then select Printer properties.
d. Click the Ports tab, and then click Configure Port.

e. Verity the IP address, and then click OK or Cancel.

f. If the IP addresses are not the same, delete the driver, and reinstall the driver using the
correct IP address.
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Solve product software problems with Mac OS X

e The print driver is not listed in the Print & Fax or Print & Scan list

e The product name does not appear in the product list in the Print & Fax or Print & Scan list

e The print driver does not automatically set up the selected product in the Print & Fax or Print &
Scan list

e A print job was not sent to the product that you wanted

e  When connected with a USB cable, the product does not appear in the Print & Fax or Print & Scan
list after the driver is selected.

e You are using a generic print driver when using a USB connection

The print driver is not listed in the Print & Fax or Print & Scan list

1. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/
PPDs/Contents/Resources. If necessary, reinstall the software.

2. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the

software.

The product name does not appear in the product list in the Print &
Fax or Print & Scan list
1. Make sure that the cables are connected correctly and the product is on.

2. Print a configuration page to check the product name. Verify that the name on the configuration
page matches the product name in the Print & Fax (Print & Scan in Mac OS X v10.7) list.

3.  Use the + button to add the product to the Print & Fax (Print & Scan in Mac OS X v10.7) list.

4. Replace the USB or network cable with a high-quality cable.

The print driver does not automatically set up the selected product
in the Print & Fax or Print & Scan list
1. Make sure that the cables are connected correctly and the product is on.

2. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/
PPDs/Contents/Resources. If necessary, reinstall the software.

3. Ifthe GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the
software.

4. Use the + button to add the product to the Print & Fax (Print & Scan in Mac OS X v10.7) list.

5. Replace the USB or network cable with a high-quality cable.
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A print job was not sent to the product that you wanted

1.
2,

Open the print queue and restart the print job.

Another product with the same or similar name might have received your print job. Print a
configuration page fo check the product name. Verify that the name on the configuration page
matches the product name in the Print & Fax (Print & Scan in Mac OS X v10.7) list.

When connected with a USB cable, the product does not appear in
the Print & Fax or Print & Scan list after the driver is selected.

Software troubleshooting

1.
2.

Make sure that your Mac operating system is Mac OS X 10.6 or later.
Use the + button to add the product to the Print & Fax (Print & Scan in Mac OS X v10.7) list.

Hardware troubleshooting

1.

P WO N

Make sure that the product is turned on.
Make sure that the USB cable is connected correctly.
Make sure that you are using the appropriate Hi-Speed USB cable.

Make sure that you do not have too many USB devices drawing power from the chain. Disconnect
all of the devices from the chain, and then connect the cable directly to the USB port on the
computer.

Check to see if more than two non-powered USB hubs are connected in a row on the chain.
Disconnect all of the devices from the chain, and then connect the cable directly to the USB port
on the computer.

E%?NOTE: The iMac keyboard is a non-powered USB hub.

You are using a generic print driver when using a USB connection

If you connected the USB cable before you installed the software, you might be using a generic print
driver instead of the driver for this product.

1.
2,

Delete the generic print driver.

Reinstall the software from the product CD. Do not connect the USB cable until the software
installation program prompts you.

If multiple printers are installed, make sure that you have selected the correct printer in the
Format For drop-down menu in the Print dialog box.

230  Chapter 9 Solve problems ENWW



Remove software (Windows)

Windows XP
1. Click Start, and then click Programs.
2. Click HP, and then click the product name.

3. Click Uninstall, and then follow the on-screen instructions to remove the software.

Windows Vista and Windows 7
1. Click Start, and then click All Programs.
2. Click HP, and then click the product name.

3. Click Uninstall, and then follow the on-screen instructions to remove the software.
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Remove software (Mac OS X)

232

You must have administrator rights to remove the software.

1.

o v s wPp

Disconnect the product from the computer.
Open Applications.
Open Hewlett Packard.

Open HP Uninstaller.

Select the product from the list of devices, and then click the Uninstall button.

After the software is uninstalled, restart the computer and empty the Trash.
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Solve scan to email problems

If scan to email problems occur, try these solutions:

o Make sure this feature has been set up. If this feature has not been set up, use the setup wizard in
the HP Device Toolbox (Windows) or HP Utility for Mac OS X software to set it up.

o Make sure the Scan to Email feature is enabled. If it has been disabled, enable the feature through
the HP Device Toolbox (Windows) or HP Utility for Mac OS X software.

e Make sure the product is connected to a computer or to a network.

Cannot connect to the email server

e Make sure the SMTP server name is correct. Check this setting with your system administrator or
Internet Service Provider.

o If the product cannot establish a secure connection to the SMTP server, try without the secure
connection or try a different server or port. Check this setting with your system administrator or
Internet Service Provider.

o  If the SMTP server requires authentication, make sure a valid user name and password are used.

o  If the SMTP server uses an authentication method that is not supported, try a different server.
Check this setting with your system administrator or Internet Service Provider.

The email failed

e Verify that email addresses entered are correct.

o If the size of the email was too large, send fewer pages or reduce the scan resolution.

Unable to scan

o If you are prompted for a PIN, enter the correct PIN for the outgoing profile.

e  Make sure at least one email address is selected in the To field.
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Solve scan to network folder problems

If scan to network folder problems occur, try these solutions:

e Make sure this feature has been set up. If this feature has not been set up, use the setup wizard in
the HP Device Toolbox (Windows) or HP Utility for Mac OS X software to set it up.

e  Make sure the Scan to Network Folder feature is enabled. If it has been disabled, enable the
feature through the HP Device Toolbox (Windows) or HP Utility for Mac OS X software.

e  Make sure the product is connected to a network.
e  Use the test option on the Scan tab of the HP Device Toolbox (Windows) or the HP Utility (Mac OS

X) to verify the Scan to Network Folder feature is set up correctly.

The scan failed

e  Make sure the network path is in the correct format (//host/share/path) and the folder exists.
e  Make sure the network directory is readable and writeable.

o If you are using the default file names for scanned documents, make sure there are no conflicting
file names. Remove some of the previously scanned documents.

o  Use the IP address instead of the host name. Make sure the product and host are connected to the
same network.

o If the network folder is password protected, make sure to enter the correct user name and
password.

o Ifa Disk full message displays, remove some files from the network folder.

e Turn the product off, and then on. Scan again.
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Accessories

part numbers 33
accessories

ordering 26
AirPrint 81
answer mode, setting 122
answering machines, connecting

111

fax settings 123
anticounterfeit supplies 28
applications

downloading 144
Apps menu 144
archival-quality printing 79
autoreduction settings, fax 125

billing codes, fax
using 120
bins, output
locating 4
selecting 23
blocking faxes 123
booklets
creating (Windows) 69
printing (Mac) 76
busy signals, redialing options

118

caller-ID boxes, connecting 111
canceling

faxes 128

print job (Mac) 78

print job (Windows) 72
cartridges

non-HP 27, 35

order numbers 35

ENWW

recycling 35
replacing 36
storage 35
supplies status page 11
checklist
fax troubleshooting 201
for solving problems 158
wireless connectivity 223
cleaning
glass 186, 190, 193
paper path 182
collating copies 90
configuration page 11
contrast settings
copy 95
fax 119
control panel
buttons and lights 8
help 10, 162
Home screen 9
locating 4
menu map, printing 11
Reports menu 11
copying
collation 90
contrast, adjusting 95
draft mode 96
enlarging 93
light/dark settings 95
multiple copies 87
multiple-page originals 88
paper size and type 97
quality, adjusting 94
reducing 93
restore default settings 85
set new default settings 84
single copies 86
two-sided documents 91, 92
counterfeit supplies 28

cover pages
printing on different paper
(Windows) 64
covers, locating 4
custom-size copies 93
customer self-repair
part numbers 31

darkness, contrast settings

copy 95

fax 119
default copy settings

changing 84

restoring to factory settings 85
default gateway, setting 145
defaults, restoring 161
delaying fax sending 135
deleting faxes from memory 129
dial tone detection settings 118
dialing

from a telephone 134

pauses, inserting 117

prefixes, inserting 117

redialing automatically,

seftings 118

tone or pulse settings 118
distinctive-ring seftings 124
document feeder 91

copying two-sided documents

91

jams 166

paperfeeding problems 164
double-sided copying 91, 92
double-sided printing

Mac 75

Windows 53
draft mode, copying 96
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drivers
changing paper sizes 70
changing settings (Mac) 44
changing settings (Windows)
42
paper types 16
presets (Mac) 73
selecting 184
settings (Mac) 73
universal 40
usage page 11
DSL
faxing
duplex 91
duplex printing
Mac 74,75
duplex printing (double-sided)
settings (Windows) 51
Windows 53
duplex settings, changing
duplexer
jams
duplexing
manually (Mac) 75
manually (Windows) 53

129

147

179

EconoMode setting 152, 184

economy settings 152

electronic faxes
sending 133

Embedded Web Server 160
changing network settings 145
changing password 154
changing product name 146

opening 145, 146, 154
enlarging documents

copying 93
envelopes

output bin, selecting 23
error messages, fax 205, 211
error report, fax

printing 204
error-correction setting, fax 204
errors

software 227
extension phones

receiving faxes from

sending faxes from

112
134

Index

factory-set defaults, restoring 161

fax
answer mode
autoreduction
billing codes
blocking 123
canceling 128
confirming number
contrast setting 119
delaying sending 135

122
125
120

134

deleting from memory 129
detect-dialtone settings 118
dial prefixes 117

dialing, tone or pulse 118

error report, printing 204
error-correction 204
extension phone receiving
112
forwarding 122
pauses, inserting
polling 127
printing 137
printing private faxes
private receive 126
receiving when you hear fax
tones 139
redial settings 118
reports, printing all 203
reprinting faxes 125

117

139

reprinting from memory 138
resolution 119

ring patterns 124
rings-to-answer 123

security, private receive 126
sending from a telephone 134
sending from software 133

solve general problems 217
solving problems 160
speed dials 133
stamp-received 126
unable to receive 211
unable to send 205
using DSL, PBX, or ISDN
using VolP 130
V.34 setting 204
volume settings 126

fax date, setup
use control panel 113
use HP Fax Setup Wizard

129

114

fax header, setup

use control panel 113

use HP Fax Setup Wizard 114
fax time, setup

use control panel 113

use HP Fax Setup Wizard 114

fax troubleshooting
checklist 201
faxing
from a computer (Mac) 133
from a computer (Windows)
133
first page
printing on different paper
(Windows) 64

Fit to Page setting, fax 125
fonts

lists, printing 11
forwarding faxes 122
fraud Web site 28
fuser

jams 177
gateway, setting default 145

glass, cleaning 186, 190, 193

group-dial entries

creating 115
deleting 116
editing 115

heavy paper
output bin, selecting 23

help, control panel 10, 162

Home screen, control panel 9

HP Device Toolbox, using 148

HP Embedded Web Server 160
changing network settings 145
changing password 154
changing product name
opening 145, 146, 154

HP ePrint, using 80

HP fraud Web site 28

HP Reconfiguration Utility
network installation 142

HP Scan software (Mac) 101

HP Scan software (Windows)

HP Universal Print Driver 40

HP Utility 150

146

100
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HP Utility for Mac
Bonjour 150
features 150
HP Utility, Mac 150
HP Web Jetadmin 151
HP Web Services
applications 144
enabling 144
HP Web Services, enabling 80

identification cards
copying 89
interface ports
locating 5, 6
IPv4 address 145
ISDN

faxing 129

jams
causes of 164
document feeder, clearing

166

duplexer
fuser 177
locations 165
output bin 168
tracking number of 11
Tray T 170
Tray 2 173

Jetadmin, HP Web 151

179

labels

output bin, selecting 23

printing (Windows) 61
landscape orientation

changing (Mac) 75

selecting, Windows 59
last page

printing on different paper

(Windows) 64

lightness

copy contrast 95

fax contrast 119

link speed settings 147
loading
toner cartridges 34
Tray 1 18
Tray 2 21
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lock
product

logs, fax
error 204
printing all

154

203

Mac
driver settings 44, 73
problems, troubleshooting 229
scanning from TWAIN-

compliant software 107
Macintosh
HP Utility 150

maintenance kits

part numbers 31
managing network 145
manual duplex

Mac 75
Windows 53
media

loading Tray 1 18
loading Tray 2 21

memory
deleting faxes 129
included 2

reprinting faxes 138
menus, control panel
map, printing 11

Microsoft Word, faxing from 134
modems, connecting 111
multiple copies 87
multiple pages per sheet
printing (Mac) 75
printing (Windows) 57
multiple-page originals
copying 88
network
password, changing 154
password, setting 154
product name, changing 146
settings, changing 145
seftings, viewing 145
networks
configuration page 11
default gateway 145
HP Web Jetadmin 151
installing the product 142

IPv4 address 145
models supporting 2
settings report 11
subnet mask 145
non-HP supplies 27, 35
number of copies, changing 87

on/off button, locating 4
online help, control panel 10,
162

ordering

supplies and accessories 26
orientation

changing (Mac) 75

selecting, Windows 59
output bin

jams 168

locating 4
outside lines

dial prefixes 117

pauses, inserting 117

page count 11
page orientation
changing (Mac) 75
page sizes
scaling documents to fit (Mac)
76
scaling documents to fit
(Windows) 67
pages per minute 2
pages per sheet
selecting (Mac) 75
selecting (Windows) 57
paper
covers, using different paper

64

fax autoreduction settings 125

first and last pages, using
different paper 64

jams 164

loading Tray 1 18

loading Tray 2 21

ordering 26

selecting 183

supported paper sizes 14

supported sizes 14

supported types 16
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paper jams. See jams
paper pickup problems

solving 163
paper size

changing 70
paper sizes

copy settings 97

selecting (Mac) 77

selecting custom sizes (Mac)
77

selecting custom sizes

(Windows) 70
paper type
selecting (Windows) 61
paper types
copy settings 97
selecting (Mac) 76
paper, covers
printing (Mac) 76
part numbers
customer self-repair 31
maintenance kits 31
supplies 31
trays 33
pauses, inserting 117
PBX
faxing 129
PCL drivers
universal 40
PCL font list 11
phone book, fax
adding entries 133
phones
receiving faxes from 112, 139
phones, connecting extra 111
phones, downstream
sending faxes from 134
polling faxes 127
portrait orientation
changing (Mac) 75
selecting, Windows 59
ports
locating 6
postcards
output bin, selecting 23
power connection
locating 5, 6
power switch, locating 4
power-down delay

sefting 152

238 Index

prefixes, dial 117
presets (Mac) 73
print drivers
selecting 184
supported 40
print drivers (Mac)
changing settings 44
seftings 73
print drivers (Windows)
changing settings 42
print job
canceling (Mac) 78
canceling (Windows) 72
print on both sides

Mac 74,75
manually, Windows 53
Windows 53
print quality
improving 181
printing

from USB flash drives 82

product reports 11

settings (Mac) 73
printing on both sides

settings (Windows) 51
private receive 126
problem-solving

no response 197

slow response 198
protocol seftings, fax 204
PS font list 11
pulse-dialing 118

rear output bin
printing to 23
receiving faxes
answer mode, sefting 122
autoreduction settings 125
blocking 123
error report, printing 204
from extension phone 112
polling 127
reprinting 138
reprinting faxes 125
ring patterns, settings 124
rings-to-answer seftings 123
stamp-received setting 126
when you hear fax fones 139
recycling supplies 35

redialing
automatically, settings 118
reducing documents

copying 93
replacing printing cartridges 36
reports

configuration report 11
demo page 11
menu structure 11
network summary 11
PCL font list 11
PCL6 font list 11
print quality page 11
PS font list 11
service page 11
supplies status 11
usage page 11
Reports menu 11
reports, fax
error 204
printing all 203
reprinting faxes 125, 138

resize documents

copying 93

Mac 76

Windows 67
resolution

fax 119

restoring factory-set defaults 161
ring patterns 124
ring tones

distinctive 124
ringsto-answer setting 123
rough paper

output bin, selecting 23

scale documents

Mac 76

Windows 67
scaling documents

copying 93
scanner

glass cleaning 186, 190, 193
scanning

from HP Scan software (Mac)
101

from HP Scan software
(Windows) 100

to email, setup 103

ENWW



to network folder, setup 103
TWAIN-compliant software
107
WIA-compliant software
sending faxes
billing codes 120
canceling 128
confirmation 134
delaying 135
error report, printing 204
forwarding 122
from downstream telephone
134
from software 133
service page 11
settings
driver presets (Mac) 73
drivers 42
drivers (Mac) 44
factory-set defaults, restoring
161
network report 11
setup
scan to email and network
folder 103
shortcuts (Windows)
creating 48
using 46
size, copy
reducing or enlarging 93
sizes, media
Fit to Page setting, faxing 125
sleep delay
disabling 152
enabling 152
small documents
copying 89
small paper
output bin, selecting 23
software
HP Utility 150
problems 227
scanning from TWAIN or
WIA 107
sending faxes 133
uninstalling for Mac 232
uninstalling for Windows 231
solve

fax problems 205

107
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solve problems
fax 217
solving
walk-up USB printing
problems 199
special paper
printing (Windows) 61
special paper for covers
printing (Mac) 76
speed dials
programming 133
speed-dial entries
creating 115

deleting 116
editing 115
status

Home screen, control panel 9

HP Utility, Mac 150

supplies, printing report 11
storing

toner cartridges 35
straightthrough paper path 23
subnet mask 145
supplies

counterfeit 28

low threshold settings 29

non-HP 27, 35

ordering 26

part numbers 31

recycling 35

replacing toner cartridges 36

status, viewing with HP Utility

for Mac 150

using when low 29
supplies status page 11
supported paper 14

TCP/IP
manually configuring IPv4
parameters 145
telephones
receiving faxes from 112, 139
telephones, connecting extra 111
telephones, downstream
sending faxes from 134
tone-dialing 118
toner cartridge
low threshold settings 29
using when low 29

toner cartridges
loading 34
non-HP 27, 35

order numbers 35

recycling 35
replacing 36
storage 35

supplies status page 11
top output bin

printing to 23
transparencies

output bin 23

printing (Windows) 61

Tray 1
jams 170
loading 18
tray 1
capacity 17
Tray 2
jams 173
loading 21
tray 2
capacity 20
trays
included 2
locating 4

part numbers 33
troubleshooting
checklist 158

fax error-correction setting

204
faxes 201
jams 164

Mac problems 229
network problems 221
paper feed problems 163
receive fax 211
send fax 205
USB connection 220
walk-up USB printing
problems 199
Windows problems
wired network 221
wireless network 223
TWAIN-compliant software,
scanning from 107
two-sided copying 91, 92
two-sided printing
settings (Windows) 51

227

239
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unblocking fax numbers 123
uninstalling Mac software 232
uninstalling Windows software
231

universal print driver 40
usage page 11
USB connection

troubleshooting 220
USB flash drives

printing from 82

V.34 setting 204
VolP

faxing 130
volume, adjusting 126

walk-up USB printing 82
watermarks

printing (Mac) 77

printing (Windows) 71
Web Services

applications 144

enabling 144
Web sites

fraud reports 28

HP Web Jetadmin,

downloading 151

universal print driver 40

WIA-compliant software, scanning
from 107

Windows

driver settings 42

faxing from 133

scanning from TWAIN or WIA

software 107

universal print driver 40
Windows print drivers

supported 40
wireless network

troubleshooting 223
wireless network interference 226
wireless printing

solving problems 158
Word, faxing from 134

240  Index ENWW






© 2014 Hewlett-Packard Development Company, L.P.

www.hp.com

A8P80-90908




	Product introduction
	Product comparison
	Product views
	Product front view
	Product back view
	Interface ports
	Serial number and model number location

	Control panel
	Control-panel layout
	Control-panel Home screen
	Control panel help system

	Print product reports

	Paper trays
	Supported paper sizes
	Supported paper types
	Tray 1
	Tray capacity and paper orientation
	Load Tray 1

	Tray 2 and optional Tray 3
	Tray capacity and paper orientation
	Load Tray 2 and optional Tray 3

	Use paper output options
	Print to the standard output bin
	Print to the rear output bin


	Parts, supplies, and accessories
	Order parts, accessories, and supplies
	HP policy on non-HP supplies
	HP anticounterfeit Web site
	Print when a toner cartridge is at estimated end of life
	Enable or disable the Very Low Setting

	Customer self-repair parts
	Accessories
	Toner cartridge
	Toner-cartridge view
	Toner-cartridge information
	Recycle the toner cartridge
	Toner-cartridge storage
	HP policy on non-HP toner cartridges

	Replace the toner cartridge


	Print
	Supported print drivers (Windows)
	HP Universal Print Driver (UPD)
	UPD installation modes


	Change print-job settings (Windows)
	Priority for changing print-job settings
	Change the settings for all print jobs until the software program is closed
	Change the default settings for all print jobs
	Change the product configuration settings

	Change print-job settings (Mac OS X)
	Priority for changing print-job settings
	Change the settings for all print jobs until the software program is closed
	Change the default settings for all print jobs
	Change the product configuration settings

	Print tasks (Windows)
	Use a printing shortcut (Windows)
	Create printing shortcuts (Windows)
	Automatically print on both sides (Windows)
	Manually print on both sides (Windows)
	Print multiple pages per sheet (Windows)
	Select the page orientation (Windows)
	Select the paper type (Windows)
	Print the first or last page on different paper (Windows)
	Scale a document to fit page size (Windows)
	Create a booklet (Windows)
	Select the paper size (Windows)
	Select a custom paper size (Windows)
	Print watermarks (Windows)
	Cancel a print job (Windows)

	Print tasks (Mac OS X)
	Use a printing preset (Mac OS X)
	Create a printing preset (Mac OS X)
	Automatically print on both sides (Mac OS X)
	Manually print on both sides (Mac OS X)
	Print multiple pages per sheet (Mac OS X)
	Select the page orientation (Mac OS X)
	Select the paper type (Mac OS X)
	Print a cover page (Mac OS X)
	Scale a document to fit page size (Mac OS X)
	Create a booklet (Mac OS X)
	Select the paper size (Mac OS X)
	Select a custom paper size (Mac OS X)
	Print watermarks (Mac OS X)
	Cancel a print job (Mac OS X)

	Create archival-quality prints
	Use HP ePrint
	Use AirPrint
	Use walk-up USB printing

	Copy
	Set new default copy settings
	Restore copy default settings
	Make a single copy
	Make multiple copies
	Copy a multiple-page original
	Copy identification cards
	Collate a copy job
	Copy on both sides (duplex)
	Copy on both sides automatically
	Copy on both sides manually

	Reduce or enlarge a copy
	Optimize copy quality
	Adjust the lightness or darkness for copies
	Copy in draft mode
	Set the paper size and type for copying on special paper

	Scan
	Scan by using the HP Scan software (Windows)
	Scan by using the HP Scan software (Mac OS X)
	Scan to a USB flash drive
	Set up scan to network folder and scan to email features
	Configure the scan to network folder feature
	Configure the scan to email feature

	Scan to a network folder
	Scan to email
	Scan by using other software
	Scan from a TWAIN-compliant program (Windows)
	Scan from a WIA-compliant program (Windows)


	Fax
	Set up the product for fax
	Connect the fax port to a telephone line
	Connect additional devices
	Set up fax with a telephone answering machine
	Set up fax with an extension phone

	Set up for stand-alone fax
	Configure the fax time, date, and header
	Use the control panel to set the fax time, date, and header
	Use the HP Fax Setup Wizard to set the fax time, date, and header (Windows)


	Use the phone book
	Create and edit speed-dial entries
	Create and edit group-dial entries
	Delete speed-dial entries
	Delete group-dial entries

	Configure send fax settings
	Set special dialing symbols and options
	Set a dialing prefix

	Set the dial tone detection
	Tone dial or pulse dial

	Set autoredial options
	Set light/dark and resolution
	Set the default light/dark (contrast) setting
	Set resolution settings

	Set billing codes

	Configure receive fax settings
	Set fax forwarding
	Set the answer mode
	Block or unblock fax numbers
	Set the number of rings-to-answer
	Set distinctive ring
	Use autoreduction for incoming faxes
	Set fax reprint settings
	Set the fax sounds volume
	Set the alarm volume, phone-line volume, and ring volume

	Set stamp-received faxes
	Set the private receive feature

	Set fax polling
	Use fax
	Supported fax programs
	Cancel a fax
	Cancel the current fax
	Cancel a pending fax job

	Delete faxes from memory
	Use fax on a DSL, PBX, or ISDN system
	DSL
	PBX
	ISDN

	Use fax on a VoIP service
	Fax memory contents are retained when there is a loss of power
	Security issues when connecting internal networks to public phone lines
	Fax from the flatbed scanner
	Fax from the document feeder
	Use speed dials and group-dial entries
	Send a fax from the software (Windows)
	Send a fax by dialing from a telephone connected to the fax line
	Send a fax with confirmation
	Schedule a fax to be sent later
	Send a fax combining an electronic and paper document
	Use access codes, credit cards, or calling cards
	Send faxes internationally

	Print a fax
	Reprint a fax
	Automatically print on both sides of received faxes
	Print a stored fax when the private receive feature is on

	Receive faxes when fax tones are audible on the phone line


	Manage and maintain
	Use the HP Reconfiguration Utility to change the product connection (Windows)
	Set up HP Wireless Direct Printing
	Use HP Web Services applications
	Configure IP network settings
	Printer sharing disclaimer
	View or change network settings
	Manually configure IPv4 TCP/IP parameters from the control panel
	Rename the product on a network
	Link speed and duplex settings

	HP Device Toolbox (Windows)
	HP Utility for Mac OS X
	Open HP Utility
	HP Utility features

	Use HP Web Jetadmin software
	Economy settings
	Print with EconoMode
	Set the Sleep Delay
	Set the Auto Power Down delay

	Product security features
	Lock the product
	Set or change the product password

	Upgrade the firmware
	Manually upgrade the firmware
	Set the product to automatically upgrade the firmware


	Solve problems
	Solve problems checklist
	Step 1: Make sure that the product is set up correctly
	Step 2: Check the cabling or wireless connection
	Step 3: Check the control panel for error messages
	Step 4: Check the paper
	Step 5: Check the software
	Step 6: Test print functionality
	Step 7: Test copy functionality
	Step 8: Test the fax functionality
	Step 9: Check the toner cartridge
	Step 10: Try sending a print job from a computer
	Step 11: Verify that the product is on the network

	Restore the factory-set defaults
	Control panel help system
	Paper feeds incorrectly or becomes jammed
	The product does not pick up paper
	The product picks up multiple sheets of paper
	The document feeder jams, skews, or picks up multiple sheets of paper
	Prevent paper jams from the paper trays

	Clear jams
	Jam locations
	Clear jams in the document feeder
	Clear jams in the output area
	Clear jams in Tray 1
	Clear jams in Tray 2 or optional Tray 3
	Clear jams in the fuser
	Clear jams in the duplexer

	Improve print quality
	Print from a different software program
	Set the paper-type setting for the print job
	Check the paper-type setting (Windows)
	Check the paper-type setting (Mac OS X)

	Check the toner-cartridge status
	Print a cleaning page
	Visually inspect the toner cartridge
	Check the paper and printing environment
	Use paper that meets HP specifications
	Check the product environment

	Check the EconoMode settings
	Try a different print driver

	Improve copy quality
	Check the scanner glass for dirt and smudges
	Check the paper settings
	Optimize for text or pictures
	Edge-to-edge copying
	Clean the pickup rollers and separation pad in the document feeder

	Improve scan quality
	Check the scanner glass for dirt and smudges
	Clean the pickup rollers and separation pad in the document feeder

	Improve fax quality
	Check the scanner glass for dirt and smudges
	Check the send-fax resolution setting
	Check the error correction setting
	Send to a different fax machine
	Clean the pickup rollers and separation pad in the document feeder
	Check the fit-to-page setting
	Check the sender's fax machine

	The product does not print or it prints slowly
	The product does not print
	The product prints slowly

	Solve walk-up USB printing problems
	The USB Flash Drive menu does not open when you insert the USB flash drive
	The file does not print from the USB flash drive
	The file that you want to print is not listed in the USB Flash Drive menu

	Solve fax problems
	Checklist for solving fax problems
	Perform a fax diagnostic test
	Fax trace report
	Fax error report printing
	Print all fax reports
	Print individual fax reports
	Set the fax error report

	Set the fax-error-correction mode
	Change the fax speed
	Solve problems sending faxes
	An error message displays on the control panel
	The Communication error message appears
	No dial tone
	The Fax is busy message appears
	The No fax answer message appears
	Document feeder paper jam
	The Fax storage is full message appears
	Scanner error

	The control panel displays a Ready message with no attempt to send the fax
	The control panel displays the message "Storing page 1" and does not progress beyond that message
	Faxes can be received, but not sent
	Product is password protected
	Unable to use fax functions from the control panel
	Unable to use speed dials
	Unable to use group dials
	Receive a recorded error message from the phone company when trying to send a fax
	Unable to send a fax when a phone is connected to the product

	Solve problems receiving faxes
	The fax does not respond
	The fax has a dedicated phone line
	An answering machine is connected to the product
	The Answer Mode setting is set to the Manual setting
	Voice mail is available on the fax line
	The product is connected to a DSL phone service
	The product uses a fax over IP or VoIP phone service

	An error message displays on the control panel
	The No fax detected. message displays
	The Communication error message appears
	The Fax storage is full message appears
	The Fax is busy message appears

	A fax is received but does not print
	The Private Receive feature is on

	Sender receives a busy signal
	A handset is connected to the product
	A phone line splitter is being used

	No dial tone
	Cannot send or receive a fax on a PBX line

	Solve general fax problems
	Faxes are sending slowly
	Fax quality is poor
	Fax cuts off or prints on two pages


	Solve USB connection problems
	Solve wired network problems
	Poor physical connection
	The computer is using the incorrect IP address for the product
	The computer is unable to communicate with the product
	The product is using incorrect link and duplex settings for the network
	New software programs might be causing compatibility problems
	The computer or workstation might be set up incorrectly
	The product is disabled, or other network settings are incorrect

	Solve wireless network problems
	Wireless connectivity checklist
	The product does not print after the wireless configuration completes
	The product does not print, and the computer has a third-party firewall installed
	The wireless connection does not work after moving the wireless router or product
	Cannot connect more computers to the wireless product
	The wireless product loses communication when connected to a VPN
	The network does not appear in the wireless networks list
	The wireless network is not functioning
	Perform a wireless network diagnostic test
	Reduce interference on a wireless network

	Solve product software problems with Windows
	A print driver for the product is not visible in the Printer folder
	An error message was displayed during the software installation
	The product is in Ready mode, but nothing prints

	Solve product software problems with Mac OS X
	The print driver is not listed in the Print & Fax or Print & Scan list
	The product name does not appear in the product list in the Print & Fax or Print & Scan list
	The print driver does not automatically set up the selected product in the Print & Fax or Print & Sc ...
	A print job was not sent to the product that you wanted
	When connected with a USB cable, the product does not appear in the Print & Fax or Print & Scan list ...
	You are using a generic print driver when using a USB connection

	Remove software (Windows)
	Remove software (Mac OS X)
	Solve scan to email problems
	Cannot connect to the email server
	The email failed
	Unable to scan

	Solve scan to network folder problems
	The scan failed


	Index

